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Unit 1: Introducton To Windows Operating System
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1.1

Objectives
Introduction

Features of MS-WINDOWS 2000

Windows 2000 Professional at a Glance
Accessibility for special needs

Hardware Requirements of WINDOWS 2000
Desktop Environment

Taskbar

Start Meny

My Computer

Recycle Bin

Control Pane] _

Windows Explorer

Windows Accessories _ '
Managing Hardware and Software and its Installation
Add/Remove Applications {Softwares)

Add New Hardware

Printers

System Tools (Disk Drive Utilities)

Disk Defragmenter '

Check for Disk Errors (SCANDISK)

Backup Your Data

Clipboard Viewer

System Information

NTFS ' _
Network-Neighbourhood (My Network Places
Sharing Information between Programs :
Sumimary

Unit End Questions

OBJECTIVES

After going through this unit to wif] be ableto: |
Describe Features of Windows, taskbar,toolbar,desktop,recyclebin,control panel etc,

Describe File folders management windows explorer, installing andmnningF,I.anmmns;(.:ohIﬁ o -
- mouseand keyboard, managing software and hardware, o g | g....

INTRODUCTION

MS-Windows 2000 is the most popular GUI for personal computers, Wmdowéﬁtdyiﬁ#s an

environment that enhances DOS in many ways, - '
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Microsoft Windows 2000 Professional, the premier desktop operating system for businesses and
organizations. Windows 2000 provides faster performance, greater reliability, improved security, anda

more manageable desktop. With its support for hardware and applications, Windows 2000 is the best

platform for running the latest software and hardware.

No matter where you are working, your computer will be eagier to use and to manage, because
Microsoft Windows 2000 Professional is more compatible and more powerful than any workstation you've
used before. ' S

1. Easier to use

With Windows 2000 Professional, you have fasier access 1o information, and you are able to
accomplish tasks more quickly and easily.

Windows 2000 Professional makes it easier to;

o Work with files.
“ e Findinformation.

e Personalize your compuiing environment.
" o Work onthe Web. . '

o Work remotely.

2. Easier to manage

You and your network administrators can work more efficently now, because many of the most

conmmon computer-management tasks are automated and streamlined with Windows 2000 Professional.
~ With Windows 2000, your workstation will be easier to:
s Setup.
o Administeror
| e Support. |
3. More comﬁatible

Windows 2000 Professiohal offers increased compatibility with different types of networks and
with a wide array of legacy hardware and software.

Windows 2000 also provides:
e  Improved driver support.
o Increased support for new-generation hardware and multimedia technologies.
e Integrationofthe new Furo currency symbol. _
3 More powerful
For all yout computing needs, Windows 2000 Professioﬁal provides:
e Industrial-strength reliability.
o The highestlevel of security.

e Powerful performance.

[2]

....,_._.v_n._..._..._._,_,____-_____—--



1.2

10,

FEATURES OF MS-WINDOWS 2000
The majdr benefits of Windows are :

Common Look and Feel : All Windows applications have the same basic look and feel, Once
you know one or two Windows applications. It is easy to learn another one.

Device Independence : Windows presents a device-independent interface to applications. Unlike
most of today's DOS applications, a Windows application is hot bound to the underlying hardware
such as mouse, keyboard or display. Windows shields the applications from this responsibility. The
application deals with the Windows API to manipulate any underlying devices.

Memory Management: Windows also provides memory management to break the 640K limitation
of MS-DOS. An application has the ability to use the extended memory, share data segments with
other applications and swap unwanted segments to disk.

Support for existing DOS applications : Windows aliow most standard DOS applications to
run under it directly. Any application that does not contro) the PC's hardware, use the PC BIOS or
MS-DOS software interrupts, can run in its own window.

Data Sharing : Windows allows data transfer between application Clipboard. Any type of data
can be transferred from one window with the Clipboard. The Dynamic Data Exchange (DDE)
protocol defines how two applications can share information. Information such as bitmap, metafile,
character strings and other data formats can be shared .

True 32-bit Operating System : The computer stores and processes data in bits, which is the
smallest unit for measuring information, OS can be classified on the basis of the number of bits it
can process at a time. Windows NT1is a 32-bit OS, which implies that it can send or receive 32 bits
of information at a time and can internally process 32 bits of data.

Portability : The characteristics of the microprocessor affect the OS design. An OS which is
designed with a particular processor in mind can take advantage of the specific features of that
processor, but will not be able to run on computers which use any other processor. The ability of
software to run on different processors is referred to as portability. Windows NT is one such
portable OS, which can run on both the older Intel 80486 processors as well as on the latest
Pentium and MIPS R 400 processors.

Scalability : Windows NTisa multi-processing OS, which means that it can use more than one
microprocessor for its internal processing. If such a processoris available in the system unit. In fact,
Windows NT can run on computers with as many as 32 processots. The architecture of Windows
NT s designed to take maximum advantage of the additional processors and ensure that none of
the processors is idle. : '

Multitasking Features : Windows NTisa multitasking OS, which means that it can perform

more than one task at the same time. For example, you ¢an write a sales report in MS-WORD,

and can refer to the latest sales figures by having the data file open. While you are writing this

- Feport, your system could also be printing a document in the background; Multitasking is implemented

by using the principle of time-sharing, where each application is allowed to run only for a fixed
duration of time. Afier that, the microprocessor puts that task on a queue and performs another
task. Thus, it manages to perform more than one task at a time. This feature is also known as
preemptive multitasking, -

Multiple User Support : Windows NT is also a multi-user OS, which means that is supports -

more than one user. Several users can access the same files; share the same resdurces, like printers
or scanners. However at the same time, Windows NT ensures that no user can use another user's
files without authorization or interfere with the tasks being executed by another user.-

=
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' Multi-Threading : The multiple tasking and multiple user support provided by windows NT is

implemented by the principle of multiple threading. A thread is defined as a single sequential flow of

" control. A program is normally broken into small chunks called tasks, and tasks are further broken

into smaller chunks called threads. Every process has a thread that determines the system resources
it can access and the operation that it can perform on it. Windows NT allows a process to have
more that one thread associated with it. For example, you can edit a file, print in the background
and another user may also be working on the same file simultaneously. All these processes seem to
be running simultaneously because each of these processes is different thread. This feature makes
multi-tasking and multi-user support possible.

Built-in Networking : Windows NT can be used as a server, with several workstations, known
as nodes, connected to it. The nodes can communicaie, access resources and data on the server
as well as on.other nodes. The networking suppott also enables Windows NT to make use of
microprocessors of other computers on a network. This ensures maximum wtilization of system
resources. This feature is known as distributed processing. '

* Graphical User Interface: Windows NT 4.0 has a user-friendly graphical interface. Users can

now perform complex tasks by selecting opti ons from drop-down menus ancl clickoniconsto

~execute programs.

Extensibility

"Ihe extensibility of window NT provides the flexibility of adding faster workstations and servers to
the network.

Imcahzatmn

Window NT is being offered in many countrlewround ihc world in local languages. Thus users .
located in different countries can interact with the sysrersti frthelr native language. Windows NT
supports date time and currency formats of different countries. -

RESOURCES

Resources are used to manage windows and user-defined obj ects MS-Windows pr 0v1dcs nine

kinds of resources to application developers. These resources are : icons, cursors, menus dialog boxes,
fonts, bitmaps, char strings, user-defined resources, and keyboard accelerators.

1.

" Icons and cursors: Windows defines a few types of icons and cursors. An icon or a cursor is

essentially a bit-mapped region that is used to represent and symbolize a window or cursor. A

developer can also define an original icon or cursor using the ICON EDIT utility.

Menus : Each window can have its own menu bar. A menu item can be a character string or a

~ " bitmap. Each item of a menu bar in turn can have a pop-up menu presenting a list of options.
- Currently, Windows does not support nesting of pop-up menus within other pop “E mernus.
- (Windows 3.0 provides this functionality), But a pop-up menu can invoke adialogbox.:

. Dialog boxes: Thesé_provide another mechanism besides pop-up menu and menu barsto obtain

information from the end-user. Dialog boxes are much more flexible than menu bars or pop-up

~“menus. Dialog boxes usually contain a group of child windows such -as buttons, scroli bars, and
. editable fields, Just like windows, dialogboxes have a functlon that is used to process messages
~ received fromthe user upon selection of options

Fonts : Windows provides a few families of fonts with different sizes and shapes : modem, romari,
Swiss, Helvetica, and script. Apphcatlon processors and desktop pubhshmg can define additional
fonts as needed

[4]



S. Bitmaps : They are used to represent icons, cursors, or draw picture on the screen, Both mono
and color bitmaps can be defined:

6. Character Strings : Character strings are handled as resources mainly to provide a manageable
solution to internationalization of a window application.

7. User-Defined Resources : These can be used for any purpose and support any user-defined
data type. Any arbitrary data can be managed as a user-defined resource.

1.3~ Windows 2000 Professionalat a Glance

: Wmdows 2000 is the most manageable, reliable, and secure version of Windows ever. Improved
hardware support and increased software compatibility make using Windows 2000 even easier. And
enhancements to networking, printing, and storage help you find resources more quickly and work more
efficiently.

Easiest Windows Yet

Desk&)p and window enhancements make Windows 2000 casy 1o use. You can customize menus
and toolbars to tailor Windows 2000 to your needs, Microsoft Windows Explorer displays more information
about files and folders, including thumbnail views and encryption information. Using the enhanced search

capabilities, you can browse and see search results in the same window. In My Documents and My -

Pictures folders you have a convenient place to back up and store all of your work.

And Microsoft Internet Explorer gives you the best Internet experience and Iaiest Web browsing
features. Forexample, the AutoComplete feature finishes typing Internet addresses and previously-viewed
files for you. The AutoDetect feature detects and configures a proxy server for your connection.

Windows 2000 includes hundreds of new printer, modem, and other hardware drivers, making
hardware installation and setup easy and efficient. New wizards make configuring hardware simple. The
“Add/Remove Hardware wizard automatically detects and configures new devices. The Add Printer wizard
-helps you change printer settings from within applications. And Windows 2000 includes improved printing
Support-Internet printing, Image Color Management 2.0, and new font technologies.

] Windows 2000 Professional is the best operating system for mobile users. The Network Connection
" wizard simplifies setting up network and dial-up connections, You can take network-based files and folders
offline, making them available when youaren't connected to the network. Likewise, you can save Web
pages for offline browsing. And Synchronization Manager ensures that offline and network versions ofa
fileare up-to-date, = - T

Building on the Traditional Strengths of Windows NT

Windows 2000 significantly expands the existing capabilities of Windows NT, providing a more
~ stable and responsive computing experience. The new Encrypting File System ensures that information is

following scalable security technologies: Kerberos V5 protocol, smart card, public key cryptography, and

, Tesources.

With the latest installation technology, you can install, customize, and remove programs more

reliably. Windows Installer helps prevent system file conflicts, repairs incomplete installations, updates out-
- of-date components, and removes all traces of a program, including registry entries.

For more efficient disk space allocation, Windows 200_0 now supports the file allocation table. .. ...

. (FAT) 32 file system. The NTES file system includes many performance enhancements and new features
such as per-user disk quotas and file encryption, :
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Information travels faster with improved TCP/IP stack performance, reducing network traffic.
Files built with dynamic Hypertext Markup Language (DHTML) load more quickly. You can accommodate
the latest transmission technologies, mcludlng cable modems, through support for asynchronous transfer
mode technology.

Best of Windows 98

Windows 2000 contains key Windows 98 features, such as Advanced Configuration and Power
Interface power management, the DirectX technologies, and Web integration. It's as easy to install and use
state-of-the-art hardware with Windows 2000 as it was with Windows 98 because Windows 2000 also
supports Plug and Play, [EEE 1394, DVD, and the universal serial bus (USB) standards, And as i Windows
98, in Windows 2000 you can use multiple monitors with a single computer to dramatically increase the
size of your workspace.

Windows 2000 is compatible with more applications than ever before, continuing to support software
for previous versions of Windows-as well as older hardware. To ensure that you're using the highest quality
hardware drivers, the drivers are digitally signed by Microsoft after testing. Also, Windows 2000 is ideally
suited to support the demands of new programs; including distributed programs written usmg Windows
Distribuied internet Applications (Windows DNA) architecture.

Lower Total Cost of Ownership

Windows 2000 can reduce the total cost of ownership-the costs involved in administering personal

computer networks-compared with that of other versions of Windows. Remote installation, a disk imaging
tool, support for Windows 95 and Windows 98 upgrades, and the unattended Setup tools help administrators
gasily deploy Windows 2000, saving time and expense. With Windows Script Host, you can also automate

tasks with language-independent scripts. And Microsoft Management Console (MMC) consolidates several

administrative programs into a single interface you can use to manage and support local and remote
computers.

The breakthrough IntelliMirror technology uses the power of Windows 2000 Server to make it
easier for administrators to manage desktops remotely-cach user's documents, system files, and administrative
settings are stored on a server. Administrators are able to quickly dupllcate a Windows 2000 installation
from one computer to another.

Whether administering small businesses or large corporations, you can manage desktops centrally
using Active Directory service and its Group Policy support in Windows 2000. Administrators can deploy
software applications using group policies. Support for Windows Management Instrumentation, a program
management tool, reduces the maintenance cost of event reporting and makes managing device drivers
Casier. . e it — e e

And you can keep Windows 2000 current by using the Windows Update Web site, an extension
of Windows 2000. From this Web site, you can download system enhancements, such as drivers and
service packs. '

Multilanguage technology lets you view, print, and share documents from any localized language
supported in Windows 2000. A single version of Windows 2000 Professional can be deployed globally
while still allowing users to access information in their preferred language.

14 Accessibility for special needs

You can adi'ust the appearance and behavior of Windows 2000 to enhance accesSibility for some
vision-impaired, hearing-impaired, and mobility-impaired users without requiring addntlonal software or
hardware.

[6]



Windows 2000 includes the following programs to enhance acgessibility:
Magnifier enlarges a portion of the screen for easier viewing,

Narrator uses text-to-speech technology to read the contents of the screen a loud. This is useful
for people who are blind or who have low vision,

On-Screen Keyboarcl prov1des users with limited mobility the ability to type on-screen using a
pointing device.

Utility Manager enables users with administrator-level access to check an Accessibility program’s -
status, statt or stop anAccesmbzhtyprogram, and designate to have the program start when Windows
2000 starts.

Using Accessibility Options in Control Panel, you can easily set up how you want to use your

keyboard display, and mouse functions.

The accessibility tools available in Accessibility Options in Control Panel perform various functlons
StickyKeys enables simultaneous keystrokes while pressing one key at a time,

FilterKeys adjusts the response of your keyboard.,

ToggleKeys emits sounds when certain locking keys are pressed

SoundEntry provides visual warnings for system sounds,

ShowSounds instructs programs to display captions for program speech and sound°

High Contrast mproves screen contrast with alternative colors and font sizes. o
MouseKeys enables the keyboard to perform mouse functions. |

SerialKeys allows the use of alternative input devices instead ofa keyboard and mouse.

You can use the Accessibility wizard to help you set up the options and programs for your individual

needs. Please see Related Topics for information on using these Accessibility aids.

A wide variety of hardware and software products are available to make. personal computers

easier to use for people with disabilities. Among the different types of products available for MS-DOS and
the Microsoft Windows operating systems are:

Programs that enlarge or alter the color of information on the screen for people with visual
impairments.

Programs that describe information on the screen in Brallle or synthesized speech for people who
are blind or have difficulty reading.

Hardware and software utilities that modify the behavior of the mouse and keyboard.

Programs that enable the user to type using a mouse‘or his or her voice,

Word or phrase prediction software, that allows users to type more quickly and with fewer
keystrokes.

Alternate input devices, such as single switch or puff-and -sip devices, for people who cannot use

amouse or a keyboard.

The AcceSSIblllty tools that ship with Windows 2000 are 111tended to provide a minimum level of

functionality forusers with special needs. Most users with disabilities will need utility programs with higher
functionality for daily use.

[7]




1.5 HARDWARE REQUIREMENT OF WINDOWS 2000 _

Before you install Windows 2000, make sure your computer meets the following minimum
hardware requirements:

¢ 133 MHz Pentium or higher micfoprocessor (or equivalent). Windows 2000 Professional
Supports up to two processors on a single computer,

e 64 megabytes (MB) of RAM recommended minimum. _
32 MB of RAM is the minimum supported, 4 g.igabytes (GB) of RAM is the maximurm.

¢ A2GBhard disk with 650 MB of free space. |
If ydu’ré installing over a network, more free hard disk space is required.

s  VGAorhigher resoluﬁon monitor.

e Keyboard.

*  Microsoft Mouse or compatible pointing device (optional).

For CD-ROM installation:
» ACD-ROMorDVD drive.

*»  High-density 3.5-inch disk drive, unless your CD-ROM drive is bootable and supports starting
the Setup program from a CD. . _

Fofﬁetwork instailation;

- & Windows 2000-compatible network adapter card and related cable (see the Hardware.
Compatibility List, Hel txt, in the Support folder on the Windows 2000 Professional CD),

- ®  Accessto the network share that contains the Setup files.
1.6  DESKTOP ENVIRONMENT

- When you start Windows 2000 for the first time, you see icons displayed on the screen. The
Windows 2000 screenisa Desktop. The desktop is the first view of the Windows 2000'0perating
system. The desktop contains icons, shortcuts and the taskbar. The user can navigate the user interface
using the taskbar or the start menu. :

For starting WINDOWS 2000, simply switch-on the computer and you will come directly to
WINDOWS 2000 screen ( as shown in the figure given below). This screen is called the desktop
(metaphor), the settings of which can be changed as the user likes

~—

To adjust Settjngs such as desktop color and background, use the right mouse button to click
anywhere on the desktop, and then click Properties. .

The icons on the left side represent some of the accessories and tools. They provide the short
and easier access to the featums_that we will discuss in the later sessions. The bar that is at the bottom
o{ the screen is called the taskbar. R

[8]



Figare : Desktop of windows 2000
1.7 TASKBAR '

The Taskbar is a bar that appears at the bottom of the windows 2000 deskiop by default. The start
button is at the left end of the taskbar. All the applications that are runting appear as minirnized buttons on
the taskbar. The current window is displayed as a pressed button: all other applications are displayed as
raised buttons. Clicking on a button for an inactive application activates the application and displays its
window as the current window. The taskbar thus makes it easier to switch between applications.

figure: task bar

18  STARTMENU

The start menu is a menu located at the left end of the taskbar, Start menu is integral to the clean
 look of the Windows NT desktop because it belps you to minimize the clutter on your desktop. Clicking on
the start button opens a popup menu that makes help, the run command, a list of programs and a list of
recently accessed documents available to you, to execute with asingle click. From the start menu, youcan
customize the look and feel of windows, find files and folders and shut down your computer. For some
items, submenu opens to the side of the main item to display the list of choices'

9]




Figure : Start menu

s

Launching an Application

To start an application, select the Programs option and click on the program application you want
to execute. The Programs option displays a submenu with a list of sub options as displayed in Figure

Explorer as a part of its submenu.

The Accessories sub option includes Games, Multimédia, system Tools, Calculator, Calendar,
Paint, Hyper Terminal and WordPad. ’

This option is used to launch various applications. Alternatively, application can also be launched
through the Run option of the Start menu. The user needs to specify the name of the executable file and the
application is launched. Figure 4 shows the Run window. :

Figure : Run Menu

[10]
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DOS ASANAPPLICATION

Windows NT is a new operating system that is being used by a large number of computer usersall
over the world. Many companies however still use MS-DOS based applications. Therefore, supports for
these applications were a key design goal. Windows NT provides compatibility with MS-DOS based
applications. ' '

In Windows NT, DOS is an application by name CMD. EXE. This application displays a simulated .
screen of the DOS command prompt in the form of a window. ' '

To start command prompt application in the Windows NT server
o Selectthe programs option from the start menu
¢ Click command prompt in the programs sub-menu

The command prompt, which appears her, is C >, (Refer FIGURE 5) If drive C is currently
active, and you want to access the files on a diskette in drive A, you can change to.drive A by specifying A:
at the cursor position. o

_ Figure : Command Prompt _
Similarly, to change to drive C type C: and press <enter>.
19 MY COMPUTER

The My Computer window displays icons representing the various drives like A: C; etc and resource
icons like printers, dial-up networking and the control panel. The various drive icons Jet you-access the
contents of each of the drives. The printers icon is a folder represent in the collection of printers installed in
the system. It also lets the user install a new printer. Every window has three buttons on the right-upper
corner that can be used to minimize, maximize and close the window. Ina maximized window; the maximize
button is replaced by the restore button. FIGURE 2 displays the My Computer window. '

Use My Computer when you want to view the contents of a single folder or disk. A disk is a
device, such as a hard disk or floppy disk, on which you can store files. When you double-click My
Computer on your desktop, icons representing the available drives appear in a new window. When you
double-click adrive icon, a window displays the folders contained on that drive. You can then double-click
anicon to open the folder or file. :

Some of the following icons may appear in the My Computer window,

[11]




Double- ' o
dick | To

View the contents of the floppy disk, which is usually designated as A.

|View the contents of the hard disk, which is usually designated as C.
|View the contents of a network drive, if your computer is connected to one. |

View the contents of a compact disc in the CD-ROM drive, if your
computer has one.

e rrerrrm———
IView features you can use to modify your computer settings. .

lSet up a printer and view information about available printers and print job
status. _ : :

Schedule or view tasks for computer maintenance.

View the contents of a folder.

View files and folders on a Web server, if your computer is connected to-
one. - '

R

BHASKAR (C:)

My Cump.utbr Control Panel

BHASI (E:)
Local Disk

BHATT (D)
Copacity. 5.51 GB '
Used: 4.26 GB
Free: 1.24 GB

(F:)

Figure: My Computer

-1.10 RECYCLE BIN

Windows stores deleted files in the Recycle Bin. Which s locétcd on the desktop? You can use the
recycle bin to retrieve files that you have accidentally deleted, or empty the recycle bin to create more disk
space. '

When you delete a file or folder, it is removed from the folder where it used to be. It moves the file

from the folder to a storage area, known as the recycle bin. You see the recycle bin as an icon on your
desktop (REFER FIGURE) '

{12]



Recycle Bin

Fgure: Recycle Bin Icon

Windows NT moves all deleted objects - files folders, shortcuts, and printers - into the recycle bin
as a precautionary measure, In case a file is deleted accidentally, you can double-click on the recycle bin
icon and move the file (s) back to their original location by selecting the restore option from the file mena.
However, if the files have to be deleted, they should be deleted from the Recycle Bin. Figure 21 shows the
Recycle Bin window and the options that the file menn provides for managing the files in the Recycle Bin

e
Recycle Bin

This felder contains fllas and foiders
Ehat yeu have delebed from vour
omplger,

Thara are no kems n the Recyde
Bin.

Figure: Recycle Bin Folder .

111  CONTROLPANEL

Control Panel is a convenient way to customize your computer, From Control Panel you can add
and remove programs, fonts, and hardware; control hardware, such as yourmouse and modem; and select
folder, display, and sound options.

S - . . :
i Puirasy Stadhimd [T T 1Y O |
Control Panet T Paoworls  Dililug 0o
R Py . .
. umtlmmmwmtmklrd?ﬂnn!tn i L‘@} % _ {»fg’ﬁw 5
B R O o , .
prrIeIRES Yo tokeuter Fome  Adehitraive Am)femove Fokler Gubins ¢
SRk e T b wign ks Toois Programs . i
dbscrighion, - s » ’
. 4 - R i
Wit S000, Scgur © T Display Bddifomare  Enternce feqiooal
- o ) Hardeaan - itk - Cptiong
< 5 AV
Ilergsa Hophoant  Sounsdanmd Scanners ang
- Hultneds Cammar s

Figure: Control Panel
(131




To open a Control Panel item _
1. Click the Start button, point to Settings, and then click Control Panel.
2. Double-click the icon of the feature you want to open.
' Choosing Folder Options

Use Folder Options in Control Panel to change how your desktop appears and how you browse
through your files and folders. You can choose Web-style options, keep familiar options from earlier versions
of Windows, or choose a combination of both.

You can use Folder _Options to choose whether:
o TheActive Desktopis on or off.
e  Web-like content appears in folders.
e  Youbrowse folder content in multiple windows or a single window.
o Youdouble-click or single-click to open files.
To ohange your folder options
You can also double-click My Cornputer and then on the Tools menu, click Folder Options.
1. Click the Start button, point to Settings, and then click Control Panel
Control Panel appears.
2. Double-click the Folder Options icon,
The Folder Options dialog box appears.
3. Onthe General tab, click the folder options jfou want, and then click OK.
112 WINDOW EXPLORER |

Windows Explorer displays the hierarchical structure of files, folders, and drives on your computer.
Tt also shows any network drives which have been mapped to drive lefters on your computer. You can also
view My Network Places, which lists other computers that are connected to your local area network
(LAN). Using Windows Explorer, you can copy, move, rename, and search for files and folders, For

example, you can open a folder that contains a file you want to copy or move, and then drag it to another

folder or even another drive.

There are other places in Windows 2000 where yoo-can view and work with files and folders. My |

Documents is a convenient place to store documents, graphics, or other files you want to access quickly.
When you delete files or folders from your hard disk, Windows 2000 places them in the Recycle Bin,
where you canretrieve them. Files or folders deleted from a floppy disk or a network drive are permanently
deleted and are not sent to the Recycle Bin. For information about My Documents or Recycle Bin, see
Related Topics.

You can also navigate in Windows 2000 by using the taskbar (including the Start button), My
Computer, Windows Explorer, or My Network Places. In some cases, one way is more efficient than

another. For example, it's faster to start programs from the Start button than from Windows Explorer, but,

Windows Explorer gives you a more complete picture of all of the files on your computer. In other cases,
the choice is personal preference. ‘When browsing through folders (containers for documents and programs),
for instance, you can use either My Computer or Windows Explorer-it's a matter of how you prefer to
display the contents of your computer. The following sections familiar you with some of your choices.
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To create a new folder -

L
2
3,
a,

Open Windows Explorer. _

Click the drive or folder in which you want to create a new folder,
On the File menu, point to New, and then click Folder.

Type a name for the new folder, and then press ENTER.

Note

To open Windows Explorer, click Start, point to Programs, point to Accessories, and then click
Windows Explorer,

You can also create a new folder by right-clicking a blank area in the right pane of Windows
Explorer or on the desktop, pointing to New, and then clicking Folder. '

To select multiple files and folders -

1.

2.

Open Windows Explorer.
- Click the drive or folder you want to work with, and then do one of the following:

To select consecutive files or folders, click the first item, press and hold down SHIFT, and thén
click the last item, '

To select files or folders that are not consecutive, press and hold down CTRL, and then click each
item.

To select all the files and folders in the window, click the Edit menu, and then click Select Al

To copy or move a file or folder -

1.
2.

Open Windows Explorer.

Click the drive or folder you want to work with,

(15]




3. Click the file or folder you want to copy or move.

4. OntheEdit menu, click Copy. Or, click Cut to move the item.

5. Open the folder or disk where you want to copy or move the item.

6. On the Edit menu, click Paste.

Notes

| . | To select consecutive files or foldefs to copy or move, click the first item, press and hdld down

_ SHIFT, and thenclick the last item.
o  Toselect files or folders that are not consecutive, press and hold down CTRL, and then click each

_ item. o

To move files by dragging

1. Open Windows Explorer.

2. Find the file or folder you want to move.

3. Make sure the destination for the file or folder you wantto move s visible.

4, Dragthefile or folder o the destination. |

Notes o |

If you drag using the right mouse button, a menu appears with the commands Move Here, Copy
Here, Create Shortcut(s) Here, and Cancel. Click the command you want. T

To copy the item instead of moving it, press and hold down CTRL while dragging. |

I you drag an item to another disk, it is copied, not moved. To move the item, press and hold .
down SHIFT while dragging. o

To delete a file or foder -

Open Windows Explorer.
Click the file.or folder you want to delete.

- On the File meny, click Delete. S _ -

Deleted files remain in the Recyclcl Bin until you empty it unless you press and hold down SHIFT
while dragging an item to the Recycle Bin. Then the item is deleted from your compuier without
being stored in the Recycle Bin. . : = '

Ifyou want to retrieve a file you have deleted, doubleclick Recycle Bin on the desktop, right-click
the file you want to retrieve, and then click Restore. ' : '

~You can also delete files or folders by right-clicking the file or folder and then clicking Delete.

To create a shortcut in a folder -

1.

2
3.
4

'Open Windows Explorer.

‘Inthe Folders list, click the folder in which you want to create the shdﬁcut. N

On the File menu, point to New, and then click Shortcut.

~ Follow the instructions on your screen.

[16]




Notes '

To open Windows Explorer, click Start, pomt to Programs, pomt to Accessories, and then cllck
Windows Explorer. o

Folders can also be opened by double-chckmg the folder in L’ne detalls pane on the right,

A shorteut is a quick way to starta frequently used program or open a file or folder without having_
o go to its installed location. For mformatlon about creating shortcuts on the desktop or Start
ment, see Related ‘Topics.

To change the name of a file or folder

1.

Open Windows Explorer.

Q_lick/ﬂle file or folder you want to rename.

‘On the File menu, click Rename,

Type the new name, and then press ENTER.

- Youdo nd_t need to open the file or folder to rename 'it..

- Afile name can contain up to 215 characters, including spaces. However, it is not recommended

" that you create file names with 215 characters. Most programs cannot interpret extremely long file -

names. File names cannot contain the following characters:
Vx> )
You can also rename a file or folder by right-clicking it and then clicking Rename.

The name of system folders such as Documents and Settings, Winnt, or System32 cannot be

. changed because they are required for Windows to run properly

'To search for a file or folder

SR

Notes
L ]

Click Start, point to Search, and then click For Files or F olders.

' In Search for files or folders named, type all or part of the file name or folder ybu want to find.

To search for files containing specific text, in Containing text, type the text you want to find.

~ InLookin, click the drive, folder, or network you want to search.

“To specnfy additional search cnterla, click Search Options, and then chck one or More, of the_'

following options to narrow your seaich:

Select Date to look for files that were created or modified on or between specific datcs.

" Select Type to look for files of a specific type, such as a text or WordPad documént. :

Select Size to look for files of a specific size.
Select Advanced Options to specify additional search criteria.
Click Search Now. '

Ifyou get too many results, try entering addltlonal search criteria to make your searchmore SpeClﬁC '

To clear the search criteria ﬁelds and begin a new search, click New.

[17]



e  Under Advanced Options, Search slow filesrefers to files that reside on removable storage media,
such as optical or tape backup. These files may need to be copied to a faster storage medium
before the contents can be searched. :

To change file or folder properties

1. Open Windows Explorer.

2. Click the file or folder whose properties you want to chenge.
3. On the File menu, click Properties. ‘

e Youcanalso right~click a file or folder and then click Properties.I

e Tochange properties for archiving, indexing, compression, or encryption on NTFS drives , right-
click the file or folder, click Properties, click Advanced, and then select the Optlons you want to
change. '

1.13  WINDOWS 2000 ACCESSORIES
- ~ Inthe following session, we will discuss the various accessories in more detail.
RUN YOUR PROGRAMS
~ Torun the accessory programs, fellow the instructions:
1. Click the Start buston. |
2. Then click on Programs, and then click on Accessories.

-3, The cascading menu appears Click onthe program you want to run

Figure: Wmdow Accessones

To run other programs, that have been created by the users :

1. Click on Run... option from the Start menu.

2."  Rundialog box is opened. In the Open text box, enter the path name of the program you want to
run. 4 '

3. If you do not remember the name of the file, click on Browse... button.
In the Browse window, lock in text box llsts the available drives, folders, and fi les Chck on the

P

" down-arrow. _ _
5 To see insidea folder chck it, The box below shows the folders and files in the selected locatlon.
6 Doublc-chck afolder or file to openit. |
7. To open the folder one level higher, chck on the toolbar.
8 Onge the file is located, click on Open and then click on OK from the Run wmdow
General Use '

The usual accessory programs that are used are easy and useful to work with. They are prov1ded
for performing certain day-to-day aC’tIVLtleS of the users.
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CALENDAR |
Windows Calendar is used fo view the current month's calendar that shows the day and date, and

also the current day showing the timings to keep track of your appointments. To display either of the

- mentioned views, click on the View option, and select whichever you require.
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. Figure: Calender

Above given are the sahlples_ of two views. The left window displays the day schedule to track -

your appointments, whereas, the right window displays the month calendar.
CALCULATOR N |
You can use Calculator in standard view to do simple caloulations, oruse it in scientific view to do

‘advanced scientific and statistical calculations. You have been using this program in earlier versions of

Windows also.

BO9FTIFITITIEG.

_ E Figure: Calculator
'CHARACTER MAP

' Character Map works only with Windows-based progmms. Thisis used to insert aspecial character

into adocument. _ _ _ _

- Toinsertaspecial character in the document; follow the given steps
1. Select Character Map from the cascadmg menuof Accessofies.
2. Click the Font box, and then click a font. -

3. Tomagnifya character in Chatacter Map, lick it and hold down the mouse button, Double-click
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each character you want. The character(s) will appear in the Characters To Copy box.
4. ClickCopy.

: 5. I your document, click where youwant the character(s) to appear, click the Edit menu, and then
- ¢lick Paste, -

6. Select the characters, and then change them to the same font you used in Character Map.
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Figure : CharacterMap
- PAINT | | |
_ Paint is a bitmap-painting program with a full set {5
of painting tools and a wide range of colors. You can use it to
 create, edit, and view pictures. The pictures created by Paint can-
_be pasted into another document you have created, or use it as

- your desktop background. You can even use Paint to view and
' 'edlt scanned photos. _

To start Paint, select Paint from the cascadmg menu of
Accessories.

‘The Paint window consists of a workspace, or canvas,
‘where you paint pictures. To the left of the canvas is the Toolbox,
- which contains a set of painting tools. The color palette is at the
bottom of the canvas. The selection box is on the left side, where
you select the width of lines or pen tips to use for the Brush, Line,
Eraser, and other tools. To paint, select atool, acolor, and a line
width, and then start painting on the canvas.,

Figure: PAINT

| -WORDPAD
‘WordPad is a text editor for short documents. Though, this accessory does not have the advanced

features of full-blown word processors like MS Word. You can format documents in WordPad with

- various fonts and paragraph styles.
| To start WordPad click on Start men, then on Accessones and then on WordPad
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Figure: WORD PAD
Onee WordPad is running, you can do the following;: |
1. Specify the initial page layout for a document, such as paper size and margin settings.

2. Type, edit, and delete text, as well as copy or move text from one place to another. You can also -
copy or move text between two different applications.

3. Change the font, style, and size of characters, and change the alignment and mdents of paragraphs -
- You can also set special tabs and create bulleted or numbered lists. :

4, Searchfor previously typed text or replace text with new text, S ._ R C -
5. Create oompound documents that contain pictures, spreadsheet data, charts, sound, and wcleo_ ‘
created in other applications. . S
NOTEPAD | - |

You can use Notepad to create or edit text files that do not require fonnatmlg and are smalierthan
64K Notepad opens and saves text in ASCI (text-only) format only. To create or edit files those require '
formatting or ae. larger than 64K, use WordPad. Notepad loads very quickly and is easy to learn and use.

To start Notepad click on Notepad from the cascading menu of Accessones.

Figure : NOTEPAD

Now youcan type text in the workspace and use standard editing techmques to insert, delete and
copy or move text.

[21]




ENTERTAINMENT
MULTIMEDIA IN WINDOWS 2009

The previous versions of Windows and DOS were not designed to support multimedia, therefore,

the muitimedia presentations were either not running or running very slowly, With WINDOWS 2000,
things are improved as it supports multimedia at the base level, as discussed below:

Multimedia presentations require more than one media, and WINDOWS 2000 is a 32-bit,
multitasking and multithreading operating system. This assures playing more than one media smoothly,
and more responsive to user interaction.

During installation procedure of W]NDOWS 2000, it automatically detects and configures itself
for multimedia devices. :

WINDOWS 2000 allows you to create compound documents that include sound, video, rapmcs,
chatts, pictures, and other elements from various applications.

A new CD-ROM file system in WINDOWS 2000 improves CD-ROM performance.

An AutoPlay feature makes it easy to set up and play back programs on CD-ROM.

The video standard in WINDOWS 2000 is widely supported in the computer indusuy.
WINDOWS 2000 supports larger video windows and higher frame rates.

WINDOWS 2000 supports Sony VISCA interface which means that you and your apphcatlons

. can control VCRs and laser disc players.

New graphic programming interface improves the game performance in

WINDOWS 2000 .

WINDOWS 2000 supports a variety of industry-standard sound and video compression codecs
(coders / decoders). Codecs reduce the size of multimedia files. '

All the multimedia controls can be changed or edited from the Multimedia Properties dialog box.

- Toopen this box, open the Control Panel and double-click the Multimedia utility.

Figure : MULTIMEDIA PROPERTIES
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MULTIMEDIA TOOLS

WINDOWS 2000 offers accessoties for editing and listening to sound, playing movies, and playmg

mugsic CDs,

To access these accessorics, follow the given steps:

1.

2
3,
4

Open the Start memu.

Select Programs from the menu.

From the cascading menu, click on Accessories.

Then cliok on Multimedia from the cascading menu of Accessories.

The options of the Multimedia menu are - CD player, Media Player, Sound Recorder, and Volume

Control Each of these is discussed in the subsections.
CDPLAYER

You can use CD Player to play audio compact discs from a CD-ROM drive connected to your

computer. To use CD Player, you also need a sound card.

ritls .. Track1
Track1 - L g PR
New Artist _ GGUQ

Fig: CD PLAYER
Before playlng a CD make sure it is in'the CD-ROM drlve, and then click the start button as

shown in Figure. Your CD continues to play even if you minimize CD Player.
MEDIAPLAYER

You can use Media Player to play audio, video, or animation files, and to control the settings for

multimedia hardware devices. To use Media Player also, you should have a sound card.

Avsthar:
apyight.

Figure : MEDIAPLAYER
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SOUND RECORDER

" The Sound Recorder is a handy but somewhat limited digital recorder. Using Sound Recorder you
can record, play, and edif sound files. To use Sound Recorder, you must have a sound card and speakers
installed on your computer. I you want to record live sound, you also need a microphone. This multimedia
utility can be used to create recorded messages and include them in files or include them in electronic mail
messages that you send to other users. ' '

Flgure SOUND RECORDER

To record anew sound, follow the steps given:
1. Attach amlcrophone tothe soundboard or attach cable from anothcr souncl source, such asa CD '
' audio playcr orstereo, - -~ .

To customxzc record:mg op’uons, choose Propmﬁes from the F11e menu.

_ Choose recordmg format inthe Format Conversmn field.

Chck the Convert now button that opens the Sound Selection cllalog box,

In the Name ﬁcld, specify the quality of sound from the pull-down list - CD Quality, Radio Quality,
or Telephone Quality. For every option of the Name field that you select, note the contents of the -
Format and Atiributes ﬁelds, which show the recordmg OpthIlS and disk space requirements in
seconds,

VOLUME CONTROL

Ifyou havea sound card, you canuse Volume Control to control the volume and speaker balance
when: you play audio files. '

thooB W N

2

~ Toadjust the volume for mult1me:d1a devmes, open the Multlmedla Propertles dlalog box. Inthe
Playback or Recordmg area, drag the Volw‘ne slider.

Flgure VOLUME CONTROL
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1.14 MANAGING HARDWARE AND SOFTWARE AND ITS INSTALLATION
SYSTEM SETTINGS : Ce '

The System can be personahzed by making interesting and useful changes to WINDOWS 2000
settings. For example, you can :

® Ad_lust the double-click speed for your mouse.
IS : Change number, currency, time, and date settings.
. Change printer settings.
e Change settings for network service,
. Chahge background of your desktop.
¢  Change the capacity of the Recycle Bin.
. Change the number of colors your monitor displays.
e  Have your monitor automatically tum off.
. Change. the séreen resolution.
e  Change display fonts. |
L 'Pmtect_your screen by setting-up a screen saver,
o  Configure multimedia devices. '
s  Enable multiple users to personalize settings.
e Viewor change resource settings for a hardware devnoe
CONTROLPANEL

When you click on the option Control Panel from the cascading menu of Settings, a window is
opened that contains the icon of the utilities for changing hardware cqnﬁguratlons or customizing the
WINDOWS 2000 graphical interface as shown below

Lonhul Pan:.l

._F!egonal Souncs Systm
Swtlings i

Figure : CONTROL PANEL

You can also access the utilities of Control Panel, if you click on My Computer and then on Control
Panel icon.
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1.15

ADD/REMOVE APPLICATIONS (SOFTWARES)
The WINDOWS 2000 components, accessories, or other applications can be added orinstalled,

and removed by using the Add/Remove Programs utility from the Control Panel window. The advantage of
using this utility is that WINDOWS 2000 maintains control over the installation process by making proper
entries into the registry.

1.16

To install an application, click on Install... button. While installing the application, the wizard helps
you to complete the process step-by-step.

To add a program, select it from the displayed list of programs and then click on Add/Remove
button. _

To remove the application, again select it from the displayed hst of apphcanons and programs and |

_chck on Add/Remove button.

ADD NEW HARDWARE _ -
To set up new hardware

Click on the Add New Hardware icon (as shown) to start Add New Hardware wizard,

Figure: AddNeaw
Hatdware

Simply, follow the instructions onyour screen.

It is recommended that you let Windows detect your new hardware. Make sure you have connected

your hardware or installed its oomponents in your computer before running the wizard.
1.17 PRINTERS
WINDOWS 2000 has significant advances inprinting features These are:

It supports bi-directional communication with prmters so that prmters can provlde WINDOWS
2000 with mfonnanon about their current state and attnbutes S

The WlNDOWS 2000 pnntmg system also returns control to users more qulckly after ajob is
sent to the printer due to a new print spooler.

Mobile and remote users can defer their printing job until later if they are not connected to a printer. '
Print jobs are stored ina local queue and automatically sent to the printer when they reconnect with-
the printer or reconnect to a network that has printers.

“ Prinhera?

E|  This keider contains information
| obsout peinbans that ane Cunpertly
: mldll:l.mdamdlolnbm. E
| Instsknaw printasy. g
Tio gel nfoumation aboul 2 prinket

Vsl i coatarbly sl aBad, iight-chick
Fhe tuinter's icon i

Figure: PRINTER CONTROLS
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To change printer settings

1. Selectthe object Printers from the Control Panel window:

2 From the Printers window, click the icon for the printer you are using.
3. On the Flle menu, click Propertles
4

The settings you can change depend onthe type of printer you have. CAlck the deferent tabs to see
all of the options you can set.

Changing the printer properties will change them for all documents you print on this printer, To
change these settings for one document, use the Page Setup or Print Setup command on the File meny in

your program.

To set up a new pi-mter

1. SelectAddPrinter icon from the Prmters window.

2. AddPrinter Wizard is opened, and follow the instructions on the screen.

3. If you want to print a test page, first make sure your printer is on and ready to print.

If you want to use a shared network printer, you can set it up quickly by 'browsing for it in Network
Neighborhood, clicking the printer’s icon, and then clicking Install on the File menu.

L18 SYSTEMTOOLS (DISK DRIVE UTILITIES).

- WINDOWS 2000 includes utilities to format diskettes, Check d1skettes and hard drives for errors,
defragments disks, and do other.types of maintenance. Some of these utilities are discussed below.,

Te aceess these utilities

1. Open the Start menu and select Programs.

2. Choose Accessories and then System Tools. The cascadmg menu that appears includes the various
* Disk Drive utilities.

- Figure: SYSTEM TOOLS

119 DISK DEFRAGMENTER

Disk Defragmenter is used to rearrange files and unused space on the hard disk so that progralm
run faster.

To speed up your hard disk by using Disk Defragmenter, follow the instructions given below ;

1.  Fromthe cascading menu of System Tools, select Disk Defragmenter. Select Drive dialog box is
opened to select the drive you want to defragment.
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Figare : DEFRAGMENTER

2. Click the drive you want to defragment, and then click OK.
3. Ifyou want to change the settings that Disk Deﬁagmenter uses, click Advanced...
4, Click Start. '

While Windows defragments the selected disk, the computer can safely carry out other tasks. |
However, the computer will operate more slowly. To temporarily stop Disk Defragmenter so you can run
other programs at full speed, click Pause. :

1.20 CHECK FOR DiSK ERRORS (SCAN DISK)

You can use Scandisk to check your hard disk for logical and physical errors, and then repmr the
damaged areas.

To check your disk's surface, ﬁlcs, and folders for errors
1. Select the option Scandisk from the cascading menu of System Tools.
2. Click the drive you want to check.

3. Click Thorough. If you want to change the settings Scandxsk uses when checkmg the disk's surface,
click Options. If you want to chcmge the settmgs Scandlsk uses when checking files and folders,
click Advanced.

4. Click Start.
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Figure : SCAN DISK

If you want to specify how Scandisk repairs any errors it finds, make sure that the Automatically
Fix Ervors box is not checked. ' '

The Swndard 1ype of test is only to check errors in fi files and folders, but does not check the disk
surface.

DRIVE SPACE

You can use DriveSpace to compress both hard and floppy disks to create more free space for
files. You can also use DriveSpace to configure disk duves that you have already compressed by using
"DoubleSpace or DriveSpace.

To determine how much space is avallable on a disk

1. Double-click the My Computer icon, and then click the disk you want to check.

2, On the File menu, click Properties, A pie chart shows how much free and used space is on the
dis.lc '

To cmatc more disk space by using DrrvaSpacc

‘1.~ Inthe Drives On This Computer list, click the drive you want to compress. -

2. On the Drive menu, click Compress.

3 o _Cllck Start

_4 .

. “Ifyou have not backed up your ﬁles click Back Up Files, and then follow 'the instructionis on your
~ screen. When you ate clone, proceed to step 6. '

v

Cllck Compress Now.

6. If Windows prompts you to restart your o f'!;fér, click Yes,
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7. If you want to free up more disk space after your computer restarts, start the Disk Space
Troubleshooter again. : '

R

121 BACKUPYOUR DATA

_ You can use Backup to back up files on your hard disk. You can back up files to floppy disks, a
tape drive, or another computer on your network. When you have made a backup file, you can restore it
if your original files are damaged or tost.

There are two ways you can backup your files :

¢ Youcan backup files on your hard disk tb a floppy disk or other media by using simple copy -
techniques. . '

e  TheMicrosoft Backup utility can also be used, which compresses files and puts them in an archive,
These compressed files can be copied to a floppy drive, tape drive or other backup device,

- To start the Backup utility |
1. Click Start and select Programs.
2. Select Accessories from the cascading menu, and then click on Systemn Tools.

3. Now click on Backup.If this utility is not present in the cascading menu of System Tools, then
probably this utility was not installed when you set up the system, :

Figure : BACK UP & RECOVERY

To install the Backup ﬁtility, follow the instructions given below :
1. Startthe Add/Remove Programs utility from the Control Panel window.

2. Click the Windows Setup tab and click the Disk Tools option in the window,
3. Then click OK to install the Backup utility, and then follow the instructions on the screen.

- While restoring backup files, again the Microsoft Backup utility is used, Restoring the files may
pose a problem if you need to restore them on a system that does not have this utility or is not rinning
WINDOWS 2000. In that case, other backup method may be used.

1.22  Clipbhoard Viewer

- When you cut or copy information from a program, it is moved to the Clipboard and remains
there until you clear the Clipboard or until you cut or copy another piece of information, The Clipboard
window in ClipBook Viewer shows the contents of the Clipboard. You can paste the information from the
Clipboard ifito any document as often as you like. However, the information is only stored on the Clipboard
temporarily.
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Using ClipBook Viewer, you can cut or copy information from another progrant and store itina
page that vou can name, save, use again, and share with others.

You can share ClipBook pages with others who have CllpBook Viewer installed on their computers,
and they can share their ClipBook pages with you,

You can also save the contents of the Clipboard to an individual Clipboard file instead of a CllpBook
page. These files generally have the extension .clp and cannot be shared with others.

The Clipboard can store text in different formats, such as the Text character set (used by most
Windows 2000 and Windows NT-based programs), the OEM Text format (used by MS-DOS-based
programs), and the Unicode character set (a superset of all of the major scripts used in the world). The
View menu gives you the ability to see your data in various formats.

In Windows 2000, Clipboard Viewel has been renamed Clipbook Viewer, ClipBook Viewer
shows you the information you have copied to the Clipboard. You can store information permanently in
your Local ClipBook and share it with other users. The Local ClipBook opens when you start ClipBook
Viewer. For information about using ClipBook Vlcwer sec Re lated TOplCS or click the Help menu in
ClipBook Viewer,

Note ]
® Toopen ClipBook Viewer, click Start, click Run, and then type clipboard.

Veliile resLoting kazku) fes, s1ak: the Micresefl Backup
a3y 050 2 protieen F yeu need [0 rustore (it on a sys.
oF i% R FRANYE YEHEOWS 2000, In (v casin, oAlier hoc!

Figure : CLIPBOARD VIEWER

1.23  SYSTEMINFORMATION

| Figure : System Information
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In Windows 2000, you can use System Information in Computer Management to collect and
display your system configuration data. Support technicians require specific information about your computer
so that they can resolve your systetn problem. You can use System Information to quickly find the data they
need. For information about using System Information, see Related Topics or click the Action menu in
Computer Management, and then click Help.

1. Open Computer Management (Local).

2. In the console tree, double-click System Tools; and then click System Information,

Note
» To open Computer Management, click Start, poi'nt to Settings, and then click Control Panel.
Double-click Administrative Tools, and then double-click Computer Management. -

1.24 NTES . _ _

The NTFS file system is the recommended file system for use with Windows 2000. NTFS has all
of the basic capabilities of FAT, and it provides the following advantages over the FAT and FAT 32 file
systems:

. Better file security.
o Betterdisk compression.

¢ Support for large hard disks, up to 2 terabytes (TB). (The maximum drive size for NTFS is much
greater than that for FAT, and as drive size increases, performance w1th NTFS doesn't degrade as
itdoeswithFAT,) -

If you're using a dual-boot configuration (using both Windows 2000 and another operating system
on the same computer), you may not be able to gain access to files on NTFS partitions from the other
operating system on your computer. For this reason, you should probably use FAT32 or FAT if you want
adual-boot configuration. o

| An advancad fle system desined or e speciicall Luilhin the Windows 200 aperaiing system. It suppors fe system
1| tecovety, esrenely lige storage media, long e names, and varius features forthe POSIX subsystem. It lso suppors
| obieotariznted appkcations by bealig o lesrascbect wi osr dfied i sytem defned atiudes.

i HBOURHgOD (MY NETWORK PLACES )

In Wmdows 2000 Network Neighbourhood has been renamed My Network Places and is located
onthe desktop. My Network Places provides a view of all the shared computers, files and folders, printers,
and other resources on the network to which your computer is connected.

A network is a group of computers connected to one another so that they can share resources such
as files and printers. If your computer is connected o a network, you can use My Network Places to
browse network resources the same way you browse the contents of your own computer. When you
double-click My Network Places on your desktop, icons representing network resources appear ina
window:

Some of the folloWing icons may appear in My Network Places.
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Double

A crick To

i

=
{[Create a shorteut to a specific network location. Runs the Add Network Place
wizard, which helps you create a connection to a shared folder, 2 Web folder

on the internet, or a FTP site.

==
Display ail of the computers, prmters files and folders, and people on your

§ organization's network _

Display only those computers in your domaln or workgroup

To open network resources
1. On the desktop, double-click My Network Places.

2. If you want to browse shared resources in your workgroup, double-click Computers
- Near Me. The computers and resources in your workgroup appear.

LI you want to view all of the resources available on the network, double-click Entire Network.
Depending on how your network is set up, you may see computers arranged by domain or by
workgroup.

3. Double- cllclgthe item you want to open, just as you would open drives and folders on your own
computer

1.26 SHARING INFORMATION BETWEEN PROGRAMS -
Concept of OLE- OBJECT LINKING AND EMBEDDING

Cutting information from one document and pasting it into another is a good way of reusing
information, When you paste information into a document, the information that you paste becomes part of
the second document. If you make changes to the information in the original document, those changes will
not be reflected in the fragment that you pasted into the second document.

For Windows-based programs that support cffag-and drop functiohs, you can use linking or
embedding to transfer information from one document to another document, even if that document isin a
different program.

Linking means inserting informatjon that retains a connection to the information stored in the original
file, Linking keeps the inserted information up-to-date by refreshing it when there is a change to the original
document. To link selected information, use the Copy and Paste Special commands on the Edit menu. To
link a file into your document, use the Objeet command on the Insert menu. For example, if you want to use
WordPad to create text that you can reuse in other documents, you can use the Object command on the
[nsert menu to insert the text into your document as a linked WordPad file. Then, whenever you make
changes to the text in the WordPad filg, those changes automatically appear in any other documents that
contain a link to that WordPad file. Some programs do not support linking.

Embeddmg means inserting information (such as text or a graphic) into a document ina different
program. The embedded information, or object, becomes part of the new document. Changes you make
to the original document will not be reflected in the new document. To edit an embedded object, double-
click it; the program in which the object was created opens. In order to edit an embedded object, the
program in which the object was created (or another program capable of editing the object) must be
installed on your computer, When you finish editing the object and return to your document, the document
reflects all of the changes you've made. To embed selected information, use the Copy and Paste commands
on the Edit menu.
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Use linking when you want the information t?_ be updated dynamically as the data in the source file
changes. Use embedding when you want to edit the information separately from the source file or if you
think the source file will not be available. ) ‘ _

To embed information in another document .

1. Selectthe information you want to embed in another document.

2. On the Edit menu, click Copy.

3. Click the location in the new'-document where you want o insert the infonnation;
4, On the Edit menu, click Paste Special, click Paste, then click OK.

Notes : .
¢ Notall programs support embedding. If embedding isn't supported, your information will be copied,
*  Youcanembed information in documents that were created in different programs.

!
¢  Iffyou want the embedded information to be updated when it is changed in the original document,

youmay be able to link the information instead of embedding it,
To copy information into anotherdocument
L. Select the information you want to copy.

2. Onthe Editmenu, click Copy.

3. Inthe document where you want the information to appear, click the location where you want to
place the information. -

4, On the Edit menu, click Paste.

Notes

¢  Youcanalso link or embed information.
*  Youcan paste the information multiple times.

To link information between documents:

1 Select the information that you want to link to another document..

2 On the Editmenu, click Copy.

3. Click the locatisonlin the new document where youwantto place the linked object.
4 Onthe Edit menu, click Paste Special. '

5. ClickPasteLink, then click OK.

‘e Some programs do not support linking. If linking isn't available, Paste Special will be available on
the Editmenu. ' ' o

s Youcanlink information between documents that were created in different programs,
Ways to share information in Application Programs-

There are many different ways to share information between Office programs. You can make ydur
decision based on how you want the information to appear in the program, whether you want the information
updated when it changes, and whom you want to share the information with,
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1.27 SUMMARY

MS-Windows 2000 is the most popular GUI for personal computers. Windows provides an environ-
ment that ephances DOS in many ways.

Winddws 2000 Professional offers increased compaiibility with different types of networks and witha

~ wide array of legacy hardware and software.

Common Look and Feel, Device Independence, Device Independence, Memeory Management, Suﬁé

. portforexisting DOS applications, Data Sharing, True 32-bit Operating System, Portability, Scalability,

Multitasking, Multiple User Support, Multi-Threading, Graphical User Interface are important feature
of windows OS, ' _ o _

The desktop is the first view ofthe Windows 2000 operating system. The desktop contains icons,
shorteuts and the taskbar. The user can navigate the user interface using the taskbar or the start menu.

- The start menu is a menu located at the left end of the taskbar. Start menu is integral to the clean look

of the Windows NT desktop because it helps you to minimize the clutter on your desktop.
Windows stores deleted files in the Recycle Bin, Which is located on the desktop.

Control Panel is a convenient way to customize your computer. From Control Panel you can add and
remove programs, fonts, and hardware; control how hardware, such as your mouse and modem,
behaves; and select folder, display, and sound options. :

Windows Explorer displays the hierarchical structure of files, folders, and drives on your computer, It
also shows any network drives which have been mapped to drive letters on your computer, '

WordPad is a text editor for short documents. Though, this accessories does not have the advanced
features of full-blown word processors like MS-Word. You can format documents in WordPad with
various fonts-and paragraph styles. :

The WINDOWS 2000 components, accessories, or other appli caﬁbﬁé can be added or installed, and

- removed by using the Add/Remove Programs utility from the Control Panel window,

WINDOWS 2000 includes utilities to format diskettes, Check diskettes and hard drives for errots,
defragments disks, and do other types of maintenance.

When you cut or copy information from a program, it is moved to the Clipboard and remains there until
you clear the Clipboard or until you cut or copy another piece of information. '
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1.28 UNIT-END QUESTIONS

1.

Describe in brief the following desktop items.
a. My computer

b. Network neighbourhood
c. RecycleBin

d. Internet Explorer

e. My Documents

. How you will manage file and folder with windows explorer.
. Whatis windows clipboard. Describe s usage and cut copy and paste operation.

. Descnbe different components of wmdows operating. |
5. How will you set up the DOS program in windows.

2
:
4
5
6.
i
8
9

What are the muljtnmedla devices work that work with windows.

. What do you mean by term Plug and Play.

. What is internet explorer, how do youenter the web addresses.
. Whatisa taskbar in windows, how you will customize it.

'10. What do you mean by OLE.

11, What s the use of control panel.

12. Bow will you install printer.

13. List various featufes of windows OS.
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Unit2: Doey mentation Using Worg Processor

Structure of the Unit

2.0
2.1
2.2

2.3

24

2.5

26

2.7 - C
. 271 Bulleted and numbered Jists -

Objectives
Introduction to Word processor
Getting Started -

2.2.1 Menus

222 Shorteut menus

2.2.3  Toolbarg

224 Customizing toolbars

Working With Files
2.3.1 Creating and opening documents
232 Saving documents
233 Renaming documents

234 Working on multiple documents

2.3.5 Close a document
Working With Text

241 Typing and insexting texy

2.4.2  Selecting tex
243 Deleting text

244 Formatting text
245 Format Painter

246 Undo

Formatting Paragraphs

2.5.1 Paragraph attribytes

252 Mowing, copying, and pasting texi
253 The clipboar_d C
2.54 Columps :

255 Drop Cap

Styles

. 2.6.1 Applyastyle

262 Apply astyle from the style dialog box |

263 ‘Create a new styles from a mode]
264" Createa simple style from the style dialog box

2.6.5 Modify or rename a style '
2.6.6  Delete a style
Lists -

- 272 Cu, Copy, Paste, Print PreviewAnd Printing

28

2.7.3  Nested hists

- 2.7.4 Fonnatting[ists

Tables

- 281 Insert Table button
- 2.82 Draw atable

283 Inserting rows and columns
2.84 Moving and resizing a table

285 Tables and Borders toolbar

- 2.8.6 Table Properties
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2.9  Graphics
291 Addingclipart
292 Addanimage fromafile
293 Editinga graphic
2.9.4 AutoShapes
210 Spellingand Grammar
2.10.1 AutoCorrect
2.10.2 Spelling and grammar check
2.10.3 Synonyms
2.10.4 Thesaurus
2.11 Page Formatting
2.11.1 Pagemargins
5.11.2 Pagesizeand orientation
2.11,3 Headers and footers
2.11.4 Page numbers
2,115 Printpreview and printing
2.12  Summary ’
213 Unitend Questions

2.0  Objectives
After compliting this unit you will be able to-
Define Ms Office and Ms Word

. .

. Word processing create file save file and open close aword document
' Text formatting ,Text gelection, Insert, Delete ,Redo,Undo

. Formatting toolbar Format Painter ,Paragraph Formatting

. Cut , Copy, Paste, Print Preview And Printing

21 Introdustionto Word Procéssing? :

Word Processing, incomputer terminology, refers 1o typing, editing and formatting of any kind of
document, which could be aletter, nemorandum, balance sheet, or something similar, As the term suggests,

word processing simply processes words, i.e. textual information. You can use itto print letters, tepoits, .

booklets, and so forth, in a suitable layout. A word processor does this by simply for-matting the information.
You ot someone else has keyed into the computer. (Keying information into a computer refers to typing
information using the computer keyboard.) _

What is Word Processing?

Waord Processing, in computer terminology, refersto typing, editing and formatting of any kind of
document, which could be aletter, memorandum, balance sheet, or something similar. As the term suggests,
word processing simply processes words, L.e. textual information. You can use it to print letters, repotts,
booklets, and 0 forth, in a suitable layout. Awotd processor does this by simply for-matting the information.
You or someone ¢lse has keyed into the computer. (Keying information into a computer refersto typing
information using the computer keyboard.) ' :

Word processing is different from conventional typing in many. ways. Here, the document is not
printed while itis being keyed in. However, its image is displayed on the video display unit (computer
screen) The user, who is typing the document, can vexify the cotrectness of document that is displayed on
the computer screen. If the user finds any mistake while typing or later, he/she can easily correct mistakes.
Once the user is sure that there are no mistakes in the document, it may he printed. The current word
processors are Very powerful. You can create any type of document using the powerful features of the
word processor. Some of the features available in most word processors are:
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Facility to create footnotes and endnotes.

Facility to create multiple-column text.

e Index and table of contents generation.

Spelling and grammar checking.

Thesaurus, etc.

While working on a word processor, you first key-in the document that you want to print, keying-
in the document, you can also use the various commands to format it in the desired way. You can check on-
the computer screen for mistakes and correct them. The word processing program normally helps youto
correct mistakes. Depending on the type of the word processor in use, the display on the computer screen
can resemble up o a 100% of the printed output that one gets on printing document.

When you use a manual typewriter, if you notice any mistakes after you have completed the typmg,
you may have to retype the document; a most cumbersome procedure. However, ina word processor, -
you can recall the document from computer’s memory, correct mistakes and reprint it. The corrected
document can be again saved in the memory for future use.

o Adjustable page size and margins. _
Printing selected text in boldface, italic or underlmed
Printing selected text in superscnpt ot subscript style.
Changing the font and the size of letters of the selected text.
Right justifying paragraphs (The last character of each lineis al1gned at the right margin.)
Adjustable line and characters spacing.

e & o o & @

Moving selected text to another location within the document or to another document.
2.2 Starting MS-0ffice

Tostartthe Ms-word

Start -> Programme -> MS-Office -> MS-Word

Screen Layout -

2.2.1 Menus

When you begin to explore Word 2000, you will notice a significant change in the menu structure
if you are familiar with previous versions of Word. The menus in Word 2000 display only the commands
you have recently used. To view all options in each menu, you must click the double arrows at the bottom
of the menu. The images below show the Format menu collapsed (left) and expanded (right) after the
double arrows at the bottom of the menu were clicked:
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 Followthe steps below to display menus similar to previous versions of Word with all the choices

a aye

listed inittally:
Select Vie»\dToolbarleustmﬂize from the menu bar.
® Click onthe Options tab. '

@ Uncheck the Menus show recently used commands first check box.

2.2.2 Shortent Menus

These features allow you to access various Word commands faster than using the options on the

menu bar. View shortcut menus by right-clicking with the mouse. The options on this menu will vary

depending on the element that was right-clicked. For example, the shortcut menu below is produced by
right-clicking ona butleted list. ' '

-

Actions such as "Decrease Indent” and "Increase Indent" are only applicable to lists and therefore
only appear on the list shorteut menu. The shorteut menus are helpful because they only display the options
that can be applied to the item that was right-clicked and, therefore, prevent searching through the many
menu options.

- 2.2.3  Toolbars

| Many toolbars displaying shortcut buttons are also available to make editing and formatting quicker
and easier. Select View{Toolbars from the menu bar to select the toolbars. The toolbars that are already
 displayed on the screen are checked. Add a toolbar simply by clicking on the name. - '

1403
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®  Select ViewlToolbarleustomize and click the Commands tab,

2.3
2.3.1 Creating ang Opening Documents

There are seveyal waysto create new docurments, Open existing documents, and save documents
in Word: : \

Create a New Document

® Click the New Document button, on the menu bar.
¢ Choose File]New from the menu bar,
® Press CTRL+N {(depress the CTRL key while pressing "N") on the keyboard.

Open an Existing Document

¢ Click the Open File button on the men bar.
® ChooseF ile|Open from the menu bar,
® Press CTRL+O op the keyboard.
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Each method will show the Opén dialog box. Choose the file and click the Open button.

2 3.2 Saveing Documents
e Clickthe Save button on the menu bar.
’ Select Flle]Save from the menu ar.
§ Press CTRL+S on the keyboard. '
2. 3 3 Renaming Documents |

" Totename Word document while using the program, select File]Open and find the file you want
to rename. ng,ht—chck on the document name with the mouse and select Rename from the shortcut meny.
Type the new name for the file and press -the ENTER key. .

2.3.4 Workingon Multiple Documents

Several documents can be opened simultaneously if you are typing of editing multnple docmnents
at once. Allopen documents are listed under the Window menu as chown below. The current document
has a checkmark beside the file name. Select another name to view another open document ot click the

_ puttononthe windows taskbar at the bottom of the screen.

2.3.5 Close a Document

Close the current document by selecting File]Close or click the Close icon if it's visible on the
Siandard Toolbar. o
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24 Working With Text
2.4.1 Typing and Inserting Text

To enter text, just start typing! The text will appear where the blinking cursm 1slocated Move the
cursor by using the arrow buttons on the keyboard or positioning the mouse and clicking the left button.
The keyboard shortcuts listed below are also helpful when moving through the text ofa document:

MoveAction =~ TiGystroke S e ]
Beginning of the line HOME """~ " T
End Of the Iine - ] E'Nﬁ' e ‘fl.”:.‘.":.h- JI‘-I-f-_ .. e .=
Top of the document CUIETRLAHOME T
End of the document ) et L GIRL'P;ENQ;»J{ g o T s Sl

24.2 Selecting Text

To change any attributes of text it must be highlighted first. Select the fé’%tby dmggiﬁé the mouse
over the desired text while-keeping the left monse button depressed; or hold down-the! SHIFT Keyior the

keyboard while using the arrow buttons to highlight the text. The following table contains shortcuts for

selecting a portionof thé tekt: - -

#

; - R ) oiE P
. MWhole word___[double~click within. the word. . e e
Whole paragraph [triple-click within, the paragtaph .~ ..
"'"""S“é{ie"f-al"#\ioi’"’&l‘i or Jdrag the mourse over the words, or hold down SHIFT
lines while using the arrow keys e
lEEltife& dogument:: ek

rechnique

%.

==
bl
@
m
fis
m
=¥
~
-,
0
£}
3
3
=
o
-
|
=
o
B

ey on
I NS TR T

PRE Deselcctthe textbyelicking anywhere-qutside of the selection onthe page ofipresslanidrrow k
the keyboard. 8 e g el et i o

© 2.4.3 Deletihg\;l‘?gxgg_-._:_:;'3__-_-.:_ S e
 Usethe BACKSPACE and DELETE keysonthe keyboardio deletetext.

thc; cursor and Delgtesw _.text to theright, To delete a
thé methods outlined aboveand press the DELETE key.

felt center st - - ipcreamer ighiight cotar
T jusificaTaa fdetraase
itdert |

® Style Menilf:—i:_sltylgs,_m@gplamed in detail later in thi tutsorlal

® Font Face - Click thé attovhiead fo (i ight ofthe font niame box 10 view the list of fonts available.
Seroll downito the font you want and select it by elicking on the name once with the mouse. A serif
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font (one with "feet" circled in the illustration below) is recommended for paragraphs oftext that |

Font Size - Click on the white part of the font size box to enter a value for the font size or click the

arrowhead to the right of the box to view a list of font sizes available. Select a size by clicking on it
once. A font size of 10 or 12 is best for paragraphs of text.

Font Style - Use these buttonsto bold, italic, and underline teﬁ.

- Alignment - Text can be aligned to the left, center, or right side of the page or it can be Justlﬁed

across the page.

Numbered and Bulleted Lists - Lists are expla.med in detail later in this tutorial.

e Increase/Decrease Indent - Change the indentation of a paragraph in relation to the side of the

page.

‘® Outside Border - Add a border around a text selection. |
e Highlight Color - Use this option to change the color behind a text selection. The color shown on

- the button is the last color used To select a different color, click the arrowhead nextto the image
onthebutton.

__® - Text Color - This option changes the color of the text. The color shown on the button is the last
~ color chosen: Click the arrowhead next to the button image to select another color.

The Font dialog box allows you to choose from a larger selection of formatting options. Select

FoﬁnatlFont from the menu bar to access the box.

" will be printed on paper as they are most readable. The following graphic demonstrates the difference ;i
between setif (Times New Roman on the left) and sans-serif ("no feet", Arial on the right) fonts.



2.45 Format Painter 3

i

A handy feature for formatting text is the Format Painter located on the standard toolbar. For
-example, if you have formatting a paragraph heading with a certain font face, size, and style and you want
to format another heading the same way, you do not need to manually add each atfribute to the new

headline. Instead, use the Format Painter by following these steps:
@ Place the cursor within the text that contains the formatting you want to copy.'

o Clickthe Format Painter button in the standard toolbar, Notice that your poiniter now has a paintbiush
beside it,

® Highlight the text you want to add the same format to with the mouse and release the mouse button.

To add the formatting to multiple selections of text, double-click the Format Painter button instead
of clicking once. The format painter then stays active until you press the ESC key to turn it off,

246 Unda
Feel free to experiment with various text styles. You can always undo your last action by clicking

the Undo button on the standard toolbar or selecting Edit{Undo... from the menu bar. Click the Redo
button on the standard toolbar or select Edit[Redo... to erase the undo action,

2.5 Formatting Paragraphs
2.5.1 ParagraphAttribute_s

Format a paragraph by placing the cursor within the paragraph and selecting Format{Paragraph
from the menu bar. '

Horzonkat fext -
elignment for

. hepargraph e seluct spesial
distarice the-~ fudents for first
text is indented 10 lines snd

h A ;
and right _ angingindents
of tha page

distance tha oy 3t the Ene
Ingdented spatitg
feext i from the for the text
tomt above and

below the
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2.52 Moving (Cutting) Text i

Highlight the text that will be moved and select Edit|Cut from the menu bar, click the Cutbutton

on the standard tool bar, or press CTRL+X at once. This will move the texttoa clipboard. Tomove a
small amount of text a short distance, the drag-and-drop method may be quicker. Highlight the text you
want to move, click the selection with the mouse, drag the selectionto the new location, and release the
mouse button. '

Copying Text _'

To copy text, choose Edit|/Copy, click the Copy button onthe standard toolbar, or press CT RL+C
to copy the text to the clipboard.

Paste Text

To paste cut or copied text, move the cursor to the location you want to move the text to and select

Edit{Paste from the menu bar, click the Paste button on the standard toolbar, or press CTRLAY.
2.5.3 TheClipboard

The last 12 elements that were cutor copied are placed onto Word's clipboard. You can view the |

elements on the clipboard by selecting View|Toolbars| Clipboard from the menu bar.

-

Place the mouse arrow over each element in the cliphoard to view the contents of each item and
click on an element to add its contents to the document: Cfick Paste All to add all of the items to the
document at once. Click the Clear Chpboard button (the icon with an "X" over the cllpboard image) to
clear the contents of the clipboard. :

2.54 Columns:

To quickly place text in a column format, click the Columns button on the standard toolbar and
select the number of columns by dragging the mouse over the diagram.

Formore column options, select F onnatholmnns from the menu bar. The Columns dialog box

allows you to choose the properties of the columns, Select the number and width of the columns from the
dialog box.
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2.5.5 DropCap

A drop cap is a large letter that begins _a,paragraph and drops through several lines of text as
shown below. '

will increase youwr kg
Office 2000 pmgrawms. -

L

rman

imes Mew Rao

Add a drop cap to a paragraph by following these steps:

® Place the cursor within the paragraph whose first letter will be dropped.
e (lick the Delete button.

& You will be asked if you really want to delete the stj(lc. Click Yes.
® Click Close on the dialog box.
. 2.6 Styles

‘The use of styles in Word will allow you to quickly format a document with a consistent and professional
look. Paragraph and character styles can be saved for use in many documents.
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2.6.1 Applyinga Style
® Place the cursor in the paragraph where the style will be applied.
e Click the Style drop-down menu on the Formatting toolbar and select a style by clicking onit.

e To apply the same style to multiple paragraphs, double click the Format Painter button on.the
standard toolbar and click in all the paragraphs that the style should be applled to. Press the ESC ’
key to disable the Format Painter.

2.6.2 Apply a Style from the Style Dialog Box
Choose from alarger selection of styles from the Style dialog box.

1 Body Text :
{1 Body Yext Z
{) Body Text 3
q| Body Text: Frst Tndent
4 Bady Text First Indent 2
9 Body Text Indent
¥ Bady Text Indent 2
1 Body Text Indent 3
1 Caption
4 Closing
a Comment Referance
i Comment Texk
» & Default Paragraph Fonk

HMlstyes
Styles In use _

® Click in the paragraph you want to add a style to.
o Select Format] Style... from the menu bar.

e From the List drop-down menu, choose All styles to view all the styles avaﬁable
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2.6.3

The styles are displayed in the Styles list, Preview each style by clicking once on the name. Paragraph.
styles are preceded by the paragraph symbol () and character styles are preceded by an"a" icon
(). A pointer arrow is located nextto the current style. Highlight the style you want to apply to the
paragraph and click Apply. ‘ '

Create a New Style from a Model

To create a style from text that is already formatted in a document, follow these steps:
Place the cursor in the paragraph you would ke to set as a new style,
Click the Style box on the formatting toolbar so the style name is highlighted,

Thils Is a heading,

Delete the text in the field and type the name of the new style.
Press the ENTER key to save the new style.
Create a Simple Style from the Style Dialog Box

Select Format|Style... from the menu bar and click the New button on the Style dialog box to
access the New Style dialog box '

'
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Type the name for the new style in the Name field.

Select "Paragraph” o "Character" from the Style type drop-down menu.

 Click the Format button at the bottom of the window and choose the paragraph element that will
be formatted for the style. Continue to make changes from the Options\f@m the Format button

menu, making changes to the dialog boxes for each element you choose.
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e Click OK to set the style and close the New Style dialog box.

e Click Apply on the Style dialog box to apply the new style to the current paragraph.
2.6.5 Mbdify or Rename a Style |

An existing style can be changed from the Style dialog box. _ _ . i

e Select Format/Style... from the menu bar.

e Highlight the style from the Styles list that you want to modify and click the Modify button.

E‘nn;n;h“ Epwa vmui ko Envm veabront Eoo owibae Eaa woihos Ena

waibae Eowa vz bas Semveabod Eog vosboe S wsuboe Eae eibos Eae
wulwr. Elwu mll En

® Use the same methods to modxfy the style from the Mochfy Style dialog box that were used for the
New Style box.

B

e Toonly rename the style, type a new name in the Name field.

Click OK when youare finished making modifications.
e Click Apply to update the style in the document.
2.6.6 Delete a Style

Preset styles created by Word cannot be deleted, but to delete a style you have made, follow these
steps: - - _

® Select Format|Style... from the menu bar

o Highlightthestyle from the Styles list that you want to delete,
® Click the Delete button.

e You will be asked if youreally want to delete the style Cl1ck Yes.
& Click Close on the dialog box.”
2.7 Lists

To create a bulleted or numbered list, use the list features provided by Word.
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2.7.2 ‘Bulleted and Nuihbered Lists

o Click the Bulleted List button or Numbered List button on the formatting toolbar.

¢ Typethe firstentry and press ENTER. This will create a new bullet or number on the next line. If
you want to start a new line without adding another bullet or number, hold down the SHIFT key
while pressing ENTER, _ ' '

® Continue to typing entries and press ENTER twice when you are finished typing to end the list.

Use the Increase Indent and Decrease Indent buttons on the formatting toolbar to create lists of
multiple levels.

NOTE: You canalso type the text first, highlight the section, and press the Bulleted List or Numbered
List buttons to add the bullets or numbers, P
2.7.3 Nested Lists

To create a nested list, such as a numbered list inside of a bulleted list, follow these steps:

o Type the listand increase the indentation of the items that will make up the nested list by clicking the
Increase Indent button for each item.x

+ Lists : e Lisis
o Bulleted and NMumbered Lists IO Uil sted and Numbered Lists
o Mested Lists
o Formatting Lists .
¢ Tahles » Tables
o Create a Tahle o Createa Table

® Highlight the items and click the Numbered List button on the fopnatting toolbar.
2.74 Formatting Lists _
_The bullet image and numbering format can be changed by using the Bullets and Numbering dialog
box.

® Highlight the entire list to change all the bullets or numbers, or Place the cursor on one line wi’rhih
. the list to change a single bullet,

® Access the dialog box by selecting Format/Bullets and Numbering from the menu bar or by right-
clicking within the list and selecting Bullets and Numbering from the shortcut menu. - -

¢ Select the list style from one ofthe seven choices given, or click the Picture... button to choose a
different icon. Click the Numbered tab to choose 2 numbered list style. o

e (lick OK when finished.
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2.8 Tables

Tables are used tb_ display data and there are several ways to build them in Word. Begin by placing
the cursor where you want the table to appear in the document and choose one of the following methods.

2.8.1 ImsertaTable

There are two ways to add a table to the document using the Insert feature:

@ Click the Insert Table button on the standard toolbar. Drag the mouse along the grid, highlighting
the number of rows and columns for the table.

e Or, select Table[Insert|Table from the menu bar. Select the number of rows and columns forthe
table and click OK.

{inseit Tah

2.8.2 Draw the Tabie

A table can also be drawn onto the document:

‘@ Drawthetableby selecting Table|Draw Table from the menu bar. The cursor is nowthe image of
a pencil and the Tables and Borders toolbar has appeared. - '

e Draw the cells of the table with the mouse. If you make a mistake, click the Eraser button:
drag the mouse over the area to be deleted.

e Todraw more cells, _click on the Draw Table button
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2.8.3  Inserting Rows and Columns

Once the table is drawn, insert additional rows by placing the cursor in the row you want to be
adjacent to. Select Table{Insert[Rows Above or Rows Below. Or, select an entire row and right-click with

the mouse. Choose Insert Rows from the shortcut menu.

Much like inserting a row, add a new column by placing the cursor in a cell adjacent to where the
new column will be added. Select TablelInserdColumns to the Left or Columns to the Right. Or, select the

column, right-click with the mouse, and select Insert Columns.

2.8.4 Moving and Resizing a Table

A four-sided moving arrow and open box resizing handle will appear on the corners of the table if
the mouse is placed over the table. Click and drag the four-ended arrow to move the table and release the
mouse button when the table is positioned where you want it. Click and drag the open box handle to resize
~ thetable. Change the column widths and row heights by clickinig the cell dividers and dragging them with

the mouse,

move handle

[

2.8.5 Tables and Borders Toolbar

The Tables and Borders toolbar allows you to add border styles, shading, text effects, ahgnment,
and more options to your table. Access the tOOlbdl‘ by clicking Table[Draw Table or '\e’iewlToolbmslTa‘bles

and Borders.

resize heindle

You will need to highlight the cells of the table you want to format. Click and drag the mouse over

the cells, oruse the follomng shortcuts

Table|Select|Cell

: Cllck the bottom left corner of the cell
iwhen a black arrow appears

One row Table|Select| Row

lCth outside the table to the left of the
row

|One column [TableSelectiColumn

Click outside the table above the
column when a black arrow appears

Several rows [(none)

Click outside the table to the left of the|
row and drag the mouse down

Several
fcolumins

{none)

Click outside the table above the
column

[Entire table |Table|Select]Table

Triple-dlick to the left of the table

2.8.6 Table Propertics

Use the Table Properties dialog box to modify the alignment of the table with the body textand the

text within the table. Access the box by selecting Tables|Table Properties.

[53]
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Size - Check the Pfeferred width box and enter a value if the table should be an exact width. |

Alignment - Hightight the illustration that represents the alignment of the table in relation to the text
of the document.

Text wrapping - Highlight "None" if the table should appear on a separate line from the text or
choose "Around" if the text should wrap around the table.

Borders and Shading - Select from a number of botder styles, colors, and.widths_. Click the
Shading tab to change the background color and pattern

Options'— Click the Options button on the Table Properties window. To change the spacing between
the document text and the table borders under Default cell margins. Check the Allow spacing
between cells box and enter a value to add space between the table cells.
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2.9 Graphics
291 Adding Clip Art
To add a clip art image from the Microsoft library to a document, follow these steps:
® Select Insert/Picture|Clip Art from the menu bar.

® To find an image, click in the white box following Search for clips, Delete the words "Type one or
inore words. . ." and enter keywords describing the image you want to use. '

¢ Click once on the image you want to add to the document and the\following popup menu will
" appear: ' :

1 inmer cip
Présia capr
B0 Lo o faviniios

fiskd simitar Sips

® Insert Clip to add the image to the document.

® Preview Clip to view the image full-size before adding it to thei:‘l'bcumen_t_'. Drag the botfom, right
corner of the preview window to resize the image and click the "x" close button to end the preview.

iy @
at can be chosen

e Add Cliﬁ to Favorites will add the éelected image to your fa?dt_i_'tééi dlrectoryth
from the Insert ClipArt dialog box, _ ; ﬂ\; Liwmiald s

® Find Similar Clips will retrieve images similar to the one yowhave choséh. -« st %

[PPSO S ST sid

| [,55] i .



" Continue selecting images to add to the document and click the Close button in the top, right
corner of the Insert ClipArt window to stop adding clip art to the document.

2.9.2 AddAnImagefrom aFile
Follow these steps to add a photo or graphic from an existing file:
Select Insert|Picture[From File on the menu bar.

® (lick the down arrow button on the right of the Look in: window to find the image on your
computer.

e Highlight the file name from the list and click the Insert button.

word

preey glf
pogesstup.oif
pagesetup2.gif
patanrank b o

i paste.gif
pnm. g
panunbox., gif
save.qif

Wl spekchoduol

f spelingbox.gf

Eﬁ’ switchheaderfootar gF

1if tabletocbar.of

§ texthordar gf

j’textcdnr.g[f

A7 toolbaraptions. oif

' wrdo.gif

2.9.3 Editing A Graphic

Activate the image you wish to edit by clicking on it once with the mouse. Nine handles will appear
around the graphic. Click and drag these handles to resize the image. The handles on the corners will resize

proportionally while the handles on the straight lines will stretch the image. More picture effects can be

changed using the Picture toolbar. The Picture toolbar should appear when you click on the image. Otherwise,
select View|Toolbars|Picture from the menu. bar to activate it.

hﬁbnwl.ass Line Format
Image Contre!  Brighiness  Sle  Pichum

Insest More/Less Cmp  Text Rezel
Plicture Conlras! Wragping Pietisre:

e Insert Picture will display the image selection window and allows you to change the image.

e [Image Control allows to to make the image grayscale, black and white, or a watermark.

. More/iess Contrast modifies the contrast between the colors of the image.

¢ More/Less Brightness will darken or brighten the image.

e Click Crop and drag the handles on the activated image to delete outer portions of the image.
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2.9.4

Line Style will add a variety of borders to the graphic. _
Text Wrapping will modify the way the document text wraps around the graphic.
Format Picture displays all the image properticsina separate window. .
Reset Picture will delete all the modifications made o the image.

Auto Shapes |

The AutoShapes toolbar will allow you to draw many different geometrical shapes, arrows, flow

chart symbols, stars, and banners on the document. Activate the AutoShapes toolbar by selecting
Insert{Picture| AutoShapes or View|Toolbars|AutoShapes from the menu bar, or clicking the AutoShapes
button on the Drawing toolbar. Click each button on the toolbar to view the options for drawing the shape.

B_Icék | Stars and
Lines Arows Bannors  More

Basic F’Idw #
Shapes Chart Cuts

Lines - After clicking the Lines button on the AutoShapes toolbar, draw a straight line, arrow, or
double-ended arrow from the first row of options by clicking the respective button. Click in the
document where you would like the line to begin and click again where it should end. To draw a

~curved line or freeform shape, select curved lines from the menu (first and second buttons of

second row), click in the document where the line should appear, and click the mouse every time

a curve should begin. End creating the graphic by clicking on the starting end or pressing the ESC

key. To scribble, click the last button in the second row, click the mouse in the document and hold
down the left button while you draw the design. Let go of the mouse button to stop drawing.

Basic Shapes - Click the Basic Shapes button on the AutoShapes toolbar to select from many
two- and three-dimensional shapes, icons, braces, and brackets. Use the drag-and-drop method
to draw the shape in the document. When the shape has been made, it can be resized using the
open box handles and other adjustrents specific to each shape can be modified using the yellow

diamond handles.
u] o
Q

Block Arrows - Select Block Arrows to choose from many types of two- and three-dimensional
arrows. Drag-and-drop the arrow in the document and use the open box and yellow diamond
handles to adjust the arrowheads. Each AutoShape can also be rotated by first clicking the Free
Rotate button on the drawing toolbar {#: Click and drag the green handles around the image to
rotate it. The tree image below was created from an arrow rotated 90 degrees.




e Flow Chart- Choose from the flow chart menu to add flow chart elements to the document and
use the line menu to draw.connections between the elements.

® Stars and Banners - Click the button to select stars, bursts,; banners, and scrolls,

e Call Quts - Select from the speech and thought bubbles, and line call outs. Enter the call out text
in the text box that is made.

e More AutoShapes - Click this button to choose from a list of clip art categbries.

Each of the submenus on the AutoShépes toolbar can become a separate toolbar. Justclick and

drag the gray bar across the top of the submenus off of the toolbar and it will become a separate floating
toolbat. ' ' '

2.10 Spelling and Grammar
2.16.1 AutoCorrect

Word automatiéally cortects many commonly misspelled words and punctuation marks with the
AutoCorrect feature. To view the list of words that are autornatically corrected, select Tools|AutoCorrect.

This may be a hidden feature so click the double arrows at the bottom of the Tools menu listing if the
AutoCorrect choice is not listed.

Many options including the accidental capitalization of the first two letters of a word and
capitalization of the first word of the sentencé can be automatically corrected from this page. If there are
words you often misspell, enter the wrong and correct spellmgs in the Replace and With fields.
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2.10.2 Speling and Grammar Check

Word will automatically check for spelling and grammar errors as you type uniess you turn this
feature off. Spelling errors are noted in the document with a red underline. Grammar errors are indicated
by a green underline. To disable this feature, select Tools|Options from the menu bar and click the Spelling
and Grammar tab on the dialog box. Uncheck "Check spelling as you type" and "Check grammar as you
type", and click OK. 3 . _

[f the word is spelled correctly and will appear in many documents youtype (such as your name),
click the Add button to add the word to the dictionary so it will no longer appear as a misspelled
word.

Aslong as the Check Grammar box is checked in the Spelling and Grammar dialog box, Word will
check the grammar of the document in addition to the spelling. If you do not want the grammar checked,
remove the checkmark from this box. Otherwise, follow these steps for correcting grammar: '

¢ IfWord finds a grammar mistake, it will be shown in the box asthe spelling errors. The mistake is _
highlighted in green text. - ' -

Spelling and Gramm:

&1

I The dog ran over the h:llL

¢ Several suggestions may be given in the Suggestions box. Select the correction that best applies
and click Change. '

® Ifno correction is needed (Word is often wrong more than it is right), click the Ignore button.
2.10.3 Synonyms

‘Word 2000 has a new feature for finding synonyms. Simply right-click on the word and select
Synonymis from the shortcut menu. From the list of suggested words, highlight the word you would like to
use or click Thesaurus... for more options.
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2.104 Thesaurus

To use the thesaurus, select Toolleanguage|Theséufus from the menu bar or select it from the
Synonyms shorfcut menu as detailed above.

noLnk

- Alist of meanings and synonyms are given on the windows. Double-click on the words in the
Meanings box or click the Look Up button to view similar words. Double-click words in the Replace with

Synonym box to view synonyms of those words. Highlight the word you would like to add and click the
Replace button.

2.11 Page Formatting
2.11.1 Page Margins

The page margins of the document canbe changed using the rulers onthe page and the Page Setup
window. The ruler method is discussed first:

* Move the mouse over the area where the white ruler changes to gray.

Dnrumunﬂ Micrasoft Ward
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® When the cursor becomes a double-ended arrow, click with the mouse and drag the margin-, .’
indicator to the desired location. e

® Release the mouse when the margin is set.
The margins can also be changed using the Page Setu p dialog box:
® SelectFile[Page Setup and choose the Margins tab in the dialog box,

Enter margin values in the Top, Bottom, Left, and Ri ght boxes. The Preview window will reflect
the changes.

¢ Ifthe document has Headers and/or Footers, the distance this text aﬁpears from the edge of the
page can be changed.

® Click OK when finished.
2.11.2 Page Size and Orientation
Change the orientation page within the Page Setup dialog box.
o SelectF iIé[Page Setup and choose the Paper Size tab.
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e Select the proper papet size from the drop-down menu.

o Change the orientation from Portrait or Landscape by checking the corresponding radio button.
2.11.3 Headers and Footers ' -

A header is text that is added to the top margin of every page such as a document title or page
number and a footer is text added to the bottom margin. Follow these steps to add or edit headers and !
footers in the document: ' . :

Select View|Header and Footer from the menu bar. The Header and Footer toolbar will appear l
and the top of the page will be highlighted as shown below. :
HBBGEE - - o e e —eemmmmme e -

! . {riert dale) _ :
: wsert time : '
] . +

tarmal page number ‘ gesiteh betwash

enemirmre YiSB1 DEINE VDA

e Type the heading in the Header box. You may use many of the standard text formatting options [
such as font face, size, bold, italics, etc. : O
e Click the Insert AutoText button to view a list of quick options available. _
e Use the other options on the toolbar to add page numbers, the current date and time.
e Toedit the footer, click the Switch Between Header and Footer button on the toolbar.
e When you are finished adding headers and footers, click the Close button on the toolbar,
2.11.4 Page Numbers | |
" Followthese instructions for another way to add page numbers toa document.

‘& Select Insert|Page Numbers from the menu bar and the following dialdg box will appear.
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® Select the position of the page numbers by choosing "Top of page" or "Bottom of page" from the

Position drop-down menu.

o Select the alignment of the page numbers in the Alignment drop-down menu.

® Ifyoudo not want the page number to show on the first page (if it is a title page, for example),

uncheck the Show number of first page box.

Wy

® Click OK when finished.

2.11.5 Print Preview and Printing

Preview your document by clicking the Print Preview button on the standard toolbar or by select- -

ing File[Print Preview. When the document is ready to print, click the Print button from the Print Preview
screen or select File|Print.

212 Summary

Word Processing, in computer terminology, refers to typing, editing and formatting of any kind of
document, which could be a letter, memorandum, balance sheet, or something smular Asthe term
suggests, word processing simply processes words, i.e. textual information,

word processor. Some of the features available in most word processors are:
- Facility to create footnotes and endnotes.

- Facility to create multiple-column text.

- Index and table of contents generation.

- Spelling and grammar checking.
- Thesaurus, etc. |
To start the Ms-word
Start -> Programme -> MS-_Office -> MS-Word

Format Painteris a handy feature for formatting text is the Format Painter located on the standard

~ toolbar. For example, if you have formatting a paragraph heading with a certain font face, size, and

style and you want to format another heading the same way, you do not need to manually add each
attribute to the new headline.

The AutoShapes toolbar will allow you to draw many different geometrical shapes, arrows, flow chart
symbols, stars, and banners on the document.

Word automatically corrects many commonly mlsspelled words and punctuation marks with the
AutoCorrect feature.
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2.13 Unit End Questions
1. . What do you mean by word processing ? o
What is the shortcut key for making text BOLD,ITALIC,and UNDERLINE.?

2.
3. Write shortcut key for cut,Copy,pas{é?
4, What s the use of format painter?
5. What s the ext. Name of word file 7
6.  Write the steps for renaming the file. ?
7. What is the difference between copy and move. 7 |
8. What doyoumean by font dialog box,?
9. whatare the steps for changing a paragraph in to columns. ?
10. What id UNDO and REDO. ? |
11. What are the work of following shdrt keys.
1. Ctrl+ N
2. Ctel+0O
3. Ctrl + 8
4. Cirl +C
5. Ctrl+P
6. Ctrl+X
7. Ctrl +V
8. Ctrl+B
9. Ctl+I
10. Cttl+ ENTER
11, Ctrl + 1,
12. - Cul+E
13 Ctrl+R
14. Cui+Z -
15. Ctrl+Y
16. - Ctri + END
17. Cutrl + HOME
18. Ctd+F
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| Unit 3: Advanced Wordprocessing
Structure of the Unit
3.0 Objectives
3.1  Introduction

32  Mail Merge
3.3  Macros
34 Tables

3.5  FileManagement

3.6  Printing the document

3.7  Styles & Templates

3.8  Linking & Embedding objects

3.9  Templates
3.10  Working with Graphics
311 Summary

3.12  UnitEnd Questions
3.0  Objectives

This unit teaches the advanced features provided Microsoft Word. In this unit, you will learn about advanced
featu_res of word processing like mail merge, macros, tables etc, : . _ '

3.1 Introduction

A word processor is software that alters text. It enables you to create, edit, format, print and save
documents for future retrieval and reference. It also allows youto check & correct your common typing
errors as well as grammatical errors. Most word processors, however, provide additional features that
enable youto manipulate and format documents in more sophisticated ways, They are often known as  full-

Jeaturedword processors. Full-featured word processors usually support the following features: '
' ® Mail-merge: Multiple copies of letters, labels can be generated with different addresses through
the mail-merge facility. _
« File management: Many word processors contain file management capabilities that allow youto
create, delete, move, and search for files. ' -
¢ Macros: Amacro is a command/word that represents a series of keystrokes. The keystrokes can
represent text or commands. The ability to define macros allows you to save yourselfa lot of time
~ byreplacing common combinations of keystrokes, '
* Graphics: Allows you to embed illustrations and graphs into a document. Some word processors
* letyou create the llustrations within the word processor; others let you insert an illustration produced
: by adifferent program.
32  Mail Merge _

There are situations when a similar type of letter or document has to be sent to a number of persons
who reside at different locations. The letters may contain the standard information and some variable
information like address of each recipient. One way of doing this s to print the letters by changing the
address each time in the document after printing such letter, which is quite time consuming. This can be
taken care of using Mail Merge facility. _

Mail merge is a tool which allows you to create form letters, mailing labels, and envelopes by
linking a main document to a set of data or data source. The main document is linked to the data source by
common fields of data, called merge fields. You can create your own merge fields, specific to your data
source, or you can use a predefined set provided by Word. Mail merge can be used to create any type of
printed document, as well as electronically distributed documents and faxes. Microsoft Word firther facilitates
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you to use data from other Office components such as Excel and Qutlook, as well as providing a wizard
that will walk you through the creation process.

For example, if you wish to send invitation card to your friends. your main document would be the letter
informing the venue and date of the party. The data source is where the fields of information about each
friend receiving the letter are saved. The data source would contain names, addresses, phone number, etc.

Mail Merge is the facility which requires the following information: |

o  General body of the letter called main document

e Data forall the individuals, for whom the letters are to be generated also called data source
For creating a Mail Merge document, you need to

e Create the main document

e Create data source

e Merge the data with document
The steps are as follows:

1. Openanew blank document.

2. Goto the Tools Menu and select “Mail Merge”. Mail Merge helper guides you through the steps
of mail merging a document. There are three main options available in the box. The tollowing Mail
Merge Helper box will appear:

Mail Merge Helper

3. The first step in the mail merge is to create the main document, Under the heading, “Main Document”,
click on the “Create” button. In this dropdown list, you will see four choices: Form Letters,
Mailing Labels, Envelopes, and Catalogs.

4. Choose “Form Letters” option from this list. Then a dialog box will appear asking you if you want
to use the active window or a new main document. Choose the Active Window button from the
above box. Type the main document and again invoke the Mail Merge Helper.

5. Choose the “Get Data” button from the Mail Merge Helper box. For creating data source, select
Create Data Source. The following dialog box will appear.
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10.

i1

Structure of Data File

This box will show you a list of fields that will be used by defanlt. You can add or remove ﬁelds.l |

For removing a field, highlight that particular field and click on the “Remove field Name” button.
For adding a new field, type the name of the field in the Field Name box and then click on the “Add
Field Name” bution. '

.. Click on the OK button and save your data source with a meaningful name,

Click on the “Edit Data Source” button from the box to enter Tecords in the data file. A Data Form
dialog box will be displayed. Fill in the information for the first person you want to add to your
database. New persons can be added using the “Add New” button. When you are done, click on
OK button.

Note: You can also use an existing data source; by clicking the “Get Data” option in the Mail
Merge Helper and then selecting “Open Data Source”. A dialog box will appear with alist of data
source file names. Select the name of the data source to be opened. :

Now, you are returned to your blank document and you will notice a new toolbar at the top of your

screen, which includes a button that says “Insert Merge Field”. Thisis your Mail Merge toolbar,

which provides you with various options related to Mail merge.

Put your cursor at the beginning of your blank document and click on the “Insert Merge Field”
button. A dropdown list containing the header fields gets displayed. Eg. To insert the title field into
your document, click on Title in the dropdown list. (It looks like <<Title>>) and your mouse
pointer is blinking just to the right of this field. Press spacebar once to puta space between this

field and your next field. Now, go back to the “Insert Merge Field” button and select the FirsiName -
field, hit your space bar again, then go back and insert the LastName field. You should now have

a line in your document which looks like this: <<Title>> <<FirstName>> <<LastName>>.

After creating the main document and data source, the third step is to merge the main document
with the data source. For this, invoke the Mail Merge Helper again and choose the ‘Merge’
button.
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12. Select ‘New Document’ from the ‘Merge To’ drop-down list and click on ‘Merge’ button. The
form letters are generated and stored in the document which may be previewed for final adjustment
in the main document, before printing the letters.

Merge Printing

You can directly print the Form Letters without previewing them. Select the Printer option, and
then the form letters are directly printed on the printer.

Conditional Merging

You can also mail merge the document based on some condition. This is known as Conditional
Merging. Using Query Option’ you can define the selection criteria so that at the time of merging, only
those records are selected which meet the defined selection criteria,

The main document, after inserting merge fields will look like:

Yaou are mwited to attend the ceremeony to be held on 12t Augusr 2010 at Hotal Tradent,
Udnippy. '

3.3 | Macros

If you perform a task repeatedly in Word, you can automate the task by using a macro. The task
may be performed in a sequence of steps. A macro is a series of steps that is grouped together as a single
step and then executed when necessary. :

Macros are advanced features that can speed up editing or formatting you may perform often in a
Word document. They can also combine multiple commands together. They record sequences of menu
selections that you choose so that a series of actions can be completed in one step. E.g, To have a particular
page setup, to copy seltﬂcted text to a new document, etc. :

A macrocan be created by performing the following steps:
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e Naming the macro
e Assigning the macro to a toolbar, menu or a shortcut key:
¢ Describing the action performed by the macro
e Recording the macro operations
Naming the macro
The macro name cannot include spaces, commas or begin with a number.
Assigning the macro

If you use a particular macro often, assign it to a toolbar button, a menu, or shortcut keys, That
way, you can run the macro directly without having to open the Macros dialog box.

Describing the macro

The macro description is the text that describes what a macro does. This is for your reference only
so you remember what the macro does.

Recording the macro

The easiest way to quickly create a snmple macro in Word 1s to use the macro recorder. To define
the macro operations, perform those very operations once and let Word “remember” the sequence, This

process is called recording the macro. Internally, word writes down each action being perfonned usinga -

programming language called VBA ( Visual Basic for Applications).

The Macro Recorder creates a copy of the commands you select with your mouse. When the
Macro Recorder is active, the tip of the mouse pointer will contain a cassette. Before you record or write
amacro, plan the steps and commands carefully you want the macro to perform, because all the steps get
recorded.

To record a macro, follow these steps:
1. Gotothe Tools Menu and select “Macro”,

2. Select “Record New Macro” from the Macro submenu. The Record Macro dialog box is displayed
as shown in the figure( at end of the steps).

3. Name the macro in the “Macroname” field.

4. Under “Store macro in” drop down box, select the document you would like the macro to be
associated with. Select “All Documents” if you want to use this macro globally.

5. Enteradescriptionof what the macro will do in the “Description” field. Include the date the macro
was created and the creator.

6. Assign the macro to a Toolbar or Keyboard, by clicking on the respective buttons. Short cut
commands for amacro must begin with Ctrl or Alt or Ctrl + Alt followed by a letter or number.

- 7. Click OK to begin recording.
Record Macro Dialog box
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8. Perform the actions you want to include in your macro. You can use the mouse to click commands
and options, but the macro recorder cannot record mouse actrons in a document window, To
move the insertion point or select, COpY, or move text you must use keyboard commands,

9. The recording toolbar will allow you to Stop, pause, and resume recording.

10. To stop recording your macro, click Stop Recording, j

Running a Macro
To run an existing macro, follow these steps. _
1. Select “Macros” from the “Tools™ menu, Macros dialog box gets operted.
Under Macro Name, click the macro you want to run.

2.
3. Click the Run bution ' ’
4.

Ifa shortcut key has been assigned, press that shortcut key at any time to run the macro,
Similarly, press the toolbar button created for macro, ' '

Macros Dialog box

.3'4 Tables

Tables are used to organize information into rows and columns. They are also usefit! when you
want to arrange and align fields in a Word form. The cells ofatable can hold text, graphics, fields, and other
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types of objects —even other tables. Table menu provides commands for creating and formatting tables,
rows, columns, and cells, as well as sorting and calculation tools.

Creating a Table

There are two ways in which you can create a table:
o Insert Table
¢ Draw Table
Inserting a Table
There are two ways to add a table to the d()ct1ment'Lising the Insert feature:

1. Click the “Insert Table” button.on thé standard toolbar. Drag the mouse along the grid, highlighting
the mumber of rows and columns for the table.

=

9 Select “Table” from the “Insert” submenu of the “Table” menu. Select the nﬁmber of rows and
columns for the table and click OK.
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Drawing a Table
A table can also be drawn onto the document:

1. Select “Draw Table” from the “Tabie” menu. This displays the “Tables and Borders” toolbar. The
pointer now turns to a pencil, -

Navigating in a Table

You can move around in the table by using mouse, as well as the keyboard.

Tomoveto Key press

Next cell Tab

Preceding cell Shift + Tab

Previous or next row | Up arrow or Down arrow
First cell in the row Alt+Home

Last cell in the row : ' Alt+End

Firstcell inthe column Alt+PgUp

Last cell in the column Alt+PgDn

Inserting & Deleting Rows and Columns
To add rows and columns:
1. Place the cursor in the row or column adjacent to where the new row or column has to be added.

2. Select “Insert” submenu from the “Table” menu. Then select “Rows Above” or “Rows Below” for
row; “Columns to the Left” or “Columns to the Right” for the column,
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3. Alternatively, select an entire row of column and right-click with the mouse. Choose “Insert Rows”
or “Insert Columns” from the shortcut menu. -

To delete rows and columns:

1. Select the row or column to be deleted.

2. Select “Delete” submenu from the “Table” menu. Then select “Rows™ or “Columns” accordingly.
Formattmg a Table

Formatting the table involves merging and splitting cells, changing the width of columns or cells
changing the row height, changing the vertical and horizontal alignment of text, adding shading to atable,
removing table borders, hiding or unhiding the table gridlines, adding or changing the line style, color, and
thickness of borders. '

_ You will need to highlight the cells of the table you want to format Click and drag the mouse
over the cells, or use the following shortcuts:

Selection ' Method

One cell Click the bottom, left corner of the cell when a black arrow appears
One row _ Click outside the table to the left of the row ._
One column Click outside the table above the column when a Bléck afrow appears
Several rows Click outside the table to the left of the row and drag the mouse down
Severalcolumns  Click outside the table above the column

Entire table Triple-click to the left of the table

' The Tables and Borders toolbar allows you to format your table. Access the toolbar by clicking
Table *1 Draw Table or View ’! Toolbars °! Tables and Borders. The text in the table can be formatted in
the same way you would format non-tabular text.

You can also use the Table Properties dialog box to modify the alignment, height, width, Shading
effects, etc. Select Tables '! Table Properties.
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»  Size - Check the Preferred width box and enter a value if the table should be an exact width. -

»  Alignment - Highlight the illustration that represents the alignment of the table in relation to the text
ofthe document.

» Textwrapping - Highlight “None” if the table should appear on a separate line from the text or
choose “Around” if the text should wrap around the table. '

*  Borders and Shading - Select from a number of border styles, colors, and widths. Click the
Shading tab to change the b_ackground color and pattern. - '

- Youcan also use the “Table AutoFormat™ command from the “Table” menu to choose from a
series of pre~defined table formats. '

Moving and Resizing a Table

A four-sided moving arrow and open box resizing handle will appear on the corners of the table if
the mouse is placed over the table. Click and drag the four-ended arrow to move the table and releasé the
mouse button when the table is positioned where you want it, Click and drag the open box handle to resize
the table. Change the column widths and row heights by clicking the cell dividers and dragging them with
the mouse.

3.5 File Management

Word provides with various file managément capabilities which include openihg documents, selecting
more than one file simultaneously, Cycle between multiple open documents, search for a file, delete or
rename a file.

Opening Documents
A document can be opened using one of the various meﬂlods:
» File’! Open
s Opentoolbar button (usually 2nd from the left on the Standard toolbar)
» Pressing Ctrl+0O '
« Ctrl+F12 | |
This will display the “Open” dialog box, Now,' you can select the file to be opened.
Opening a file as Read-only ' |

A document can be opened as read-only using the Open dialog box. Select the file(s) in Open
dialog box. Right Click on the mouse, select “Open Read Only” command from the drop down menu.

Selecting more than one file
Multiple files can be selected & opened simultaneously using the Open dialog box.

~» Toselectnon-adjacent files, click one file, and then hold down “Ctrl” key and click each additional
file, ;

* Toselectadjacent files, click the first file in the sequence, and then press “Shift” key and click the
last file. _

» Tounselectahighlighted file you don’t want, hold down “Ctrl” key and click the file again,
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Switching between multiple open documents _.
You can cycle between the multiple open documents using one of the various methods:
1. Press Ctrl + F6. . | |
2. Click on the “Window” menu and click on the reqmred file from the list dlsplayed
3. Selectthe Word document icon displayed i in the task bar

Searching a File

Word lets you search for a file, if you are unable to locate it. Within the Open dialog box, click on
the Tools icon and then select the Find option. This will open the “Find” dialog box. Within the “Look in”
section of the dialog box, define the location where you wish to search. If you wish to search sub-folders,
tick the “Search subfolders™ check box. Inthe “Value” field, enter a value such as the name of the file you
are searching for (or may be text contained within a file). Click on the “Find Now” button to start the
search. The system will now search through the entire hard disk and locate any ﬁle w1th the speclﬁed file
name.

Deleting a file
1. Select the required file in the “Open” dialog box.
2. Press the Delete key, or rlght click on the file & select “Delete” from the pop-up menu.
Renamjng a file
1. Selectthe required ﬁIc in the “Open” dlalog box.

2. Rightclick on the file and select “Rename” from the pop up menu.
3.6 Printing | - -

After adocument has been prepared youmay want to prmt the document. The printed copy of the
document is also called hard copy. Before printing, you must install the printer.

Print Prevnew

Print Preview allows you to see how your file looks before you print. This prevents a waste of
paper and ink. :

To Access Print Preview, you should choose “Print Pre\new” from the “Flle“ menu. Alternatively,
you can click the “Print Preview” button on the standard toolbar, Once you have accessed Print Preview,
your document will now be in Print¢ Preview mode. The document will look like as given in the ﬁgure

[75]




ERLIE

vt e e
R,
RN

B P A

i A MRS L DL
. e\ e
Bl m R A

s st i i e
e l‘wtdl-lsllw L
[T
¥ et o Rarersany
e e
L e i

- i .

AR AL o A e i B

3.6 Printing the Document .
1. Choose “Print” from the “File” menu. The Print dialog box will appear,

2. Click the “Print” button on the “Standard” toolbar Thls starts pnntmg immediately, The prmt dialog
box will net appear.

Pinler -
Section

@ n
%mﬁoge

Print YWhat
Section

; Pt T
: MNuymber
Section . . af Copies
The Print Dialog Box

Selecting the Printer

When working in an office environment, it is possible your computer is part of a network that

accesses several printers. You can choose the printer to which your document wnll be sent for printing,
using “Name” drop down box.
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Selecting the Page Range

The default setting is all. If you want to print only the current page, select the current page radio
button. If you want to print only part of a document (but it is more than one page), select the Pages radio
button and enter in the page numbers you would like to print. If you want to print selected part of the
document, select the “Selection” radio button. ' :

Selecting the Number of Copies

. The default setting is 1.copy, Enter the iumtberof éopieé you would hke to print. You may use the
up or down arrows to indicate the desired number of copies. Collate is adcf_aul_t__s_c’éting. Collate means to
put pages in proper order. If you would like to turn off the collating feature, simply deselect the radio button
(this means that if you ptint more than one copy of a document, all the page 1s will be together, all the page
2s, ete.) : : S
Miscellaneous Options

_ You can choose to print only the odd or even pages. The default setting is “all pages in range.
You can also choose to print ¢ither directly to printer or to a file. '

3.7 Styles

A style is a set of pre-defined formatting instructions that you can use repeatedly throughout the
document. Styles define the format for a paragraph using specific margins, font sizes, or underlining. Styles
are used to identify parts of a document. E.g. heading, footnote, hyperlink, or body text. Using styles, you
apply a whole group of formatting characteristics in one simpletask.

The use of styles in Word will allow yoﬁ to quickly format a document with a consistent and
professional look. If you store the fotmatting commands in a style, you can apply that style any time you
need it without having to do all of the teformatting, -

There are two ways to choose a style:
‘e The“Style” dialog box. _
o The“Style” list box on the “Folrﬁi.s.n.t.ting” toolbar,
Choosing a Style using the Style List Box: _

1. Place the cursorin the paragraph where the style will be applied.
2. Click the “Style” drop-down menu on the Formatting toolbar and select a style by clicking on it.

3. To apply the same style to multiple paragraphs, double click the “Format Painter” button =

the standard toolbar and click in all the paragraphs that the style should be applied to. Press the
ESC key to disable the Format Painter. ' ' -
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Choosing a Style using the Style Dialog Box

1. Click inor select the paragraph text that you want format with a style.

il

Click the style you want to use.

Click Apply. .

¥ Body Text
1] Body Text.2
¥ Body Text 3
11 Body Text First Indent
1l Body Text Frst Indsrk 2
1 Body Text Indert:
9 Body Text Indsnt 2

| 91 Body Text Indent 3

1l Caption
81 Closing

! a Comment Reference

1l Comrrent Tet
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| T —

Creating a New Style from a Model

Style Dialog Box

ki LT RTLURT TPV

Times N'e\.v Roman

Choose “Style” 'o__l_.)_fibn from the “Format” menu. The Style dialog box appeats.

To create a style from text that is already formatted in a document, follow these steps:

1. Place the cursor in the paragraph you would like to set as a new style.

2. Click the Style box on the formatting toolbar so the style name is highlighted.
3. Delete the text in the field and type the name of the new style.
" 4. Pressthe ENTERkey to save the newstyle.

Delé.tiné a Style

 steps:

1. Select “Style” from the “Format” menu.
2. Higlilighf the style from the “Styles™ list that you want to delete.

3. Click the “Delete” button, :

4. You will be confirmed to delete the style. Click “Yes” & Click “Close” bution.

3.8

Linking & Embedding Objects

Preset syl creted by Word canios be delted, buttodeete syl youhave made, fllow these

There are times when you need to explain a concept with the help of a picture or a graph. These
elements enhance the visual appeal & quality of the document. Word provides a feature called Object
Linking & Embedding (OLE), which allows you to include objects of other applications in your document.
L.g. an Excel spreadsheet can be embedded within a Word document using OLE, Double-clicking the
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embedded spreadsheet will launch Excel and allow the user to modify the sheet. Objects can either be
inserted or linked into the document. ' ' .

Linking - -

When you link an object from one application to another, this means that an active fink is maintained
between the applications. Thus you can enter data into an Excel spreadsheet and then create a chart of that
 data within Excel. Save the Excel document and then link the Excel chart to your Word program. Every

time you change the original data within Excel the chart will update automatically within Word. Similarly, &

bitmap file can be linked to your document, -~ = - IS
Embedding | - |
" Whenyouembed an object, there is 1o fink to the original. Thus you_ca'n:.entct data in to an Excel
spreadsheet and then create a chart of that data within Excel & copy it to your Word program. The Excel
chast is now embedded. If you change the original data within Excel, then the chart will not update within
Word. Thus the copy of the chart embedded into Word is completely independentof the original data.
Embedding/Linking an Object '

1. To insert an object or a file into an open document, position the insertion point at the Jocation
where you want to place the object in the current document. I

2. Fromthe “Insert” menu, choose “Object”.

3. The Insert Obj’e_ct: dialog box is displayed, as shown intl .e_ ﬁgune ._The'r:_é‘ are two.ta-bs: '

. Creai‘e New: If a new object has to be inserted, select.the type of object like photoshop |

image, calendar control, which has to be inserted. Tick “Display as icon” if you don’t wish to
see the entire object. . '

o Create from File: Click on this tab if you wish to 1nsert an éﬁ(isfing file. Browse fo f:ind.the file. -

Ifyou want to link the file to your document, tick the “Link to file” checkbox.
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‘Inserting an Object
3.9  Templates

If you frequently create documents that contain a lot of spécialized formatting but don’t always
contain the same text, you can save yourself aconsiderable amount oftime if you create Word templates to
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use as the basis of future documents. By using Word's template feature, you can focus your concentration
on the content of the document and leave the formatting up to the template. They give documents a more
consistent look and feel. A Word template can contain formatting, styles, headers, footers, macros, toolbars,
and AutoText entries.

Word provides three types of templates. _
. _."_'Themes: Color SChemes, background images, bullets, fonts, horizontal lines, etc:

*  Style Templates: One ormore styles for creating common types of documents such as fix cover
pages, memos, business letters, and resumes. '

s Styles: Defines the format for a paragraph using specific margins, font sizes, or undetlining. Styles
have been discussed earlier. _ _ _ _

Choosing a Theme
1. _C}_lbose_ “Theme” from “Format” menn.
2. 'The Theme dialog box appears. In the Choose a Theme list, click the theme. you want to use.
3. Word gives you a preview of how that theme can changé the appearance of your document.
Style Templates ' o

- Using a style template, you simply select the text in the template and replace it with your own
text. Templates also automate common tasks, such as inserting the current date and time into your document.
The templates available in Word are accessed through the “New” dialog box. '

Choosing a Style Template:
1. Choose “Themie” from “Format” menu. _
2. The Theme dialog on appears, showing the theme in your current document,
3. Ciick the “Style Gallery” button.
4

Click on the style templates listed in the “Template” box, such as Professional Fax and Elegant
Memo. . _

5. ClickOK. - | |
‘Access Style Templates Using the New Dialog Box:

- Youcanalso access Style Templates using the “New” dialog box & then choosing from any of'the
tabs, ' ' :
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Creating Your Word Template

Once you have outlined your document and are ready to create your Word template, follow these

simplé steps:
1. Clickthe “File” menu and sefect “Save™.
2. Inthe “File Name” box, give your template a name that will be easily recognizable.
3. Inthe Save astype box, select “Document Templates”. The extension for templates is “.dot”.

4. ‘Word will automatically open the default save location fc_;r Templates. You can save the template in
another location also by navigating through the folders on your hard drive. Templates saved in
locations other than the default location will not appear in the Templates dialog box.”

5. Click Save. o ' '
3.10 Workingwith Graphics |
Graphics can be added to a document to enhance its appearance. It also makes the dOClilnent
more interesting visually. : ' :
Adding ClipArt

Clip Art is the term given to pre-made images that are ready for use in youf Microsoft Word

docurnents. There are many Clip Art categories, such as Special Occasions, People, Business, Decotative
Elements, Animals, Cartoons and many more. To add a clip art image from the Microsoft library toa
document, follow these steps: ' - = B

1. Click on“Insert” menu. Select “Clip Art” from “Picture” submenu, The “Insert ClipArt” dialog box

appears.

Castoons Gl

9. To find an image, click in the white box following “Search for clips”. Otherwise, Click one of the

category icons.
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3. Click once on the image you want to add to the document and the followmg popup menu will
appear; :

sl oitp
presfigw ¢lip
" add chy 1o favorites

find sirsilar clips

o Insert Clip'to add the image to the document.

e Preview Clip to view the i 1n1dge full-size before addmg it to the document, Drag the bottom,
right corner of the preview window to resize the image and click the “x” close button toend the -
preview,

v Add Cilip to Favomes will add the selected image to your favorites dlrectory that can be
- chosen from the Insert ClipArt dialog box. '

» Find Similar Clips will rétrieve 1mages similar to the one you have chosen.

4, Contmue selectmg images to add to the document and chck ;l{e Close button in the top, rlght
corner of the Insert ClipArt window to stop addmg clipartto the document

Adding an Image from a File
1. Select Insert’!Picture’!From File on the menu.

2. Click the down arrow button on the right of the “Look in” window to find the image on your
computer. y

3. Highlight the file name from the list and click the “nsert” button.
Editing a Graphic | |

Activate the image you wish to edit by clicking on it once with the mouse. Chck and drag these
handles to resize the image. The handles on the corners will resize proportionally while the handles on the
straight lines will stretch the image. More picture effects can be changed using the Picture toolbar, The
Picture toolbar should appear when you click on the image.

Moreiless  Une Foemat
Imisge Contra Brighteess  Biyle  Piclure

Ingeri Moraftass. Cop  Text ' _-et .

P’ielure {;cmlmsﬁ' ' : CWiapping . Fictwie
o Insert Picture w1ll display the image selection window and allows youto change thei 1mage :
» Image Control allows the image to be changed to grayscale black and thte, or a watermark.
s More/Less Contrast modlﬁes the contrast between the colors of the i image. |

s More/Less Brightness will darken or br1ghten the image.
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Click Crop and drag the handles on the activated image to delete outer portions of the image.
Line Szj)le will add a vcmety of border sto the graphlc _

Text Wrapping will modify the way the document text wraps around the graphic,

Format Picture displays all the image properties in a separate window.

Reset Picture will delete all the modifications made to the irnaQe_t '

Wrapping Text Around Graphics

Wrapping means that text flows around a graphic object rather than over it. When positioning a

graphic near text, you can specify how you would like the text to wrap around the graphic. This can be
done s follows: _

1,

AN T i

7.

Click the Graphic to select it. When the graphic is selected, the “Picture” Toolbar gets opened.
Click the “Text Wrapping” button on the Pictizre Toolbar. | |

Click one of the text wrapping options that appears |

Click “Picture” on the “Format” mer_m. Then click the “Layout” tab

Click “Advanced”, then click the “Text Wrapping”” tab

Click one of the text wrapping options that appears, Click OK,

Cfick OK '

Auto Shapes

You can also create your own graphics using the Drawing tools on the Drawing Toolbar, which

includes tools for drawing lines and shapes, as well as tools for applying color, shadows, and fills to the
images you create. The AutoShapes toolbar will allow you to draw many different geometrical shapes
arrows, flow chart symbols, stars, and banners on the document. :

1.

Rl

¥ PN o W

Click a shape on the memg toolbar _
Position the pointer over the shape so that it changes to: a 4~way arrow.
Drag the white handles until youreach the desired slze of your shape.

Click “AutoShapes” on the Drawmg toolbar Cllck oneof the listed styles and then click adesired
shape.

When you click the shape, the pointer changes o +. Drag this pomter to draw the Auto shape.
With the shape selected, click the “Fill color” list on the Drawmg toolbar Click acolor for fill color.
Click the “Line Color” for line color.

Click the “Line Style” button for line style.

When you want to add text to your documents as a graphic image, you can create a text box. A
text box 1s a container into which you can place text and graphics.

Insert .
Texd Box  word An Line Style - Arrow Style

Fift Coler  Line Color

B
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Inserting Word Art

Word Art is another powerful graphics tool that you can use to give your docurnents visual flair and
impact. Text in Word Art is formatted in unique shapes, orientations, and paiterns that you can easily
maodify and customize.

1. Click the “Inisert Word Art” button from the Drawing toolbar, or select “WordArt” from “Picture”
submenu of “Insert” menu. The WordArt Gallery dialog box appears '

Werd Arl 14 an nwwwurfnl g 1 aphig b ﬂw! T T A rog ive you dot:nmrms wmnl
Baur ancl imngace: Taztt 1m Weard Aetie Ptivasted i wmime ahapie, stkbatinns, and paterns
thi Fot can aanly moddy mn.lcuswmnu

o posiniey

2. Click astyle from The WordArt Gallery dialog box

3. ijpe your text in the Your Text here box, Then Click OK

4. Position the pointer over the text. Resize by dragging the white handles and position as de51red
3 Summary

+ Word prov1des alot of advanced features to facilitate the user to create well formatted documents.

« Mail Merge is a feature used for sending similar letters with minor differences to multiple persons at
the same time. Tt can also be used to print envelopes, mailing lists.

« A macro is a.seties of steps that is grouped together as a single step and then executed when
necessary It speeds up tasks which aré performed repetitively.

¢ Tablesarea grid of rows and columns. It is useful when data has to be represented in tabular form.

«  Table menu provides commands for creating and formatting tables, rows, columns, and cells, as
well as sorting and calculation tools.

e Word provides with various ﬁle'management capabilities which include opening documents, selecting
more than one file simultaneously, Cycle between multiple open documents, search for a file, delete or
renamea file.

o Wordallows printing of the document if ahard copy is required. Print Preview allows you to see
how your file looks before you print. This prevents a waste of paper and ink.

+ Astyleisaset of pre-defined formatting instructions that you can use repeatedly throughout the
document.
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10,
L
12,

13.
14.
15.
16.

Templates serve asa blue print for your documents. A Word template can contain formatting,
styles, boile_,rplate text, headers, footers, macros, toolbars, and Auto Text entries. They give
documents a more consistent look and feel. '

Word provides a feature called OLE (Object Linking & Embedding), to facilitate the user to
insert or link an object like images, charts, worksheets into your document.

- Word includes features like ClipArt, WordArt, Auto shapes to help the user add graphics &

predefined symbols to their documents.

Clip Art allows you to import pictures, sound, etc. in the document. It also helps you to add
more clips from Internet or other sources.

Unit End Questions

Explain Mail Merge. _

What is the difference between main document and data source?

Define amacro. How can you assign a shorteut key to your macro?

What is Print Preview?

How can you insert a table of 3 columns & two rows in your document?
Explain Templates. |

What are the different Ways of creating templates?

Why dowe use styles? N ] \

Send a New Year party invitation to your ten friends. Write the stejas followed by you to do
Definea macro to convert all the alphabets in the document to upper case.
Create a macro Address which inserts your address at insertion point,

Create a macro to copy the selected paragraph to the end of the document. Assign a shortcut
key to it. ' ' :

Find all files in c: drive and having extension .doc”.

Open three documents simultaneously, as read-only.

Create a table for storing the marks of your friends of any three subjects.

Write a letter to a Computer Institute as a Manager of a bank, for ha{zing computer training for

~ your employees. Save it as a template.

17.
18,
19,

Create anew style for a paragraph as font Aﬁﬁl, size 10 point, justified én_lignment, double line
Insert an excel chart in your document.

Link a bitmap image file to your document

20. Using WordArt, create a title for your document.
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Unit4: Introduction to Spreadsheets

Structure of the Unit

4.0  Objectives

4.1  Introduction

42  Excel _
4.3  File Managemeént in spreadsheet
4.4  Moving around in a worksheet
4.5  Entering Data '
4.6 Speliing Check

4.7  Selecting Cells

48  Autofill Feature

4.9 Quick Data Entry

4.10 Autosum

- 4.11  AutoFormat

4.12° Summary

4.13  Unit End Questions

4.0  Objectives : . _

In this unit, the student will learn about basics of spreadsheets, terminology, and its advantages.
You will also learn about File management in spreadsheets, Moving around & entering data, Spell check &
AutoCorrect, AutoFill feature, Quick data entry, Auto Sum & auto format etc. S

4.1 - Introduction o _ o : :
Word processors are indispensable when youawe working with textual data, but it falls short when

you have to operate upon numerical data, Spreadsheets are the ri ght choice for numerical data processing

and analysis. A » o L

A spreadsheet is a grid of rows and columns, similar to a paper ledger sheet, and is used to record
and compare numerical or financial data. Originally, spreadsheets only existed in paper format. Now people
associate this term with a software application that displays the numerical information in rows and columns,
Spreadsheets can be used in any area that works with numbers and are commonly found in the accounting,
budgeting, sales forecasting, financial analysis, and scientific fields. Spreadsheet provides powerful features
to arrange & group numeric data, automatic recalculations, maintain complex relationship between set of
data, depict data in graphical format. It also offers data analysis, modeling & forecasting, trend analysis
tools. There are many spreadsheet programs available in the market like Excel, VisiCale, Lotus1-2-3,
etc. of which Microsoft Excel is the most popular. It 1sa part of MS Office Suite. -
42 Exced. - - - o : e
Microsoft Excel is an electronic spreadsheet program used for storing, organizing and manipulating data. It
helps in creating complex spreadsheets. The type of data that Excel can use includes numbers, text and
formulas. Excel allows you to create spreadsheets much like paper ledgers that can perform antornatic

calculations. It features calculation, graphing tools, pivot tables and macros. - IR '
Terminology _ : - N

s Workbook: A workbook is an Excel file, which can hb]d many worksheets.
» Worksheer: Aworksheet is a grid of columns and rows, used for entering data.

¢  Rows & Columns: The columns are assigned letters called column Iabels; and rows are given
numbers called row numbers. These are displayed in gray buttons across the top and lefi side of
the worksheet respectively. In excel there are 256 columns and 65,536 rows.
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o Cell:Acellis an intersection of row & column. Data is entered inthe cells

o Cell Address: Eaeh celthasa umque cell address; which consists of column label followed by row
number. Eg. A1, B3. The address of the current or active cell can be seen in the Name box. The
address of the last cell is IV65536.

o Active cell: The currently selected eell is called active cell.
o Range: Arectangular block ot contiguous cells is called range.

o Formula Box/Bar: This area displays the contents of the active cell. Ifa formula is entered, the cell
~ contains the output & formula box displays the formula. -

o  Worksheet tabs: These contain the name of the individual sheets in the workbook. You can make
a worksheet active by clicking on these tabs. Tab scrolling buttons are used to scroll between tab
sheets: They are used only to view the tabs not for selectmg them '

cell fermca box  mesubar  sSshducoNer - formaling wcltor

winkstost Lol .
sl butiens wotkshaes tabs

' Sample Worksheet

o Toolbars: There are two main toolbms

- = Standard Toolbar - This toolbar is located just below the menu bar at: the top 6f the screen and
allows you to quickly access. basm Excel commands like new, 'Open, Print, Cut, copy, paste,
autosum, eic.

=  Formatting Toolbar- This toolbar is used to select fontface, font size, font style such as, bold
Ttalics, or underline. \ _

Advantages of Spreadsheets

The advantages of using spreadsheets are as follows:
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» No manual calculations are required. Thus, the chances of errors are reduced.

» Automatic recalculations are performed when you can change numbers inacell, If youchange
one number on a paper based spreadsheet, you have to do all the calculations that directly or
indirectly use that number all over again.

* You can edit easily if you make a mistake. Also, you can easily modify row/column width by
dragging at any time. '

* Youcanautomatically perform most simple to most complex mathematical caleulations on the
data you’ve entered, using functions. ' '

* Datacanbe presented in graphical form. Also different formatting can be applied to it easily.
-« Ttallows for easy organization of data in a format that is visually easy to follow.

e “WhatIf’ Analysis can be performed, which allow you to change one or more value, view the
computed results, before the final decision is made. '

» Basic data management facilities are available.
¢ Adavnced data analysis & modeling tools are available;
43  File Management in Spreadsheet

Aworksheet is aset of spreadsheets used to store numeric data. The worksheet data may be
printed, graphed, sorted, and used in a variety of calculations.

Creating a Workbook

Select “New” from “File” menu & select “Blank Workbook™, or Click the “New” button on
Standard toolbar, or press Ctrl +N. ' _

This will open a new Excel file named Book1. A workbook contains three worksheets, by
defauit. You can enter data in any one of them. Each new workbook that you create is automatically
named in a sequential manner as Book1, Book2, Book3 & so on. You can save these later with
meaningfil name, . o

Saving the Workbook

If you wish to use the workbook, for future use, you need to save it. To save afile, follow these
l. Select “Save As” from “File” menu. The Save As dialog box will appear.
2. Choose the drive & folder from “Save In” drop down box.

3. Giveameaningfol name to your file in “Filename” box. In “Save as type” box, select “Microsoft
Excel Wookbook.xs”. _ ' '

4. Click Save button

Now, ifyou make changes & you want to save it again, select File’! Save. Or you can click on
_save button on standard toolbar, or press Ctrl +S.

Quitting Excel _
To quit Excel, take the following steps:

1. Select “Exit” from the “File” menu.
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2. [fthe open workbook has not been saved after making changes to it, Excel asks you if you want to
save the workbook. '

3. Click“Yes” to save the workbook, otherwise click *“No”. Ciicking the “Cancel” command cancels
the “Exit” command and retuins you to the workbook. :

Opening an Existing Worlkbook |

If your worksheet is not open, Choose “Open” from “File” menu. The Open dlalog box appears.
Select the appropriate drive, folder, and filename. Then Click Open.

LA

_ . Open Dialog Box
Finding Workbooks -
You can use the Open dialog box to search a file based upon some criteria. To do so, right click on

the arrow near “Tools” option and select “Search”. This will open a search dialog box, where in you can
give your search criteria like search text, search location or file type.

Closing a Workbook -

You can close more than one workbook smultaneously You can use “Closc option from “File”
“menu for closing the current workbook. :

For closing all the open workbooks, press Shift & click upon File menu. Then, select “Close AlP _
option.

Adding & Renaming a Worksheet

The worksheets in a workbook are accessible by clicking the worksheet tabs just above the status
bar. By default, three worksheets are included in each workbook. To add a new worksheet, select
“Worksheet” from “Insert” menu.

To rename the worksheet, right-click on the tab with the mouse and select “Rename” from the
shortcut menu. Type a new meaningful name and press the Enter key.
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Déleting a Worksheet

‘The worksheets in a workbook can be deleted by clicking the worksheet tabs just above the
status bar. To delete the selected worksheet, right-click on the tab with the mouse and select “Delete”
from the pop up menu. You can also delete the selected sheet by selecting “Delete Sheet” from the “Edit”
44  Moving Around in 2 worksheet

. Youcanmove around in the worksheet using mouse or keyboard. You can also use the horizontal
or vertical scrollbar, or drag the scroll box to navigate in the worksheet. ' '

Click upon any cell in the worksheet makes that cell the active or current cell. The following table
shows the various keys used to move the cell pointer:

Key Moves the pointer to
Up arrow ~ Onecellup or previous row
Down arrow : One cell down or next row
Right Arrow or Tab One cell right or next column
Léﬂ Arrow or SHIFT+Tab .Onecell ieftor previous column
Home , _ . Beginning of row
CIRL+Home Beginning of worksheet (cell A1) )
CTRL+End End of worksheet(last cell in the filled worksheet)
CTRL+arrow key the edge of the current data region
- CTRL+PageDown - next worksheet
PAGE DOWN -~ downonescreen
PAGE UP ' up one screen
ALT+PAGE DOWN . one screen to the right
ALT+PAGEUP  omescreentotheleft
| CTRL-f-PAGE DOWN . thenextsheetinthe IWOrkbook _
CTRLAPAGE UP B the previous sheet in the workbook

4.5  EnteringData

~ When you open a new workbook, the worksheets within itare b'lank.__Tb enter data into any cell,
make that cell active by selecting it. The insertion point appears. Type the data & press “Enter” key, or -

select any other cell to complete the entry. Due to some reason, if you wish to canéél the entry before its
completion, press “Esc” key. When you are typing the entry, the characters appear in the formula bar as
well as the active cell. Also “Enter” & “Cancel” button appear on the formula bar and mode on the status
bar changes from “Ready” to “Enter”.

Acell entry can contain either text or value or formula. Text value is a sequence of letters, numbers
and special characters. It is also called string or label. Name, phone numbers, city, etc. are common
examples of text entries. Values are numbers, dates and time. '
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Numeric entries can contain digits 0-9 and certain special characters like+- () E ., % and . Dates
& Time are viewed by Excel as a value, starting from 1/1/1900, which was assigned the value of {.

A formula is an expression, which has a value. Either you create that expression, or you can use the
built-in formula called finction. All formulas start with an equal sign. When you enter the formulainacell
and press Enter or move to another cell, you will see the results of the formula in the cell. The formula itsetf
will appear on the formula bar.

 Example: You want to create a grade sheet for BCA class of 5 students. Each student has
three subjects. Also you wish to calculate the class average in each subject. Following worksheet can be
created: '

wdﬁw telg

Toals

Q-ata

L ‘g’;‘: f .. . - -
s Foas -
Grade Sheetfar BC& e e —— Text Erdry
3 EName _ C_umpuler_.hl‘laths English Average
- I - ' Formua -
Bhavya - 9 100 ormia
Harsh- - 7% 93 N
: A - - - |
Ramesh . 63 &
10, Clas_s._Av.er.asé"'f CEe2 98 78 ol nercerty

Forentering text or number, you have to go to the comesponding cell & start typing directly. If you
notice in the given figure, cell ES contains a formula which can be seen in the formula bar. Its value can be
seen in the cell. '

Moving and Copying Cells

Once you have entered some text or value of formula in a cell, it can be copied or moved to
another cell. For moving the cell contents to another cell, you can either select “Cut” option from “Edit”
menu or click the Cut button on the standard toolbar. For copying the cell contents, select “Copy” option
from “Edit” menu or click the Copy button on the standard toolbar. Then highlight the cell you want to
saste the cut or copied content into and select “Paste” 0pt10n from “Edit” menu from the menu bar or click
‘he Paste button on the standard toolbar. .

Altematively, if you are moving the celi cdntents to only a short distance, the drag-and-drop method
nay be easier. Simply drag the highlighted border of the selected cell to the destination cell with the mouse.

$.6  Spelling Check

Excel provides a built-in spelling checker you can use to correct your spelling mistakes in the
worksheet. This tool works in much the same way as the spelling checker does in Office applications. To
-un the spelling checker, follow these steps: :

1. Select the worksheet or worksheets that you want to be tncluded in the spelling check.
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2. Choose “Spelling & Grammar” from the “Tools” menu, or press F7. The Spelling dialog box is
displayed & potential errors are checked, There are buttons for you to respond to the suggestions.

You can either ignore the suggestions made by Excel or replace the original word with any of the ¢

suggested word. Youcan also add new words to the dictionary, so that next time it does not give
error on that word.

Spelling Dialog Box

If you don’t want to spell check an entire worksheet; you can run the spelling checker on arange
of cells, as well. To run the spelling checker on a range, do the following:

1. Selectthe cells you want to be checked.

2. Choose “Spelling & Grammar” from the “Tools” menu, or press F7. Respond to the spelling
suggestions as appropriate.

Automatic Error Correction

Excel wxll fix mistakes for you as you typeif they are past of the auto correct lLst The purpose of
AutoCorrect is to automatically change things you type, as you type them. For instance, mistakenly typed
“teh” will automatically be replaced by “the”, Also if you type any text & mistakenly make first two letters
capitalised, then the second letter will automatically be converted to lower case, when you move to another
cell. If you know you always misspell a certain word, you can force Excel to recognize that word and
replace it with the proper one. Similarly, you can define short codes that can be automaticaily replaced with
long words or phrases. To do so, select “AutoCorrect” from “Tools” menu. An AutoCorrect dialog box
appears.

There are many features that can be checked at the top including the one for correcting two initial
capitals as you type. If you’re typing in sentences, the first letter will always be capitalised for you, and
names of the days of the week will always become capitalised. There is a check mark “Replace text asyou
type” which is tick marked, hence the word “the” become corrected.

You can add new words to autocorrect list. To do so, follow these steps:

1. Select “Autocorrect” from “Tools” menu.
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2. - Inthe “Replace” area, type the misspelled text, ie.the word you typically misspell.

3. Inthe “With” textbox, add the text the way it should be spelled or the way you want it to be
replaced with.

4. Click the*Add” button The word’s misspelling and correct spelling are added to the auto correct
list.

4.7  Selecting Cells

Before a cell can be modified or f01 matted, it must first be selected (highlighted). Refer to the table
below for selecting groups of cells.

Cells to Select Mouse Action

One cell Click once in the cell

Entire row ' Click the row label

Entire column Click the columnlabel

Entire worksheet . Click the whole sheet button

Range Drag mouse over the cells or hold down the SHIFT key while
: using the arrow keys

' Editing Cell Entry

Ifyou select a cell containing some content, you can just select that cell and type a new entry. This
will replace the old entry. To edit the existing contents of a cell, double-click on the cell or click once and
press F2. A cursor or insertion point appears in the cell. Now, you can modify the existing entry.

4.8  Autofill Feature

The Autofill feature allows you to quickly fill cells with repetitive or sequential data such as

- chronologtcal dates or numbers, month names and repeated text. You can conveniently create series such

~asl,2,34,5,.....0r3,5,7,9,.... or Marksl, Marks2, Marks3,...etc. Also an existing series can be extended
further.

When you select a cell or a range, a small black box called “fill handle” appears at the lower right
corerof the selection,

Gk ﬂindmﬁ Help
10 - B L. UIE

When youplace the mouse pointer over the fill handle, the shape of the pointer changes o a black
cross, By dragging the fill handle, you can copy contents to adjacent cells. To do so, follow these steps:




1. Type the beginning number or date ofan mc1ementmg series or the text that will be repeated into a
cell.

2. Select the fill handle with the left mouse button and drag it down as many celis as you want to fill.

3. Release the mouse button.

Exercise: To copy the contents of cell A1 to range A2:A10 using Autofill
1. Selectcell Al & Type some number or text in this cell.
2. Place the mouse pointer over ﬂ']e fill handle & drag the fill handle to cell A10.
3. Release the mouse button. The same number/text will be copied to the selected range.

Ifyou want to autofill number ofrows with cells displaying the same number or date you must enter
data to two adjacent cells in a column. Highlight the rwo cells and drag the handle of the selection with the
mouse, downwards, Say, incell Al type 132, in cell B1 type “Test”. Select Al: A2. Drag the fill handle up
to cell B10 and see what happens.

Depending upon the initial selection, Excel decides whether to copy the contents of selected cells
or create a series. If the initial selection is a single cell containing text or a number; then the contents are
copied. If the initial selection is a single cell containing month name, week day or some label conta.mmg a
number, then the series is extended. Following Table shows the resultant action of Autofill:

Initail Selection (content of cell B1) Action ( contents of cell B2, B3)
12 | | 12,12
Class _ _ Class, Class
Classl | | Class1, Class? |
Sunday ' ' "~ Monday h

Autofill to Extend a Series

You can also use fill handle to extend a series. If you select multiple cells, series will be extended.
To do so, follow these steps: -

1. Type the first two numbers of the series into two adjacent cells. Select both the cells.
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2. Select the fill handie with the left mouse button and drag it down as many cells as you want to fill.

3. Release the mouse button.

Exercise: To extend a series 5,10, 15, ...... using Autofill
1. Selectcell A1& Type 5 inthis cell.
2. Select cell A2 & Type 10 in this cell.
3. Place the mouse pointer over the fill handle & drag the fill handle to cell A10.
- 4. Release the mouse button. You can see the extended series in the figure.

If you want to copy these cells in the same sequence, press Cirl & drag the fill handle. See what
happens.

Alternating Text and Numbers with Autoﬁll

The Autofill feature can also be used for alternating text or numbers For example, to make a
repeating list of the days of the week, type the seven days into seven adlacent cells inacolumn. nghhght
the seven cellsand drag down with the mouse.

Autofillmg Functmns

Autoﬁll canalso be usecl to copy functions. To do 50, type a formula in the first cell & dragthe fill
handlc down asmany cells as you want to fill. Then release the mouse button.

Exercise: Touse Autoﬁll for copymg functions.

Column A and column B each contam hsts of numbers and column C contains the sums of’ columns
Aand B for each row.

1. Select cell C2and type “=SUM(A2:B2)".

2. Select cell C2 and drag the fill handle down to fill in the remaining cells. The autofill featm'e will
automatxcally update the row numbers as shown below ifthe cells are reference relatively.
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4.9  Quick Data Entry

There are plenty of features in Excel to enter data in a faster and smarter way than via the
keyboard. One of these is the 4 utofill feature, which lets you enter days of the week or months of the
year automaticaly, that was discussed earlier, This feature also helps in generating linear series. This is
one way to speed up data entry, but it’s not the only way. Here are some other techniques.

Custom Lists

As with the months of the year and days of the week, you can create your own custom fill lists,
To do so: ' '

1. Select “Options” from the “Tools” menu. The Options dialog box gets displayed.

Select the “Custom Lists™ tab,

L

Select “New List” in the Custom Lists list.

>

Inthe List Entries portion of the dialog box, type the items in your fill series, in the order they

should appear. For instance, you might type a list of department managers in alphabetic order.
Press Enter at the end of each element.

5. When you are done, click the Add button.
6. Click OK to finish.

Lhart

Cwombs: . ;
C Inew st ) pwe
§Sur'r, Mon, Tuz, Wed, Thu, Fr, £ . ' LR~ : i
i Sunday, Monday, Tuesdaw, “Yec | il Browr L | f
+ 1Jan, Feb, Mar, dpr, May, Jun, J . +Brenda Baker | L __QE"?‘EWM
. iJanuary, February, March, Apr : {Debra Davie o
{ired, grance, yeli b ! Fdward Evans ;
1 | Felida Ferris
D . . 1Gordon Gibson !
E i i iHermpine Hinkle :
1 . R
; .; fress Enter to separate fist entries, 1
. ; I_m rt ﬁst -ﬁ-em CE!ES: ‘ ........................ JR— —— : ;

b0 [ conce |

Creating Custom List
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Drop Down List

You can create a drop-down list using the data validation feature in Excel. This list allows users to
select the cell and then select from a list of pre-defined values for that cell. Once the usermakes a sclectlon
and moves to a different cell, the arrow for the drop-down list disappears.

For example, let’s say that you want to create a list of employee names. On a new worksheet,
enter the employee names in any manner desired, Select the list and give it a name such as Employees.
Now follow these steps:

1. Select the cell where you want the drop-down list to appear.

| 2. Choose Validation from the Data menu. The Data Validation dlalog box is displayed. Select the
Settings tab.

Using the Allow drop-down .list, choose List.

Make sure the “In-Cell” Dropdown check box is seleéted.

In the Source box, enter =Employees. (This is the name you earlier gave to the emplojfee list.)
Click OK.

AN G

Now, whenever someone selects the cell youused in step 1, they’li see a drop-down list arrow to
the right of the cell. Clicking on the list provides a drop-down listing all the employees. The user can select
one of the employees, but cannot enter a different name. When they move to a different cell, the drop-
down list disappears, but the selected value remains visible.

Data Entry Forms

Excel offers a simple data entry form, which is a quick and easy way to enter data dlrectly into
cells. You'll find it invaluable if you wish to: :

» start a new database table or to add new records to an existing one
o scroll through data records one at a time

o search for records containing specific information

o editordelete individual records if necessary |

To use the data entry and search form, you need to follow the convention of organizing your
variables or attributes in the columas of the spreadsheet, and your records in the rows, as shown below

|First Name _Last Name Gender Age |
Anu  Kapoor F 11
Ankur Sharma M 1‘;

To pull up the data entry and search form, first make sure to enter your variable [abels in the first
row, if they are not there already.

Select “Form” option from “Data” menu. A simple form gets displayed:
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Click on the “New” button to enter a new necord.%u can navigate between variables by hitting the
Tab keyon your keyboard, or by holding the Alt key and typing the underlined letter for the variable shown
onthe forn (e.8., type Alt+A to skip straight to the “Last Name” variable). It is very important to note that
the dath ire not transferred from the form to your spreadsheet until you click the “New” button.

You can also use this form as a simple search tool by clicking the Criteria button. Then enter the
~ datayou wish to find in one or mote fields and click the “Find Prev” or “Find Next” buttons to find each
instanée of the search information. To returnto the data entry function of the form, click the Form button,
which you’lt find in place of the Criteria button selécted eailier. - ' '

4,10  AutoSum

Adding numbersisa commion task on spreadsheets. The AutoSum function makes this one of the
easiest tasks to accomplish. AutoSum function can be performed using AutoSum button, present on the
standard toolbar. Totaling a group of columns or rows can be as easy as clicking a button. You can use the
Autosum button to add the contents of a group of adjacent cells. To do this, Excel looks at the cells
adjacent to the active cell, makes an assumption as to which cells youwant to sum, and displays a formula
based on its best determination about the range you want to sum. You can press the enter key to accept the

~ formula, or you can select a different range of cells to change thé range in the formula.

Touse Autosum, follow these steps:

1. Select the cell where the you want the sum to appear. This cell should be outside the group of cells .

whose values 15 1o be added.

2. Click the “Autosum” button % on the standard toolbar, ~

3. Asum function gets entered in the selected cell. Also atange of cells whibh are being added gets

highlighted. You can change the rangr if you wish.

4. Pressthe “ENTER” key on the keyboeird or click the green check mark button on the formula bar

Exercise: To add the cdnfents ofcell A2 & B2 usmg Autosum
© L SelecteellC2. |
2. Press Autosum Buﬁon. - _
3. The raﬁge A2 ."thrc_)ugh B2 gets selected.
4

. Press“Enter” Key.
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4.11

AutoFormat

To make the worksheet presentable, formatting is a must. At times formatting can be rather tedious,

especially if your worksheet is large or presents complex information. Excel includes a very powerful
 formatting tool called AutoFormat to help you with your formatting tasks. This feature allows you to format
data tables within your worksheet quickly and easily. Excel has many preset table formatting options which
can be used to format an entire table, including setting all formatting attributes and row and column sizes.

To use autofqrmat, follow these steps:

1.

Highlight the celis that will be formatted.

2. Choose “AutoFormat” from the “Format” menu. The AutoFormat dialog box is displayed.

Jan Feb Mar Jotal
5 13
7 7

AutoFormat Dialog Box

Select the format you want to apply to the table by clicking on it with the mouse. Use the scroll
barto view all of the formats available. ' o

Click the “Options...” button to select the elements that the formatting will apply to.
Click on the OK button. Excel reformats your table to match the format selected by you.
Summary .

An electronic spreadsheet is similar to a ledger and can be used to solve large variety of problems
related to data analysis and modeling.

Spreadsheets can be used for business as well as scientific applications.

A workbook is the ﬁle in wlﬁch you work and save for later use. It contains worksheets,

- A worksheet is a grid of rows and columns. The intersection of row and column is called a Cell.
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The formula bar is used to enter or edit values & formulas. Name box telis you which cell is active.

A workbook can be retrieved either by selecting Open command from the file menu or by clicking
Open button on the standard toolbar.

You can search a workbook using the Open dialog box. ‘

The worksheets can be inserted, deleted or renamed in the Worrkbook.

You can move around in the worksheet using mouse or keyboard.

Cell entries can be either text or value or formula.

Text is combination of letters, numbers and special characters.

Numeric value contains numerals through 9 & certain special characters.

A formulaalways begins with an equal sign. |

You can copy or move cells to different parts of same worksheet or to another worksheet,

Excel provides a built-in spelling checker you can use to correct your spelling mistakes in the
worksheet, _

Excel will fix mistakes for youautomatically, as you type if using the AutoCorrect feature. -
Before a cell can be modified or formatted, it must first be selected (highlighted).

The Autofill feature allows you to quickly fill cells with repetitive or sequential data such ag
chronological dates or numbers, month names and repeated text. This is done using the fill handle.

Ifthe fill handle is dragged up or to the left of the selection, then the series is created in descending
order.

There are many features in Excel to enter data in a faster and smarter way than via the keyboard.
These include AutoFill, Custom lists, Drop down lists and Data entry forms.

The contents ofa group of adjacent cells can be added easily on a click, using the Autosum button
to add. ' ' |

Avery powerfu! formatting tool called AutoFormat helps you to format data tables within your
worksheet quickly and easily. Excel has many preset table formatting options which can be used to
format an entire table. '

Unit End Ques_tions

What do youmean by a spreadsheet?

What are the advantages of using an electronic spreadsheet?
Differentiate between a workbook and a worksheet.

What are the components of an Excel window?

Explain the concept of file management in spreadsheets.
How can you rename a worksheet?

What type of data cén be entered in a cell?

How can you check for tﬁe spelling errors in a worksheet?

What is the use of Autocorrect? Give a suitable example.
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10.

How can you create a series in Excel?

11. Explain the use of AutoFill.

12.
13.
14.
15.
16.
17.

18,

19,

20,

21,
22.

23,
24.

25,

How autofill can be used to copy functions?

What is the significance of AutoSum?

How can you select multiple columnsin a worksheet?
Why do you need AutoFormat in spreadsheets?
Explain the data entry forms. |

Create a worksheet for storing the sales record of a Car company for past 5 years. The company
has three outlets in the city.

Create a worksheet to store the payroll data of ABC Company. Save the workbook as -
EMPLOYEE.XLS. Rename the worksheet as Payroll. The salary should be divided into different
heads like Basic, HRA & DA.

Write the steps to search for a workbook named “BCA.xIs” on C:\.
How will you make an entry “avrg” to be replaced automatically by “averége”?
Create aseries 1,4, 7,....... In Excel using autofill.

Open the workbook “Employeexls™. Insert a column “S.No.” before the names of employees and
number the employees in serial order. Use fill handle.

Open anew worksheet & write the names of month in a single row, using fill handle.

Use AutoSum fo total the salary of each employee in the workbook “Employee.xls”. Apply a
format of your choice to this workbook. -

Create a custom list containing n/am'és of your ten friends.
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Unit 5: Formatting

Structure of the Unit

5.0
5.1
5.2
53
54
5.5
5.6
5.7
5.8
5.9
5.10
311

5.12

- 513

5.14
5.15

5.16

Objecﬁves

Introduction to cell text

Téxt Editing

Copying Cell Contents

Copying and Pasting Cells

Cutting or Moving the Contents of Cells
Moving oelis_ | |
Choosing a Default Font

Adjusting the Standard Column Width |

CellAlignment

- Alternate Method: Alignment by Using the Formatting Toolbar

-

Addihg Bbld, Underline, and Italic

Alternate Méthod: Alignment by Using the Formatting Toolbar
Working with Long Text

Making Numeric Entries

Summary

Unit End Questions
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5.0 Objectives
After going through this unit to will beable to :
~ « TextEditing, copy cells, moving cells
» Fontsettings, call alignment, formating cells
e Varioustype of entries in worksheet etc.
5.1  Introductionto cell text

A new worksheet is primarily made of cells that are patiently waiting for you to enter data, There
are different types of values that can be entered inacell. - '

To puf avalue inacell, click that cell and type the value you warit. After entering the value, you can:
. Press Enterto move to the cell under it '
« PressTabtomovetothecellon the right side (unless you were on the most right cell of the columz)

« Press Shift+Tabto move to the cell on the left side (unless you were on the most left cell of the
columnn} '

« Press theup, the right, the down, ox the left arrow keys to move to the upper cell, the right cell
(equivalent to pressing Tab), the down cell (equivalent to pressing Enter), or the left cell (equivalent
to pressing Shift -+ Tab) celi of the current cell

« Click another cell

As mentioned above, if you enter a value inacell and press Enter, you move focus to the cell under
it or if you press Tab, youmove focus to the cell on the right side. As an alternative, you can indicate the
sequence of cells you want to follow so that, when you press Enter or Tab, the focus would not necessarily
move to the right or the cell under but rather to the cell in the sequence of your choice. To do this:

« Randomly select the sequence of cells you want. In other words, click the first cell in your mtende.d
sequence, press and hold Ctrl, then click each cell in the desired order

. . While still holding Ctrl, once again click the cell that will be the fivst, and release Ctrl Type the
 desired vatue in that first cell ' :

« PressEnteror Tab

« Typethevalueinthe next cell of the sequence

« Repeatsteps

« When youhave finished, either press oneof thé arrow keys or clicka cell thatisnotin the sequehce

n Microsoft Excel, you can entera common value forthe same cell address in different worksheets.
To do this, first select the worksheets. Click thie intended cell and type the desired value If you type
something, it goes into the active cell. If you click a cell and start typing, the new eniry will replace the
content of that cell, whether that cell had data or not, this could be advantageous or disastrous.

To prevent acell from being edited by the user, you can protectitand Jock its content.

Data you type ina cell can consist of any kinds of characters, letters, numbets, etc. Sometimes, 2
long text will look Jike covering more than one cell; unless you merge cells, the text you type goes into one
cell regardless of the length of the text. -
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A cell can contain as many as 32767 characters.

Data that you type in a worksheet is in fact entered in cells, except when you are drawing, Unlike
atraditional word processor, Microsoft Excel hasa unique way of treating text and considering any data
youtype inacell. Data entered in a cell is confined to that cell, ] fyou type text that is longer than the cell's
width, the content will display fine, giving the impression that the text is covering more than one cell or that
the cell on the right side is no more available. Data youtype is always in its cell. If you type anything ina

~cell, its content will take priority in displaying its content. Therefore the content of the left cell will appear
cut. That's why you should be very familiar with the way a cell (any cell) displays its data, and how every
cell relates to the others.

5.2 TextEditing

Editing cells content consists of deleting, replacing, altering, or adding something in them. You
already know that if you click a cell and start typing, its content would be replaced with the new entry. If
- Youwant to add or subtract something to a cell's content: '

*  Youcandouble-click it. This would put the cell in edit mode and you can then pméeed

»  Click a cell to give it focus and then press F2. This puts the ceil in Edit mode; this time, the caret is
at the end of the text in the cell; then you can proceed

» Clickacell, in the Formula bar, edit the text as you see fit

Whatever techlliIC]lie you use, when you have finished editing a cell, make sure you move its focus
by pressing Tab, Enter, or clicking somewhere else. When you are in edit mode, the arrow keys are not
working, and many actions are not available, o

3.3 Copying Cell Contents

If you have done word processing before, you are probably familiar with techniques of cdpying |
and pasting text from one part of 2 document to another, or from one document to another, The same

technical approaches are also available in Microsoft Excel.

You can copy the content of one or more cells and store the value(s) in the clipboard. In Microso
Excel 97, you could store only one item at a time in the clipboard. Kyou cut or copied something, it would
replace the content of the clipboard with the new selection. In Microsoft Excel 2000, the clipboard could
contain up to twelve items. When the Clipboard toolbar was functional, you conld select copied or cut
items fromits list of buttons, If you used more than 12 stored items, the toolbar functionedon a first-in first-
out basis. ' '

In Microsoft Office 2007, the clipboard is represented as a window. To display it, on the Ribbon,
in the Home tab, and in the Clipboard section, you can click the more options
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The Clipboard window can be mo ed to any location of your choice on the screen. You can aiso
hide/close it if you don't need its services. To close it, you can click its Close button or you can click the
more options button. :

5.4  Copying and Pasting Cells

_ As we have seen we could copy one or more columns and put them to the clipboard. In reality,
you would have copied the contents of the cells under the colurn header and paste the values of those cells
to (an)other column(s). As areminder, to copy the contents of the cells of a column to the clipboard:

« Right-click a column header and click Copy
«  Click the column header. On the Ribbon, click Home. In the Clipboard section, click Copy

After copying acolumn, the vatues of all of its cells are available from the clipboard. To paste those
cells to another column: -

« Right-click the target column header and click Paste
« Click the column headet. On the Ribbon, click Home. In the Clipboard section, click Paste

we saw how 10 copy arow and paste 1 somewhere. When you copy & Tow, you in fact copy the
values of the cells on the right side of its Tow header. You can then paste the copied valuesto another row.

Instead of copying all the cells of a column or all of the cells of arow, you can copy only one or '
more cells to the clipboard: :

To copy the contént of a cell:

« Right-click thatcell and click Copy. To paste, click the target cell and simply press Enter, or right-
click the target cell and click Paste

. Click the celt. On the Ribbon, click Home. Tn the Clipboard séction, click Copy. Click the target
cell. To paste the content of the selected cell, click Paste

+ Clickthe cell. Press and hold Ctrl. Position the mouse on one of its borders. The mouse cursor |
would be pointing to the top-left and accompanied by a + sign:

While holding Ctrl, drag to the target cell. When the target cell is surrounded, release the mouse
and release Ctrl '

- To copy the contents of various cells, select the cells ina range:

"« Right-click the selection and click Copy. Click the top-left cell of the target cell. To paste, simply
press Enter, or right-click a targeted cell and click Paste
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 OntheRibbon, click Home. In the Clipboard section, click Copy. Click the top-left cell or the -
target. To paste, in the Clipboard section of the Ribbon, click Paste

Press and hold Ctrl. Position the mouse on one of the borders of the selection. The mouse cursor
would be pointing to the top-left and accompanied by a+ sign. While holding Ctrl, drag the group in the
“desired direction. When the target cells are surrounded, 1'ele§se the mouse and release Ctrl.

5.5  Cautting or Moving the Coutents of Cells

As we know saw how to move a column or a group of columns from one location to another. In
Lesson 3, we saw how to move a row from one section of the worksheet up or down. Sometimes, instead
of moving the whole colwmn or the whole row, you may want to move only one particular cell ora group of
cells. To move the content of'a cell to the clipboard and paste it somewhere:

. Ri ght-click the cell and click Cut. To paste the value of the cell somewhek,_click the target cell and
press Enter, or right-click the target cell and click Paste

*  Click the cell. On the Ribbon, click Home. In the Clipboard section, click Cut. Click the target
cell. To paste the cell, in the Clipboaid section of the Ribbon, click Paste T

When you move a coluinn or arow, it gets removed from the previous location and carries its cells
to the new location, An alternative is to move only a particular group of cells. To move the contents of a
group of cells to the clipboard, select the cells: - :

+  Right-click the group and click Cut. To paste the valﬁes of the cells éomewhére, click atarget cell
and press Enter, or right-click a target cell and click Paste

* Onthe Ribbon, click Home. In the Clipboard section, click Cuf. Click the target cell. To paste the
cell, in the Clipboard s_ec_tion of the Ribbon, click Paste

. 5.6  Moving Cells

Tomoveacell, you ask Microsoft Excel to remove its content from that location to a new location
of your¢ - When you do this, only the content of the cell moves, leaving the previous location empty.

To move acell, first click it to give it focus. Position the mouse on one of it borders the mouse -
cursor changes into a cross: '

| Fisthamilost NasEnghish  isiory

~ Roland Becker  10.50!  12.08]
¢ . Chrissy lamans *{% 12.00 1450
g Rovert  Ferall 7 16000 1550
8 Alexa Sciwitts 15.50. 14,00
3 :
A0
11
17

Click and hold your mouse down, Drag up, down, left or ri ght to the target cell of your choice. A
rectanguiar box that is the same size as the cell would guide you and assume the position of the mouse
where the mouse is currently over: _ -
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When the celi is positioned where you want, release the mouse. If you land on acell that containg
something already and that cell is allowed to receive a value (some cells can be "locked"

receive a vahue), you would receive a warning message box asking you to confirm that you really want to

so they cannot

If you click OK, the content of the tai‘get value would be replaced with that of the éell that was



" To move more than once cell, first select the cells ina range (they most be selected as a range). Position the
" mouse on the border of the selection until the mouse cursor turns into a cross. Click the drag in the-
direction of your choice. A guiding box that is the same size as the group would gulde you. When you get :
to the new location, release the mouse. '

5.7

Choosing a Default Font
Microsoft Excel enables you to choose a default font. The default font is the style of typeface that

Excel will use unless you specify adifferent style. For the exercises in this lesson, you want your font to be
sei to Arial, Regular, an_d Size 10. To set your font to Arial, Regular, and Size 10: :

1.

7.

5.8

Choose Format > Celis from the menu.

2. Choose the Font tab.

3. Inthe Fontbox, choose Arial.
4.
5
6

In the Font Style box, choose Regular.

. Inthe Size box, choose 10.
. Ifthere s no check mark in the Normal Font box, click to place a check mark there. Your selections -

are now the default.

Click OK.

Adjusting the Standard Column Width

When you open Microsoft Excel, the width of each cell is set to adefault width. This width is called

the standard column width. You need to change the standard column width to complete your exercises. To
.. make the change, follow these steps:

1.

5.9

Choose Format> Column > Standard Width from the menu. The Standard Wldth dialog box
opens.

Type 25 in the Standard Column Width field. Click OK. The width of every cell on the worksheet

_should now be set to 25,

Move to cell Al.

-Type Cathy.

Press Enter.

- Cell Alignment

The name "Cathy" is aligned with the left side of the cell. You can change the cell alignment.

Centering by Using the Menu

To center the name Cathy, follow these steps:

1.

Move the cursorto cell Al.

2. Choose Format > Cells from the menu. The Format Cells dialog box opens.
3.
4. Click to openthe drop-down box associated with the Horizontal field. After the drop-down box

Choose the Alignment tab.

is opened, click Center.

Click OK to close the dialog box. The name "Cathy" is centered.
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nght Alignment by Using the Menu
To right-alignthe name "Cathy,“ follow these steps:
1. Move the cursor to cell Al. _
Choose Format > Cells from the menu. The Format Cells dialog box opens.

Choose the Alignment tab.

Sl

Click to open the drop-down box associated with the I—Iorlzontal field. After the drop down box
opens, click Right (Indent).

. 5. Click QK toclose the dialog box. The name "Cathy" is right-aligned.

Lefi-Aligning by Using the Menu _
To left-align the name "Cathy," follow these stéps:

1. Move the cursor to cell Al.

2. Choose Format > Cells from fhé menu. The Format Cells dialog box opeps;
3. Choose the Alignment tab, |
4

. Click to openthe drop-down box associated with the Horizontal field, After the drop-down box
opens, Clle Left (Indent).

5. Click OK to close the dlalog box. The name "Cathy" is left-aligned.
5.10  Alternate Method: Alignment by Using the Formatting Toolbar

Using the Formatting toolbat, you can quickly perform tasks. You can use the Formatting toolbar
to change alignment. . _

Centering by Using the Toolbar |
To center the name "Cathy," follow these steps: _
1. Move the cursorto cell Al the Center icon, which is located on the Formatting toolbar.
The red circle designates the Align Cenier icon.
Right-Aligning by Using the Toolbar
You can right-align the name "Cathy" by following these steps:
1. Move thé cursorto cell Al,
2. Click the Align Right icon, which is located on the Formatting toolbar.
The red circle designates the Align Right icon.
Left-Aligning by Using the Toolbar
You can left-align the name "Cathy" by following these steps:
1. Move the cursortocell Al _
2. Click theAlign Left icon, which is located on the Formatting toolbar.
The red circle designates the Align Left icon. |
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5.11

Adding Bold, Underline, and Italic

You can bold, underline, or italicize text in Microsoft Excel. You can also combine these features -

in other words, you can bold, underline, and italicize a single piece of text.

Inthe exercises that follow, you will leaﬁ‘l ‘hree different methods for bolding, italicizing, orunderlining

text in Microsoft Excel. You will leamn to bold, italicize, and underline by usmg the menu, the icons, and the
shortcut keys. _ _ LA

Adding Bold by Using the Menu-

1.
2.

U

TypeBoldincell A2, -

Click the check mark located on the Formula bar. Clicking on the check mark is similar to pressing
Enter.

Choose Format> Cells from the menu. The Format Cells dialog box opens. |

- Choose the Fonttab,

Click Bold in the Font Style box.
Click OK. The word "Bold" should now be bolded.

~Adding Italic by Using the Menu

1.
2.

3.
4,
5.

Type Italicin cell B2.

Click the check mark located on the Formula bar. Clicking on the check mark is similar to pressing
Enter. -

Choose Format > Cells from the menu. The Format Cells dialog box opens.
Click Italic in the Font style box. _
Click OK. The word "alic" is italicized.

- Adding Underline by Using the Menu

them,

'Microsoft Excel provides several types onunderlines. The exercise that follows itustrates some of

 Single Underline

1.

& v os W

Type Undertine in cell C2.

Click the check mark located on the Formula bar. Clicking on the check mark is similar to pressing -
Enter. '

Choose Format > Cells from the menu. The Format Cells dialog box opens.
Click to open the drop-down menu associated with the Underline box.

Click Single. -

Click OK. The cell entry now has a single underline,

Double Underline

1.
2.
3.

Type Underline in cell D2.
Click the check mark located on the Formula bar,

Choose Format > Cells from the menu. The Format Cells dialog box opens.
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4. Click to open the drop-down menu associated with the Underline field,

5.

Click Double,

6. Click OK. The cell entry now has a double underline.

Single Accounting

1.

6.

"Type Undetline in cell E2,

. Chick the check mark located on the Formula bar.

2

3. Choose Format > Cells from the menu. The Format Cells dialog box will open,
4,
5

Click to open the drop-down menu associated with the Underline field.

. Click Single Accounting,

Click OK. The cell entry now has asingle accounting underlme

Double Accounting

L
2,

-
J.

Type Underline in cell F2.
Click the check mark located on the Formula bar.

Choose Format > Cells from the menu. The Format Cells dialog box will open.

4. Click to open the drop-down menu associated with the Underline field.
5.
6

Click Double Accounting,

. Click OK. The cell entry now has a double accounting underline.

Adding Bold, Underline, and Italic by Using the Menu

1.

8.

N e W

Move the cursor to cell G3.

Type All three,

Click the check mark located on the Formula bar.

Choose Format > Cells from the menu. The Format Cells dialog box opens

Choose the Font tab,

Click Bold Italic in the Font Style box. ,

Click to open the drop-down menu associated w1th the Underline field. Then click Smgle
Click OK. The words "All three" are now bo]cled italicized, and underlined.

Removing Boldmg and Italics by Using the Menu

1.

2.

3,
4,

Highlight.cells A2 to B2. Place your cursor in cell B2. Pr ess the F8 key, Press the right arrow key
once.

Choose Format > Cells from the menu. The Format Cells dialog box opens.
Click Regular in the Font style box. |
Click OK. Cell A2 is no longer be bolded. Cell B2 is no longe1 italicized.

Removing an Underlme by Using the Menu

I.

Moveto cell C2.
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2. Choose Format > Cells from the menu. The Format Ceils dialog box'opens. _
3. Clicktoopen the drop-down meﬁu associated with the Underline field. Then click None.
4. Click OK. The underdelined isremoved. |
Alternate Method: Adding Bold by Using the Icon
1. TypeBoldincell A3, |
- 2. Click the check mark located on the Formula bar.
3. C.lick the Bold icon, which is on the Formatting toolbar.
4. Click again on the Bold icon if you wish to remove the bolding:
~ Alternate Method: Adding Italic by Using the Icon
1. Typeltalicincell B3,
2. Clickthe éheck’ mark located on the Formula bar.
3. Click the Italic icon, which is on the Formatting toolbar.
4. Click again on the Italic icon if you wish to remove the italics.
Alternate Method: Adding Underline by Using the Icon |
1. Type Underline in cell C3. |
2. Click the éheck mark located on the F ormula bar.
3. Click the Underline icon, whiéh is on the Formatting toolbar.
4, Click again on the Underline icon if you wish to remove the underline.
Alternate Method: Adding Bold, Underline, and Italic by Usiﬂg,lcons
1. TypeAll Threeincell D3,
2. Click the check mark located on the Formula bar.
3. Clickthe Boldicon,
4. Click the Ialic icon,
- 5. Click the Underline icon.
*. Alternate Method: Adding Bold by Using Shortcut Keys
1. TypeBoldin cell Ad. | o
2. Click the check mark located on the Formula bar. ‘
3. Hold 'dowﬁ the Ctrl key while_ pressing "b" (Ctrl-b). .
4, Press Ctrl.-b again. if you wish to remove the bolding.
Alternate Method: Adding Ttalic by Using Shortcut Keys
1. TypeItalic in cell B4, |
2. Click the check mark located on the Formula bar,

3. Holddownthe Ctrl key. while pressing "i" (Ctrl-i).
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4. Press Ctrl-iagainif you wish to remove the italic formatting,
Alternate Method: Adding Underline by Using Shortcut Keys
1. Type Underine in cell C4.
2. Click the check mark located on the Formula bar.
3. Hold down the Ctrl key while pressing "u" (Ctrl-u).
4, Press Cirl-uagain, if you wish to remove the underline,
Alternate Method: Adding Bold, Underliné, and Italic by Using Shortcut Keys
1. TypeAll threein cell D4, |
2. Click the check mark located on the Formula bar.
- 3. Holddown the Cirl key while pressing "b" (Ctrl-b).
4." Hold down the Ctr key while pressing "i" (Ctrl-i).
5. Hold down the Ctrl key while pressing "u" (Ctrl-u).
5.12 Alternate Method: Alignment by Usmg the Formatting Toolbar
- You can change the Font, Font Size, and Font Color of the data you enter.
Changing the Font _
L. Type Times New Romanin cell AS.
2. Click the check mark located on the Formula bar.
Choose Format > Cells from the menu. The Format Cells dialog box opens.
Choose the Font tab, All of the Fonfs listed in the Font box are available to you

woh W

Find and click Times New Roman in the Font box.

6. Click OK:—The-font-changes- ﬁom AtrialtoTimesNew-Roman
Changmg the Font Size
1. Place the cursorincell AS. _
2. Choose Format > Cells from the menu. The Format Cells dialog box opens.
3. Choose the Font tab. | o
4. Click 16 in the Size box
5. Click OK. The font size changes to 16
Changmg the Font (Z/ bor '
1. Place the cursor in cell AS. o
- 2. ChooseF ormat > Cells from themeny, The Format Cels dialog box opens. )
3. Choose the Font tab, o
4. Click to open the drop-down ménu associated with the color ﬁéld.
5. Click Blue.
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6. Click OK. The font color changes to blue,
Alternﬁte Method: Changing the Font Color by Using the Icon
I. Place the cursor in cell AS.
2. Click the down arrow next to the Font Color icon.
3. Click on Red. Your font clofor changes to red.
- 5.13  Working with Long Text

- Whenever you fype text that is too long to fit intoa cell, Microsoft Excel attempts to display all the text.
It eft-aligns the text regardless of the alignment that has been assigned to it, and it borrows space from the
blank cells to the right. However; a long text entiy will never write over cells that already contain eniries-
nstead, the cells that contain entries cuts off the long text. Do the following exercise to see how this works.

1. Move the cursor to cell A6. S

Type Now is the time for all good men to go to the aid of their army. '.

-Press Enter. Everything that does not fit into céllAG spills over into the adjacent cell,
‘Move the cursor to cell B6. |

Ty!lae TEST. :

Press Enter. The entry in cell A6 1s cut off.

S RN SEE RN

Move the cursor to cell A6, - _
8. Look at the Formula bar. The text is still in the cell,
Changing a Single Column Width

Earlier you increased the column width of every column on the worksheet. You can also increase
' individual column widths. If you increase the column width, you will be able to see the long text.

1. Make sure the cursor is é;hywhcré under column A. S
2. Choose Format> Column > Width from the menu. The colmnnﬁdth diélog box oi)eﬁs.
3. Type 55 inthe Column Width field, - | |
4. Click OK.

Column A s setto a width of 55. You should now be able to see all of the text.

Alternate Method: Changing a Single Column Width by Dragging -

You can also change the column width with the cursor.

1. Place the cursor on the line between the B and C column headings. The cursor should look like the
one displayed here, with two arrows. : '

. 2. Move your mouse to the right while holding down the left mouse button. The width indicator
appears on the screen. _ : '

;3. Release the left mouse button when the width indicator shows approximately 40,
Moving to a New Worksheet '

In Microsoft Excel, each _workijook is made up of several worksheets. Before moving to the next
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topic, move to a new worksheet.

1. Click Sheet 2 in the lower left corner of the screen,

Setting the. Enter Key Direction

In Microsoft Excel, you can sﬁeci_fy which direction the cursor moves when you press the Enter

key. You can have the cursor move up, down, left, right, or not at all. You will now make sure the cursor is
set to move down when you press the Enter key.

1. Choose Tools > Options from the menu, The Options dialog box opens.
2. Choose the Edit tab.

3. Make sure there is a check mark in the "Move Selection after Enter" box,

4,
.S

5.14

It Down is not selected, click to open the Direction drop-down box. Click Down.
Click OK. .
Making Numeric Entries

In Microsoft Excel, you can enter numbers and mathematical formulas into cells, When a number

is entered into a cell, you can perform mathematical calculations such as addition, subtraction, multiplication,
and division. When entering a mathematical formula, precede the formula with anequal sign, Use the
following to indicate the type of calculation you wish to perform:

+Addition
- Subtraction
* Multiplication
/Division
"Exponential
5.15 - Smilmary
» Anew worksheet is primarily made of cells that are patiently waiting for you to enter data. There
are different types of values that can be entered in a cell.
*» Acell can contain as many as 32767 characters.
«  Editing cells content consists of deleting, replacing, altering, or adding something in them.
. Fonnattiﬁg tool bar can be used to perform all tyf)e of formatiing in a worksheet
5.16 Unit End Questions | .
1. Write steps for making a cell bold italic and undertine.
2. How youwill change alinment of a cell entry.
3. How you will seta standard column width.
4. Howyouwill editatextinacell.”
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Unit 6: Formulas and Functions

Structure of the Unit

6.¢
6.1

6.2
63

6.0

Objectives

Formulas and Functions

Formulas

Linking worksheets

Relative, absolute, and mixed feferenchg
Basic functions

Function Wizard

Autosum

Short cut keys

Summary

Ynit End Questions

Objectives
After going through this unit you will be able to :
Enter formula in the worksheet, linking worksheet

Various cell refrencing i.e. Relative ,absolute and mixed _

¢ Basic function etc

6.1

Formulas and Functions

The feature of a spreadsheet program such as Excel is that it allows you to créate mathematical
formulas and execute functions. Otherwise, it is not much more than a large table for displaying text,

Formulas

Formulas are entered in the worksheet cell and must begin with an equal sign"=". The formulatncn
includes the addresses of the cells whose values will be manipulated with appropriate operands placed in -
between. After the formula is typed into the cell, the calculation executes immediately and the formula tself
is visible in the formula bar. See the example below to view the formula for calculating the sub tofal fora
number of textbooks. The formula multiplies the quantity and price of each textbook and adds the subtotal

for each book.
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ot Excel B_o‘ﬁk1 .

Adding Numbers

There are several ways to do this. Each method has its advantages and disadvantages.

To do this, begin by moving your cursor to ¢e]

| s icking-on cell C9,

Always move to the cell where you wan

Type-in method

Fto belocated.”

We want to add the three numbers in cells C6, C7 and C8. To use this method type-in (using the
keys on the keyboard) the following incell C9: ., :

=C6+C7+C§
4 B
S INCOME |
R . ‘Parents,
T Job
8| . Investments
Total

i

Your spreadsheet should look like the image to the right as you are typing in this equation. Note:
you don't have to'use capital letters - we only did this because they are easier to "see" in the tutorial.

Now - press the Enter kflzy Then, click on cell C9 again, The total of these cells will now appear
inC9. ' :
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When you have completed typing your equation, you will see this formula in the area below the
menu bar. Change the number in cell C6 to 500 (and press Enter). See howthe tota! AUTOMATICALLY
recalculates!!!

Whenever anumber is entered in a cell the entire spreadsheet will automatically recalculate.

Something happened here. Notice how you typed in an (equal sign) = before the cell location, If
you had simply typed in C6 + C7 + C8, Excel would have thought this entry was a word (text) and this
entry would have shown as you typed it.

Try this if you want. Any time you “create" an error in Excel, you can simply re-type or edit the
formula to correct the etror.

The Type in Method is really easy if you have a few numbers and can see their cell locations on the
screen, If you have alot of cells in the formula, which are on several screens, this is not such a great
'method, The next method will work a lot better for numbers "all over the place.”

Subtraction, Multiplication; and Division

You can put ina (minus) for subtraction, (asterisk) * for multiplication, and (slash)/ for division.
As you become more capable we'll, build some nifty formulas - using these features.

Point Method

Move to cell C9 again and click-on it. We'llnow add the numbers a second way. Press the Delete
key on the keyboard to delete the current formula,

First, press the = and then POINT (move) the cursor over cell C6 using the mouse, tap the left
mouse button on cell C6 (you will see a marquee box go around the cell). Now tap a+and move cursor
to C7, tap the left mouse button, and press another + and move the cursor to C8 and press the left mouse
button (notice how as you " +and point " the addition formula is being built in cell C9), now press Enter.
~ The same formula can be built using the arrow movement keys on the keyboard (except that you don't

have to click-on each cell as the cell is markeQ- as you move the arrows). :

LU -;mm s v ven

Pare s

Job R .-
Immstments - -
Tctal "'“Efi—}f‘?a»CE

Notice, as you are entering the cell é.ddresses, that as you place another + in the formula, that the
cursor "returns” to cell C9. Also notice, asyou point to cachcell that it is highlighted by a "marquee box."
This "tells" you what cell you've pointed to, Pretty neat!

This method is good when you need to move to numbers that are spread out all over the place.
Some people like it best and use it all the time  it's your choice.

Linking Worksheets

You may want to use the value from a cell in another worksheet within the same workbook ina
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formula. For example, the value of cell A1 in the current worksheet and cell A2 inthe second worksheet
can be added using the format "sheetname!celladdress". The formula for this example would be
"=A1+Sheet2! A2" where the value of cell A1 in the current worksheet is added to the value of cell A2 in
the worksheet named "Sheet2".

" Relative, Absolute, and Mixed Referencing

Calling cells by just their column and row labels (such as "A1l ")‘ié called l;é:l:ative referencing,
When a formula contains relative referencing and it is copied from one cell to another, Excel does not

create an exact copy of the formula. [t will change cell addresses relative to the row and column theyare

moved to. For example, if a simple addition formula in cell C1 "=(A1+B1)" is copied to cell C2, the
formula would change to "=(A2-+B2)" to reflect the new row. To prevent this change, cells must be called
by absolute referencing and this is accomplished by placing dollar signs "$" within the cell addresses in
the formula. o .

As per the previous example, the formula in cell C1 would read "=<($A$1+$B$1 )' ifthe value of
cell C2 should be the sum of cells A1 and B1. Both the column and row of both cells are absolute and will
not change when copied. Mixed referencing can also be used where only the row or column fixed. For
example, in the formula "=(A$1-+$B2)", the row of cell A1 is fixed and the column of cell B2 is fixed.

Basic Functions

 Functions can be a more efficient way of performing mathematical operations than formulas. For
example, if you wanted to add the values of cells D1 through D10, you would type the formula
"=D1+D2+D3+D4+D5+D6+DT+DE+DI+D10", A shorter way would be to use the SUM function and
simply type "=SUM (D1:D10)". '

Function Wizard #5 _
View all functions available in Excel by using the Function Wizard.

» Activate the cell where the function will be placed and click the Function Wizard button on the
standard toolbar, '

» Fromthe Paste Function dialog box, browse through the functions by clicking in the Function
category menu on the left and select the function from the Function name choices on the right. As
each function name is highlighted a description and example of use is provided below the two
boxes. '

| Paste Functlion

..... e
DATEVALUE

Eer B Tirne
Math & Teig
Statistical
Lookup & Referance
Database
Text




L

1
1

Autosum

|
|
i

L J

Click OK to seleeta function.

* The next window allows you to choose the celis that will be included in the function. In the example
below, cells B4 and C4 were automatically selected for the sum function by Excel. The cell values
{2,3} are located to the right of the Number 1 field where the cell addresses are listed. If another
set of cells, such as BS and CS, needed to be added to the function, those cells would be added in
the format "B5:C5" to the Number 2 field.

Select the cell that the sum will appear in that is outside the cluster of cells whose values will be

£

added. Cell C2 was used in this example. |
Click the Autosum button (Greek letter sigma) on the standard toolbar. -
Highlight the group of cells that will be summed (cells A2 through B2 in this example).

Press thé_ENTER key on the keyboard or click the green check mark button on the formula bar.

~ Click OK when all the cells for the function have been selected.

Use the Autosum {imction to add the contents of a cluster of adjacent cells.

SUM(A2:B2)

an

MS Excel - Useful Shortcut Keys .

Shortcut key Operation

Ctrl+A
CuHB

- CuC

Ctl+D
Ctrl+F

CHHG

Cul+H
Ctrl+
Cual+K

Select All

~Bold

Copy
FillDown

- Find
"~ Goto

Replace
Ttalic
Insert Hyperlink

Result

None _

Format, Cells, Font, Font Style,Bold
Edit, Copy

Edit, Fill, Down

‘Edit, Find
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Edit, Goto

Edit, Replace _
Format, Cells, Font, Font St yle, Italic
Insert, Hyperlink




Ctr+N
CtlH+O

Ctrl+P .

Cl+R
Ctrl+S
Cir+U
Cl+V
Ctr+W
Cr+X
CtrtY
Cul+Z
" Fl
F2
F3
F4
F4

F5
Fé
F7
F8
F9
F10

- Fll

Fi12

Cir+:
Ctrl+;
Cul+"
Ctrl+

Shift

Shift+F1
Shift+F2
Shift+F3
Shift-+F4
Shift+F5
Shift+F6
Shift+F8

Shifi+F9-

New Workbook

Open
Print

Fill Right
Save
Underline
Paste
Close
Cut
Repeat
Undo
Help

" Edit

Paste Name
Repeat last action

File, New

File, Open

File, Print

Edit, Fill Right

File, Save

Format, Cells, Font, Underline, Single
Edit, Paste

File, Close

Edit, Cut

Edit, Repeat

Edit, Undo

Help, Contents and Index
None

Insert, Name, Paste

Edit, Repeat. Works while not in Edit mode.

While typing a formula, switch None

between absolute/relative refs
(oto

Next Pane
Spell check
Extend mode

Recalculate all workbooks
Activate Menubar

New Chart
Save As

Insert Current Time
Insert Current Date
Copy Value from Cell Above
Copy Fromula from

Hold down shift for additional

What's This? Help,

Edit cell comment

Paste function into formula

FindNext

Find

Previous Pane
Add to selection

Calculate active worksheet

Edit, Goto

None

Tools, Spelling

None

Tools, Options, Calculation, Calc, Now
N/A

Insert, Chart

File, Save As

None

None

Edit, Paste Special, Value

Edit, Copy
Cell Above

none
functions in Excel's menu

What's This?

Insert, Edit Comments
1n$ert, Function

Edit, Find, Find Next
Edit, Find, Find Next
None

None

Calc Sheet



Shift+F10 Display shortcut menu None
Shift+F11 New worksheet Insert, Worksheet
Shift+F12 Save File, Save
Cul+F3 Define name Insert, Names, Define
Ctrl+F4 Close File, Close
Ctrl+F5 XL, Restore window size Restofe
Curl+F6 - Next workbook window Window, ...
Shift+Cirl+F6  Previous workbook window Window, ...
Ctrl+F7 Move window XL, Move
Ctrl+1 Format cells dialog box Format, Cells
Ctrl+2 Bold Format, Cells, Font, Font Style, Bold
Ctrl+3 [talic - Format, Cells, Font, Font Style, Italic
Ctrl+4 Underline Format, Cells, Font, Font Style, Underine
Crl+5 Strikethrough Format, Cells, Font, Effects, Strikethrough
Cul+6 Show/Hide objects Tools, Options, View, Objects, Show All/Hide
Ctl+-7 Show/Hide Standard toolbar  View, Toolbars, Stardard
Ctrl+8 Toggle Outline symbols None
Ctrl+9 Hide rows Format, Row, Hide
Cul+0 Hide columns Format, Column, Hide
CirtH-Shifti+(  Unhide rows Format, Row, Unhide
Ctel+Shiftt)  Unhide columns Format, Column, Unhide
AltorF10 Activ:qte the menu None
CtrHTab In toolbar: next toolbar None
Shift+=Ctri+Tab  Intoolbar: previoustoolbar  None
Shift+Ctrl+Tab  Ina workbook: activate None
_ previous workbook
Shift+Tab Previous tool . None !
Shift+Ctrl+F Font Drop Down List Format, Cells, Font -
Shift+Ctrl+F+F  Font tab of Format Cell Dialogbox Format, Cells, Font
Shift+Ctrl+D Point size DropDownList ~ Format, Cells, Font |
Shortcut keys with CTRL combination
Key Description _

- CTRLH Unhides any hidden rows within the selection.
CTRL+) Unhides any hidden columns within the selection.
CTRIL+& Applies the outline border to the selected celis.
CTRL+_ Removes the outline border from the selected cells.,
CTRLA~ Applies the General number format.
CTRL+U Applies orremoves underlining.
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CTRL+V

“CTRL+W
CTRL+X
CIRLAHY
CTRL+Z

CTRLASHIFT+Z

Funetion keys

F1
CTRLAF1
ALT+F1
ALT+SHIFT+F1
F2

SHIFT+F2
F3
SHIFT+F3
F4
CTRLAF4
F5
CTRLAFS
F6

SHIFT+F6
CTRLAF6

F7

CTRLAF7

F8§

5'.:"
Inserts the contents of the Clipboard at the 1 insertion point and replaces

. any selection, Available only after you cut or copied an object, text, or cell

contents.
Closes the selected workbook window.
Cuts the selected cells..

Repeats the last command or actton, if possible.

Usesthe Undo command to reverse the last oommand orto delete the last

entry you typed.

uses the Undo or Redo command to reverse or restore the last automatic
correction when AutoCorrect Smart Tags are displayed.

Displays the Help task pane. - |
closes and reopens the current task pane.
creates achart of the data in the current range.

inserts a new worksheet,

Edits the active cell and positions the insertion point at the end of the cell
contents. It also moves the insertion point into the Formula Bar when
- editing ina cell is turned off.

edits a cell comment.

I_ Pastes a defined name into a formula.

displays the Insert Function dialog box.

Repeats the last command or actibn, if possible.
cloees the selected workbook window,
Displays the Go To dialog box. |

restores the window size of the selected workbook window.

Switches to the next pane in a worksheet that has been split (Window

menu, Split command).
switches to the previous pane in a worksheet that has been split.

switches to the next workbook window when more than one workbook
window is open.

Note: Whenthe task pane is visible, F6 and SHIFT+F6 include that pane when switching between panes.

Displays the Spellmg dialog box to check spellmg in the active worksheet

- orselected range.

performs the Move command on the workbook window when it is not
maximized. Use the arrow keys to move the window, and when finished
press ESC. :

Turns extend mode on or off. In extend mode, EXT appears in the status
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SHIFT+F8
CTRL+FS

ALT+F8

Fo

SHIFT+F9
CTRL+ALT+F9

CTRLAALT+
SHIFT+F9

" CTRL+F9
F10

SHIFT+F10

ALT+SHIFT+F10-

CTRL+F10
F1l
SHIFT+F11
ALT+F11

- ALT+SHIFT+F11

F12

Other useful shortcut keys

line, and the arrow keys extend the selection.

enables you to add a non-adjacent cell or range to a selection of cells by
using the arrow keys.

performs the Size command (on the Control menu for the workbook
window) when a workbook is not maximized.

displays the Macro dialog box to run, edit, or delete a macro.
Calculates all worksheets in ail open workbooks.

followed by ENTER (or followed by CTRL+SHIFT+ENTER for array
formulas) calculates the selected a portion of a formula and replaces the
selected portion with the calculated value. '

calculates the active worksheet.

calculates all worksheets in all open workbooks, regardless of whether

 they have changed since the last calculation.

rechecks depéndent formulas, and fhen caleulates all cells in all open
workbooks, including cells not marked as needing to be calculated.

minimizes a workbook window to an icon.

Selects the menu bar or closes an open menu and submenu at the same

time,

displays the shortcut menu for a selected item.

diSpIays the rhe_nu or message for asmart tag. If more than one smart tag
is present, it switches to the next smart tag and displays its menu or message.
maximizes or restores the selected workbook window. |
Creates a chart of the data in the current range.

inserts a new worksheet.

opens the Visual Basic Editor, in which you can create a macro by using
Visual Basic for Applications (VBA).

opens the Microsoft Script Editor, where you can add text, edit HTML
tags, and modify any seript code. -

Displays the Save As dialog box.

ARROWKEYS Move one cell up, down, left, or right in a worksheet.
CIRL+ARROWKEY - moves to the edge of the current data region (data region:
o ' A range of cells that contains data and that is boumded by
) _ : - empty cells or datasheet borders.) in a worksheet.
SHIFT+ARROW KEY - extends the selection of cefls by one cell.
~ extends the selection of cells to the last nonblank cell in

CTRL+SHIFT+ARROW KEY

the same column or row as the active cell,

LEFTARROW or RIGHTARROW  selects the menu to the left or right when a menu is visible.
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DOWN ARROW or UPARROW

ATLT+DOWN ARROW
BACKSPACE Deletes

DELETE

CTRL+END
CTRLASHIFT+END

ENTER

ALT+ENTER
CTRL+ENTER
SHIFT+ENTER
ESC

'HOME

When a submenu is open, these arrow keys switch
between the main menu and the submenu.

selects the next or previous command when a menu or
submenu is open.
.

In a dialog box, arrow keys move between options in an
open drop-down list, or between options in a group of
options.

opens aselected drop-down list,
one character to the left in the Formula Bar.
Also clears the content of the active cell.

Removes the cell contents {data and formulas) from

selected cells without affecting cell formats or comments.

In cell editing mode, it deletes the oharacter to the right of
the insertion point.

Moves to the cell in the lower-right corner of the window

- when SCROLL LOCK is turned on.

Also selects the last command on the‘me_nu whenamenu
or submenu is visible.

moves tothe lastcellona woi'ksheet, in the lowest used

row of the rightmost used column.

extends the selection of cells to the last used cell on the

~ worksheet (lower-right corner).

.COmpletes a cell entry from the cell or the Formula Bar,

and selects the cell below (by default), _
In a data form, it moves to the first field in the next record.

Opens a selected menu (press F10 to activate the menu
bar) or performs the action for a selected command.

Ina djalog box, it performs the action for the default

© command button in the dialog box (the button with the

bold outline, often the OK button).

starts a new lii_lé in the same cell.

fills the selected cell range with the current entry,
completes a cell entry and selects the cell above.
Cancels an entry in the cell or Formula Bar.

[t also closes an open menu or submenu, dialog box, or

message window.

Moves to the beginning of a rowina W_orksheet.

Moves to the cell in the upper-left comer of the window
when SCROLL LOCK is turned on.
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6.2

CTRL+HOME
CTRLASHIFT+HOME
PAGEDOWN

ALT+PAGE DOWN
CTRL+PAGE DOWN

;

CTRLASHIFT+PAGE DOWN-

PAGE UP

ALTH+PAGE UP

CTRL+PAGE UP
CTRL+SHIFT-+PAGE UP
SPACEBAR

CTRL+SPACEBAR

SHIFT+SPACEBAR

- CTRL+SHIFT+SPACEBAR

ALT+SPACEBAR
TAB

SHIFT+TAB

CTRL+TAB
CTRL+SHIF“T+TAB

 Summary

placed in between.

Selects the first command on the menu when a menu or
submenu is visible,

moves to the beginning of a worksheet.

extends the selection of cells to the beginning of the

| worksheet.

Moves one screen down in a worksheet,

moves one screen to the right in a worksheet.

moves to the next sheet in a workbook.

selects the current and next sh@ét in a workbook.
Moves one screen up in a worksheet.

moves one screen to the left in a worksheet,
moves to the previous sheet ina workbook.

selects the current and previous sheet in a workbook.

Ina dialog box, performs the action for the selected button, '

or selects or clears a check box.
selects an entire column in a worksheet.

selects an entire row in a worksheet.

~ selects the entire worksheet.

If the worksheet contains data,
CTRLASHIFT+SPACEBAR selects the current region.
Pressing CTRLASHIFT+SPACEBAR a second time
selects the entire worksheet.

When an object is selected, CTRL+SHIFT+
SPACEBAR selects all objects on a worksheet, -

displays the Control menu for the Excel window,

Moves one &Il to the right in a worksheet.

Moves between unlocked cells in a protected worksheet.
Moves to the next 6ption or option group in adialog qu.

moves to the previous cell ina worksheet or the previous

- optioninadialogbox.

switches to the next tab in dialog box.

switches to the previous tab in a dialog box.
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6.3

There are three types of referencing relative, fixedand mixed.

Unit End Questions

1. Whatis formula, explain?
2. Whatis finction?

3.

4, Explainfo]lo_wing functions:

Explain various function of MS-Excel.

(a) SUM

(b) MIN

(¢) MAX

(d) COUNT
(¢) AVERAGE




Unit 7: Advanced features of Spreadsheet

Structure of the Unit

7.0
7.1

7.2

7.3

7.4

15
7.6
77

Objectives

Sorting and Filling

7.1.1 ' Basic ascending and descending sorts
712 Complex sorts

7.1.3  Aubofill

7.1.4  Altemating text and numbers with Autofill
7.1.5 Autofilling finctions

Graphics

7.2.1 Addingclip art

7.2.2 Addanimage fromafile

7.2.3 Editinga graphic

7.2.4 AutoShapes

Charts

7.3 Chart Wizard
732 Resizingachart

733 Movingachart

7.3.4  Chart formatting toolbar

7.3.5 Copy a chart to Microsoft Word
Page Properties and Printing

7.4.1 Page breaks

7.42 Page orientation

7.4.3 Margins

7.4.4 Headers, footers, and page numbers
7.4.5 Print Preview

7.4.6 Print

Keyboard Shortcuts

Summary

Unit end Questions
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7.0

Objectives

After completing this unit you will be able to-

7.1
7.1.1

Work on Data sorting and filtering
Work with graphics in MS Excel
Work with charts in MS Excel
Sorting and Filling

Basic ascending and descending Sorts

To execute abasic descending or ascending sort based on one cotumn, highlight the cells that will be
sorted and click the Sort Ascending (A-Z) button or Sort Descending (Z-A) button on the standard
toolbar.

7.1.2

Complex Sorts

To sort by multiple columns, follow these steps:

- SIS,

Highlight the cells, rows, or columns that will be sorted.
Select Data|Sort from the menu bar,

From the Sort dialog box, select the first column for sorting from the Sort By drop-down menu and
choose either ascending or descending, )

Select the second column and, if necessary, the third sort column from the Then By drop-down
.: e TS -

If the cells you highlighted included the text headi:igs in the first row, mark My list has... Header row

nd the first row will remain at the top of the worksheet.,

Click the Options button for special non-alphabetic or numeric sorts such as months of the year
and days of the week. :
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® ClickOKto execute the sort.
) 7 L 3 Autofill

.. TheAutofill feature allows you to quickly fill celis with repetltwe or sequential data such as chronologlcal
| dates or numbers, and repeated text. :

e Typethe begmmng, y number or date of an incrementing series or the text that will be repeated into a
cell.

as many cells as you want to fill.
® Release the mouse button.

~ Ifyouwant to autofill a column with cells displaying the same number or date you must enter identical
‘dataiotwo adjacent cells in a column. Highlight the two cells and drag the handle of the selection with the
mouse

7 1.4 Altematmg Text and Numbers with Autofill

. The Autofill feature can also be used for alternating text or numbers. For example tomakea repeatmg'
st of the days of the week, type the seven days into seven adjacent cells ina oolumn Highlight the seven
wells and drag down with the mouse.

7.1.5 Autofilling Fu_nctlons

Autofill can also be used to copy functions. In the example below, column A and column B each
: gontain lists of numbers and column C contains the sums of columns Aand B for each row. The functionin
cell C2 would be "=SUM(A2:B2)". This function can then be copied to the remaining cells of column C by
activating ¢ell C2 and dragging the handle down to fill in the remaining cells. The autofill feature will
amtomatically update the row numbers as shown below if the cells are references relatively.
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7.2  Graphics
7.2.1 Adding Clip Art |
To add a clip art image to the worksheet, follow these steps:
® Select Insert|Picture|Clip Art from the menu bar.

Hnsert ClipAtt

Mew Catanary

Boxders & Frames Buildings Business - Buttens & loons Cattaong

¢ Tofindanimage, click in the white box following Search for clips. Delete the words "Type one or
more words. . ." and enter keywords describing the image you want to use. '

OR
Click one of the category icons.

& Click once onthe image yéu want to add to the worksheet and the following popup menu will
appear: : ' o '

praview dip
add olip to Tavorites

find similar 2ips

o Insert Clipto add the image to the worksheet.

e Preview Clip to view the image full-size before adding it to the worksheet. Drag the bottom, right
-corner of the preview window to resize the image and click the "x" close button to end the preview.
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722

Highlight the file name from the list and click the Insert button.

el

Add Clip to Favorites will add the selected image to your favorites directory that can be chosen
from the Insert ClipArt dialog box. :

Find Similar Clips will retrieve images similar to the one you have chosen.

Continue selecting images to add to the worksheet and click the Close button in the top, right
corner of the Insert ClipArt window to stop adding clip art to the worksheet. ’

Add An Image from a File | _
Follow these steps to add a photo or graphic from an existing file:

- Select Insert|Picture/From File on the menu bar.

Click the down arrow button on the right of the Look in: window to find the image on your
computer, '

51 pagesetup2.oif
pagesetup3,gif
pagesstup3a, gif

f’ printpreview. off
; save.gif

§ Y’ screengrab,gif
sortd,qif
=0 il

7.2.3 Editing A Graphic

Activate the image you wish to edit by clicking on it once with the mouse. Nine handles will appear

around the graphic. Click and drag these handles to resize the image. The handles on the corners will resize
proportionally while the handles on the straight lines will stretch the image. More picture effects can be
changed using the Picture toolbar. The Picture toolbar should appear when you click on the image. Otherwise,
select View|Toolbars|Picture from the menu barto activate it.
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7.2.4

ldoreiless Lirvet Fogrnat
Imiage Cmimi Brighinass  Siyle Figture

insest  More/Less Crop  Text Rasst
Picture Lontrast Wrapping Pictisre

Insert Picture will display the image selection window and allows you to change the image.
Tmage Control allows to to make the image gray scale, black and white, or a watermark.
More/Less Contrast modifies the contrast between the colors of the image.

More/Less Brightness will darken or brighten the image.

Click Crop and drag the handleé on the activaied image to delete outer portions of the image. |
Line Style will add a variety of borders to the graphic.

Text Wrapping will modify the way the worksheet text wraps around the graphic.

Format Picture displays all the image properties in a separate window.

| Reset Picture will delete all the modifications made to the image.

AutoShapes

The AutoShapes toolbar will allow you to draw a number of geometrical shapes, arrows, flow chart '
elements, stars, and more on the worksheet. Activate the AutoShapes toolbar by selecting
Insert|Picture|AutoShapes or View|Toolbars| AutoShapes from the menu bar. Click the button on the
toolbar to view the options for drawing the shape. : '

Basic Flow Cali
Lines Shapes Chart  Ouls

Conneciors’ Block Stars and  More
Arows Banners

Lines - After clicking the Lines button on the AutoShapes toolbar, draw a straight line, arrow, or

double-ended arrow from the first row of options by clicking the respective button. Click in the
worksheet where you would like the line to begin and click again where it should end. To draw a
curved line or freeform shape, select curved lines from the menu (first and second buttons of
second row), click in the worksheet where the line should appear, and click the mouse every time
a curve should begin. End creating the graphic by clicking on the starting end or pressing the ESC
key. To scribble, click the last button in the second row, click the mouse in the worksheet and hold
down the left button while you draw the design. Let go of the mouse button to stop drawing.

Connectors - Draw these lines to connect flow chart elements.

Basic Shapes - Click the Basic Shapes button on the AutoShapes toolbar to select from manjr
two- and three-dimensional shapes, icons, braces, and brackets. Use the drag-and-drop method
to draw the shape in the worksheet. When the shape has béen made, it can be resized using the
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open box handles and other adjustments specific to each shape can be modified using the yellow

diamond handles,
o u]
Q

¢ Block Arrows - Select Block Arrows to choose from many types of two- and three-dimensional
arrows. Drag-and-drop the arrow in the worksheet and use the open box and yeHow diamond
handles to adjust the arrowheads. Each AutoShape can also be rotated by first clicking the

Free Rotate button on the drawing toolbar . Click and drag the green handles around the image to |

rotate it. The tree image below was created from an arrow rotated 90 degrees., .

® Flow Chart - Choose from thé flow chart menu to add flow chart elements to the worksheet and

use the line menu to draw connections between the elements,

¢ Starsand Banners- Click the button to select stars, bursts, banners, and scrolls.

¢ Call Outs - Select from the speech and thought bubbles, and line call outs, Enter the call out text in

the text box that is made. |
¢ More AutdShapes - Click this button to choose from a list of clip art categories.

Each of the submenus on the AutoShapes toolbar can become a separate toolbar. Just click and
drag the gray bar across the top of the submenus off of the toolbar and it will become a separate floating
toolbar. ' '

7.3 Charts

Charts allow you to present data entered into the worksheet in a visual format using a variety of
graph types. Before you can make a chart you must first enter data into a worksheet. This page explains
how you can create simple charts from the data. . S

731 Chart Wizardij

The Chart Wizard brings you through the process of creating a chart by displaying a series of
~ dialog boxes. :

®  Enterthe datainto the worksheet and highlight all the cells that will be included inthe chart including
~ headers. ' '
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® Click the Chart Wizard button on the standard toolbar to view the first Chart Wizard dialog box.
o Chart Type - Choose the Chart type and the Chart subtype if necessary. Click Next.

e Chart Source Data - Select the data range (if different from the area highlighted in step 1) and click
ST s S -

Henbar of Stedents

m ﬁ v i
Phyeles

Colewhis

-@ Chart Options - Enter the name of the chart and titles for the X~ and Y-axes, Other options for the
axes, grid lines, legend, data labels, and data table can be changed by clicking on the tabs, Press
Next to move to the next set of options. S
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® Chart Location - Click As new sheet if the chart should be placed on a new, blank worksheet or
select As object in if the chart should be embedded in an existing sheet and select the worksheet
from the drop-down menu.’ '

Number of
Students
oN58

73.2 Resizing the Chart

To resize the chart, click on its border and drag any of the nine black handles to change the size.
- Handles on the corners will resize the chart proportionally while handles along the lines will stretch the
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7.3.3 Moving the Chart

Select the border of the chart, hold down the left mouse button, and drag the chart to a new
location. Elements within the chart such as the title and Iabels may also be moved within the chart. Click on
the element to activate it, and use the mouse to drag the element to move it. -

7.3.4 Chart Formatting Toolbar

display dats

by rong or
_ formet  lagend 0O
chartoblects st buion  1ogge 0¥ SolUMn

Shelt  gata tavie angle
type ey text

Chart Objects List - To select an object on the chart to format, click the object on the chart or select the
object from the Chart Objects List and click the Format button. A mndow containing the properties of that
object will then appear to make formatting changes. -

Chart Type - Chck the arrow head on the chart type button to select a different type of chart.
Legend Toggle - Show or hide the chart legend by clicking this toggle button.

Data Table view - Display the data table instead of the chart by clicking the Data Table toggle button.
Display Data by Column or Row - Charts the data by Columns or rows according to the data sheet.

Angle Text - Select the category or value axis and click the Angle Downward or Angle Upwand button to
angle the the selected by +/- 45 degrees.

Cis

b b O}
oD

Number of
Students

—

7.3.5 Copying the Chart to Microsoft Word

_ A finished chart can be copied into a Microsoft Word document. Select the chart and click Copy.
+  Open the destination document in Word and click Paste.
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7.4 Page Properties and Printing
. 7.4.1 Page Breaks

To set page breaks within the worksheet, select the row you want to appear just below the page
break by clicking the row's label. Then choose InsertjPage Break from the menu bar. Youmay need to
click the double down arrow at the bottom of the menu list to view this option.

Page Setup

Select FilefPage Setup from the menu bar to format the page, sef margins, and add headers and
footers.

7.4.2 Page Orientation

Select the Orientation under the Page tab in the Page Setup window to make the page Landscape
or Portrait. The size of the worksheet on the page can also be formatting under Scaling. To force

 aworksheet to print only one page \mde s0 all the columns appear on the same page, select Fit to
1 page(s) wide.

Page Setup "

7.4.3 Margins
Change the top, bottom, left, and right margins under the Margins tab,

Enter values in the header and footer fields to indicate how far from the edge of the page this text

should appear. Check the boxes for centermg honzontally or vertically on the page

Pri(lr f.u-':ul} A
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7.4.4 Header/Footer

Add preset headers and footers to the page by clicking the drop-down menus under the Header/
Footer tab.

To modify apreset header or footer, or to make your own, click the Custom Header and Custom
Footer buttons. A new window will open allowing you to enter text in the left, center, or right on the page.

page mumber  date time lah name

format fext  total number fite name
' ol pages

Format Text : Click this button after highlighting the text to change the font, size, and style.
Page Number : Insert the page number of each page.

Total Numbey of Pages : Use this feature along with the page number to create strings such as "page 1 of
1 5"- A

Date : Add the current date.

Time : Add the curreni time.

File Name : Add the name of the workbook file.
Tab Name : Add the name of the worksheet's tab.

R Page Sciup
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[ Sheet

Check Gridlines if you want the gridlines dividing the cells to be printed on the page. If the worksheet
is several pages long and only the first page includes titles for the columns, select Rows to repeat at
top to choose a title row that will be pnnted at the top of each page.

7.4.5 Print Preview

Select File[Print Preview from the menu bar to view how the worksheet will print. Click the Next
and Previous buttons at the top of the window to display the pages and click the Zoom bution to view the

- pages closer. Make page layout modifications needed by clicking the Page Setup button. Click Close to

return to the worksheet or Print to continue printing.

7.4.6 Print

To print the worksheet, select F 11e|Prmt from the menu bar.

® Print Range - Sclect either all pages or a range of pages to print.

® Print What - Select selection of cells highlighted on the worksheet the active worksheet, or all the
worksheets in the entire workbook.

¢ Copies - Choose the number of copies that should be prmted Check the Collate box if'the pages
- should remain in order,

~ ClickOK to print.'
1.5 | Keyboard Shortcuts

Keyboard shottcuts can save time and the effort of switching from the keyboard to the mouse to
| execute simple commands. Print thls list of Excel keyboard shortcuts and keep it by your computer for a
qwck reference.

- Note: Aplus sign indicates that the keys need to be pressed at the same time.
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{Action ] [Keystroke
' /
R — 7 Dpcumentactions . i
Open a file CTRL+O
New file CTRL+N
Save As [F12
Save CTRL+S
Print CTRL+P
Find CTRL+F
{Replace CTRL+H
|Go to F5

Oné .ééil up

Up ALTOW

One cell down down arrow

One cell right Tab

One cell feft SHIFT+Tab

Top of worksheet (cell A1) CTRL+Home
fﬁ&i‘fiﬁ?ﬁ:ﬁm CTRL+End

End of row Home

|End of column CTRLA+-left arrow
Move to next worksheet CTRL+PageDown

T T

TATi=

Apply Aut?.hSum

Current date CTRL+;

Current time CTRL+!

Spetling F7

jHelp [Fi

[Macros JALT+F8
Iaction [Keystroke

- YAlt cells Yt of current cell

SHIFT+left amow

All cells right of current cell SHIFT+right arrow
Entire column CTRL+Spacebar
[Entire row SHIFT +Spacebar
|Entire worksheet CTRL+A

Bold CTRL+B
Ttalics CTRL+I
Underline CTRL+U
1Strikethrough ICTRL+5

active cell - )

Fdrmat as currency with 2 decimal places SHIFT+CTRL+$
Format as percent with no decimal places. SHIFT+CTRL+%
Cut CTRL+X

Copy [CTRL+C

[Paste lCTRLAY

Undo CTRL+Z

Redo CTRL+Y

JEormat cells dialog box CTRL+1
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7.6

7.7

NS AN

Summary

The AutoShapes toolbar will allow you to draw a number of geometrical shapes', arrows, flow
chart elements, stars, and more on the worksheet.

Charts allow you to present data entered into the worksheet in a visual format using a variety of
graph types. Before you can make a chart you must first enter data into a worksheet, This page
explains how you can create simple charts from the data,

To set page breaks within the worksheet, select the row you want to appear just below the page
break by clicking the row's label. Then choose Insert|Page Break from the menu bar.

Unit end Questions

Write the step for creating MS Excel Charts,

How you will print selected data in Ms Excel?

What do you mean by page break? _

What is page orientation? '

What is pie chart?

Explain sorting in Ms Excel |
Explain various options available at the time of page setup,
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Unit 8: Presentation package

Structure of the Unit

8.0

8.1

3.2

83

8.4

8.6

Objectives

Introduction to MS Power Point _
Getting Started

8.2.1
8.2.2
8.2.3
8.2.4
8.2.5
8.2.6

AutoContent Wizard

Create a presentation from a template
Blank Presentation

Open an existing presentation
AutoLayout |

Views

Working with Slides

8.3.1
8.3.2
8.3.3

834

8.3.5
8.3.6
8.3.7

Insert a new slide

Applying adesign tem]ilate
Changing slide layouts
Reordering slides

Hide slides

Create a-custom_ slide show

Edit a custom slide show

Adding Content

8.4.1
8.4.2

8.43

844
8.4.5
3.4.6
8.4.7

Bulleted lists
Numbered lists
Resizing a text box
Text box properties
Delete a text box
Adding notes
Video and Audio

Summary
Unit End Questions
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8.0  Objectives |
After completing this unit you will be able to - | _
& Define What is Power Point, create Power point Presentation
® types of power presentaion, open,save close presentatioi.
& Screen layout, insert élide, slide layout, hide slide |
e creatfe and edit custom slide show, text add and':'edif etc.
8.1  Introduction to Power Point

Power Point is presentation software that can help you fo quickly create effective ‘siide based’
presentations. The presentation consists of a number of slides. Each slide can have text and graphics. The
program can help you to create the following types of presentations.

1. Black-and-white transparencies for the overhead projector
Colour transparencies for the overhead projector

35mm slides for the slide projector.

Video slide show on the computer screen or network

A self-running slide show at a trade show kiosk.

Printed handouts.

Detailed speaker’s notes

Printed outline of the presentation.

e A R

To help you to quickly create a presentatio_n; itcomes equipped with an AutoContent wizard. This
wizard can help you quickly create an empty presentation with suitable slides for common presentations,
such as selling a product, company meeting, financial overview, project overview, training, re-porting

progress, etc. Then you can fill the slides created by the wizard with suitable text and graphics. Forcreating

other presentations that are not covered by the wizard, PowerPoint comes with a number of sample slides.
* Depending on the type of slide you want to include in the presentation, you can choose an appropriate
slide. For instance, if you need to show the organization chart slide, you can choose the organization chart
slide. Then you can fill details in the slide. Similarly, if you want to show a chart, you can pick up the chart -
slide. PowerPoint helps you to enter and edit details in the slides you choose. It also allows you to easily
format text and other graphics used in shdes and to change the order of the slides or to insert and dclctc _
slides in the presentation.

After you have created the slides that you want to include in your presentation, you can either pririt
the slides or run the slide show on the computer screen. In the slide show, PowerPoint shows the slides on
the computer screen just as you would get on a slide projector. You can advance to the next slide manually
or automatically after a specified time. While showing the presentation on the computer screcn, you can
use an electronic pointer ot pen to highlight any pomt inthe slide, .

8.2 Getting Started

Open Power Point and you will be prompted by a dialog box with four choices. If Power Point 1s
already open or this box does not appear, select File[New from the menu bar.
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8.2.1 AutoContent Wizard

The AutoContent Wizard provides templates and ideas for a variety of presentation types. Page
through the wizard by clicking the Next button on the bottom of each page after making necessary choices.

I

£
“The AutoContent Wizard gets you started by
providing ideas ard an organization for vour
) prasentation,

8.2.2 Design Template

Power Point provides many templates with different backgrounds and text formatting to begin
your presentation. Preview each design by highlighting the template name on the list. Press OK after you
have chosen the design.
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8.2.3 Blank Presentation
Select Blank Presentation to build the presentation from scratch with no preset graphics or formatting,
8.2.4 Open an Existing Presentaiion

Select this option to open a Power Point presentation that already exists. Select the folder the file
is located in from the Look in: drop-down menu and highlight the {ile on the list. Click Open to open the
presentation. ' ' : _ '

LA

8.2.5 AutoLayout

After selecting the presentation type, you will be prompted to choose the layout of the new slide.
These layouts include bulleted lists, graphs, and/or images. Click on each thumbnail image and a description
will be printed in the message box, Highlight the layout you want and click OK.
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8.2.6 Views :
Power Point gives you four screen layouts for constructing your presentation in addition to the

Slide Show. You can select the page view by clicking the buttons just above the formatting toolbar and the
botiom of the page.

Normal vi,
This screen is split into three sections The slide view displays each slide on the
showing the presentation outling on the  scraen and Is helpful for adding images,
left, the slide in the main window, and formatting text, and adding background
nctes at the bottom., styles,

e e 4 i
Jrahan
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butﬂne View

) Slide Sorter View
The presentation outling is displayed on A small image of each slide is displayed X
the majority of the screen with smal in Shde Sorter view. Slides can wasily be !
windows for the slide and notes, This ordered and sorted from this screen. i

view is recommended for editing text.

Click the Slide Show button to view the full-screen slide show.
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8.3  Working with Slides
8.3.1 Inserta New Slide
Follow these stepsto inserta new shdc into the presentation:

o Inthe Outline window, select the slide you want the new slide to appear after by clicking the slide's
number. S '

¢ Select InsertfNew Slide from the menu bar or click the new slide button on the standard toolbar,
e Choose the page layout from the window and press QK.
8.3.2 Applying a Design Template

To add a design template or changing the existing one, selection Format|Design Template from the
menu bar. Select the template and click Apply.

833 Changing Slide Layouts

To change the layout template of the slide select Format|Shde Layout from the menu bar. Select
one of the layout thumbnait images and click Apply.

Jow Slhide

8.34 Reordermg S]ldes '

To reorder a slide in Slide Sorter View, snnply chck on the slide you wish to move and drag it to the
new location. In Normal or Outline View, click the slide icon beside the number of the slide you want to
move and drag the icon to a new location. .

8.3.5 Hide Slides

If you do not want a slide to appear during the slide show, but do not want to delete the slide as it may
be used later, the slide can be hidden by selecting Slide Show|Hide Slide from the menu bar. To add the
slide back to the slide show, select Slide Show{Hide Slide again.

8.3.6 Createa Custom Slide Show

The Custohl Slide Show feature allows you to select the slides you want to display in the slide show if
not all the slides should be used.

® Select Slide Show|Custom Slide Show from the menu bar.
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ustom Ghows

e Click the‘New..._ button in the Custom Shows wirido.
® In the Define Custom Show window, type a name for the slide in the Slide show name field.

D cfine Custim Show

Add slides to the custom show by highlighting them in the Slides in presentation window and
clicking the Add>> button. Those slides will then appear in the Slides in custom show window.

o Toremoveslidesfromthe custom shiow, highlight their names in the Slides in custom show window
and click the Remove button.

e Toreorder slidesin the custom show, highlight the slide that should be moved and click the up and
down arrows to change its order in the show,

® (Click OK when finished.

e (lick the Show button on the Custom Shows wmdow to preview the custom slide show and click

Close to exit.

8.3.7 EditaCustom Slide Show

ven Shows

. Seléct Slide Show{Custom Slide Show from the menu bar,
- & Editthe show byhighlighting the name in the Custom shows box and clicking the Edlt... button.
o Todecletea show highlight the name and click Remove.
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® Create a copy of a show by clicking the Copy button. The copy can then be renamed by clicking
- the Edit... button.

® Click the Show button to preview the custom slide show and click Close to exit.
8.4  Adding Content
8.4.1 Bulleted Lists

Bulleted lists allow you to clearly display the main points of your presentation on slides. The text
boxes on design templates already include bulleted lists. Click the place holder on the slide to begin adding
textand press the ENTER key to return to the next line and add a new bulleted item. To go to the next fine
without adding another bullet, hold down the SHIFT key while pressing ENTER.

Bulleted List from a Text Box

If you are not creating a bulleted list from an existing placeholder on a design template, or if you
_would like to add an additional butleted list, follow these steps to create a new list:

o Inslide view, create a text box by selecting Insert|Text Box from the menu bar.

" ® "Draw"the textbox on the slide by holding down the left mouse button while you move the mouse
until the box is the size you want it.

- ® Choose Format|Bullets and Numbering from the menu bar.

Change the Size of the bullet by changing the percentage in relation to the text.
- ® Choose acolor for the bullet from the Color menn. Cliek More Colors for a larger selection.
® _ Select one of the seven bullet types shown and click OK.

_ | | o OR
' Click the Picture button to view the Picture Bullet window. Select one of the bullets and click OK.
. ~ OR . | '

Click the Character button to select any character from the fonts on the computet, Select asymbol font
" such gs Wingdings or Webdings from the Buliets from drop-downmenu for the best selection of icons.
Click on the eharactets in the grid to see them larger. Click OK when you have chosen the bullet you want
to use.
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Cllck OK on the Bullets and Numben ing window and use the same methods described in the -
"Bulieted Lists on Design T emplates" to enter text mto the bulletﬁd list.

Bullcted Llsts and New Slides from an Outlme

In Normal or Outline view, text can easily be entered in the outline window and new slides are
automatlcally added. Follow the steps below to become familiar with adding slide content in outline view:

——
L]

Next to the Slide 1 icon, type the title of the slide. The text you type beside the slide icons will be
the large-type titles on each slide.

Press ENTER to type the next line. This will automatically create a new slide. To create a bulleted
list for the first slide, press the TAB key on the More Buttons menu accessible by clicking the
"triple arrow" button at the end of the formatting toolbar.

“OR _
Press ALT+SHET+Right Arrow to demote the selection to a bulleted fist item. |
Continue entering text for the bulleted list, pressing ENTER at the end of each line to create anew

Create a multilevel list by executing the demote action again to create a bulleted sublist. Press the
promote button on the More Buttons menu or press ALT+SHIFT-++Left Arrow to return to the

original list.
Create a new slide by executing the promote action until a new slide icon appears.

Continuc creating new slides and bulleted lists by using the demote and promote actions until the
presentation is completed. Use the formatting instructions below to format the lists.

Ifthere is more than one bulleted list on the slide, the lists will be designated by numbers enclosed in
black boxes. The example below shows the slide created from the outline on the left. The bulleted liston
the left side of the slide is labeled list "1" on the outline and the list on the right is labeled list "2". When typing
the outline, begin typing in the new list by pressing CTRL+ENTER. In this example, CTRL+ENTER was
pressed after typing "Access",
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* Power Point . '
« FrontPage
3 7] Getting Started
h -
Numbered List

Follow these steps to create a numbered list:
Create a text box.
With the text box selected, choose Format[Bullets and Numbering from the menu bar.

Click the Numbered tab at the top of the Bullets and Numbering window.

mberi

Change the size of the numbers by changing the percentage in relation to the text.

Choose a color for the numbers from the Color menu. Click More Colors for alarger selection.

- Change the Start at value if the numbers should not begin with 1.

Select one of the the seven list types shown and click OK.
Resizing a Text Box ' |

Select atext box by clicking on it with the mouse. A border with nine handles will appear around

the text box. The four handles on the corners will resize the length and the width of the box at once while

the handles on the sides will resize only in one direction. Click one of the handles and drag it with the
mouse, Release the mouse button when it is the size you want it to be. Move the text box by clicking and
dragging the thick, dotted border with the mouse. '

8.4.4 Text Box Properties _
Change the colors, borders, and backgrounds of 2 text box from the F ormat AutoShape dialog box.
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Activate the textbox by clicking on it and select Format|{Colors and Lines from the menu bar.

¢ Under the Colors and Lines tab, select a Fill color that will fill the background of the text box.
Check the Semitransparent box if you want the slide background to show through the color.

® Select aLine color that will surround the box as well as a Style or Weight for the thickness of the
line and a Dashed property if the line should not be solid.

® Click the Text Box tab.

e Change the Text anchor point to reposifion‘ the text within the text box.
o Set Internal margins to the distance the text should be to the text box edges.
e Click OK to add the changes to the text box.

8.4.5 Delete a Text Box |

To delete a text box from a template, simply click the border ofthe text box and press the DELETE
key on the keyboard.

8.4.6 Adding Notes

From Normal View, notes can be added to the slide. These notes will not be seen on your presentation,
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but they can be printed out on paper along with the slide the notes refer to by selecting Print What Notes
Pages on the Print menu.

8 .4.

85

8.6

-

Video and Audio

To add a video to your presentation select InsertMovies and Sounds]Movie from File or to insert an
animation from Microsoft's gallery choose Insert|Mov1es and Sounds|Movie from Gallery, Select the video
file and click OK.

To add sound to your presentation select Insert{Movies and Sounds|Sound from Gallery or Sound
from File. Select a sound file and click OK.

Summary

Power Point is presentation sofiware that can help you to qulckly create
effective ‘slide based’ presentatlons The presentation consists of a number of slides.

The AutoContent Wizard provides templates and ideas for a vanety of presentation types.

Power Point provides many templates with different backgrounds and text formatting to begin
your presentation. Preview each design by highlighting the template name on the list,

Toreorder aslide in Slide Sorter View, simply click on the slide you wish to move and drag it to the
new location. In Normal or Outline View, click the slide icon beside the number of the slide you
want to move and drag the icon to a new location.

The Custom Slide Show feature allows you to select the slides you want to display in the slide
show if not all the slides should be used.

To add sound to your presentation select InsertMovies and Sounds{Sound from Gal]ery orSound

from File. Select a sound file and click OK.

To add a video to'your presentation select InsertMovies and Sounds|Movie from File or to insert an
animation from Microsoft's gallery choose Inserthowes and Sounds[Movie from Gallery. Select the video
file and click OK.

Wk wn

Unit End Questions
What is Power point? Explain.
What is the use of auto content wizard?

"How you will hide a slide?

How will you change line space in Text?

Write steps for changing properties of text box.
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Unit 9: - Presentation Package Cont.,

Structure of the Upit

9.1 Working with Text
9.1.1 Addingtext
9.1.2 Editing options
9.1.3 | Formatting text
9.1.4 Replace fonts
9.1.5 Linespacing
9.1.6 Change case
9.1.7 Spelling check
9.2 Changing Colors
921 Colorschemes
- 92.2 Backgrounds |
93 * Graphics
- 93.1 Addingclipart o
932 Addingan image from 2 file
9.3.3 Editingagraphic
9.3.4 AutoShapes
93.5 WordArt
9.4  Slide Effects
9.4.1 Action buttons
9.4.2 Slideanimation
9.4.3 - Animation preview
9.4.4 Slidetansitions
945 Slide show options
95  Master Slides
951 Slidemaster
9.5.2 Header and footer
9.5.3 Shidenumbers
9.54 Dateand time
%6  Saving and Printing

9.6.1 Saveasawebpage
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9.6.2 Page setup
9.6.3 Print
9.7  Keyboard shortcuts Tips
9.7.1 Designtips
9.7.2 Presentation basics
9.8  Summary
9.9 ) Unit end Questions

9.1  Working with Text
9.1.1 Adding Text

If the slide layout includes text boxes, simply click on the text box to add text. To add a text box to the
slide, select Insert]Text Box from the menu bar and draw the text box with the mouse. Set text editing
options by selecting Tools|Options from the menu bar and clicking the Edit tab.

9.1.2 Formatting Text

Select the text that will be formatted by hlghllghtmg the text either on the outline or on the slide. Choose
Format|Font from the menu bar or right-click on the highlighted selection and select Font from the popup
shortcut menu or. Select a font face, size, style, effect, and color from the Font dialog box. Click the
Preview button to see how the changes will appear on the slide before making a decision.

9.1.3 Replace Fonts

Design templates have a preset font that you may want to change or you may want to change the font
used on for the entire presentation for a number of reasons. This can be accomplished quickly using the
Replace Fonts feature. Select Format|Replace Font from the menu bar. Choose the font you want to

Replace from the first drop-down menu and the font it should be replaced With from the second menu, and
click the Replace button.

[156]




[Heplace Font

9.1.4 Line Spacing

Change the amount of space between lines in a text box by selecting Format|L1ne Spacing from the
menu bar.

e Line spacing - Select the amount of vertical space between lines. A value of "1" is equal to single
spacing and "2" is double spacing. Values between and above these numbers are valid as well.

e Before paragraph and Afier paragraph - This value will determine the amourit of vertical space
before and after each paragraph in 4 text box.

9,1.5 Change Case

Change the case of the charactersina paragraph by selectmg Fonnathhange Case from the menu bar -
without having to retype the text.

‘Sentence case - Capitalizes the first letter of the first word in each sentence.
e Lowercase and Uppercase - Changes thc case of all the letters. | _
e Title case - - Capitalizes the first letter of every word and reduces the rest to 1owercase.

e Toggle case - The opposite of Title case, it makes the first lettcr of every word lowercase and
capitalizes the remaining letiers.

9.1.6 Spell Check | |

Correct the spelling in the presentation by selechngToolslSpellmg from the menu bar or by pressing |
the F7 key on the keyboard.

s
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9.1.7

Spelling Options

The spell checker will prompt yf)u to make corrections of the first word that is spelled wrong.
If the word is spelled correctly, click Ignore or Ignore All if the same word appears several times

during the presentation, If this word will appear in many presentations (such as your name), click
Add to add the word to the dictionary and you won't be prompted by a misspelling again.

hIfthe word is spelled wrong, highlight one of the the Suggestions or type your own revision in the
Change to box. Click Change to correct this occurrence of the word or Change All to correct all
oceurrences of the word in the presentation.

Click Close to abort the sp’iélling check early.

When the spell checker has read through the entire presentation, you will be prompted by a window
telling you that the spelhng check is completc Click OK.

Select Tobls|0ptions' from the menu bar and click the Spelling and Style tab.

Check spelling as you type - If this box is checked, Power Point will check the spellmg of every
word as you type Misspelled words wiil be underlined with wavy red lines.

Hide spelling errors in this document - Check this box to remove the wavy red lines from words
that are spelled wrong,

Always suggest corrections - If this box is checked, suggestions for misspelled words will appear
when you activate the spe]l checker,

Ignore words in UPPERCASE - Power Point recommends thal you don't type slide titles in all
uppercase letters so it will treat words Jike this and other all-uppercase acronyms as misspelled.
Check this box to ignore this suggestion and acronyms that are typically typed in all caps.

[gnore words with numbers - Check to ignore words that are combinations of letters and numbers.
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9.2 Changing Colors

The colors of predesigned slide templates can be changed and a color scheme can be added to
blank presentations. This page explains how to add color schemes and background images to slides.

9.2.1 Color Schemes
® Select Format|Slide Color Scheme from the menu bar.

® Click one of the preset color scheme thumbnail images in the Color schemes box,

| e Click the Preview button to see how the scheme will appear on the slide.

¢ To make changes to the color scheme, click the Custom tab on the dialog box.

® Change the colors of the slide elements by sélecting the color swatch beside the name of the
- elementand clicking the Change color button, _ S

~ e Highlight one of the colors from the Text and Line Color window or select the Custom tab to view
- more ¢olor choices and click OK when finished.
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e When ydu have finished all color formatting, click Apply to All to apply the color scheme to all the
slides in the presentation or Apply to add the scheme only to the current slide.

9.2.2 Backgrounds . o
Follow these steps to add background colors and patterns to a slide: -
¢ Select Format|Background from the menu bar. |

Titla of Skida
+ Bulket bext

¢ Select a color from the drop-down menu below the Background fill preview or choose More
- Colors... for a larger selection, ' '

e Select Fill Eftects from the drop-down menu to add gradients, texture, pafterns, or épiculre tothe
background.
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e Gradient ¢ab

(1) Select One color if the color chosen will fade into the background and select the color from the
Color 1 drop-down menu, Choose Two colors if the gradient will use two colors and select
those colots from the Color 1 and Color 2 drop-down menus. Preset provides a selection of
color combinations. Select one from the Preset colors drop-down menu.

(2) Selectthe type of gradient from Shading styles.
(3) Click one ofthe four Vartants of the styles chosen.

SFill Effects © .. -

& Texture tab

From the Texture window, select arepeating background by scrolling through the thumbnall unages
or click Other Texture... to select an image from a file.

*attern tab

" Select a two-tone pattern by chckmg one of the pattern swatches and selecting the Foreground
nd Background colors.
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& Picturetab

(1) Click the Select Picture button to choose a picture from a file. After the picture is selected, a
preview and description will be shown in this window, ' -

(2) Click OK to apply the changes made from the Fill Effects windc WIS,

(3) Click Apply to Alt to add the changes to every slide or apply to make changes only to the current
slide. '

9.3 Graphies

The Drawing Toolbar provides many co_mrhands for creating and ed iting graphics. The toolbar is
located at the bottom of the Power Point screen orit can be activate d by sele cting View[Toolbars|Drawing
from the menu bar.

fross
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‘@ Grouping - Images can be grouped together so they ; become one image and can be moved together
or the same formatting changes can be applied tc both at once. Select all the images that will be

grouped by holding down the SHIFT key and ¢ fj cking once on each image. Then select Group-

from the Draw menu. The images can be ungre,u ped by selecting Ungroup from the same menu,

The rectangles in the image to the left are sepa-rarie images with their own sets of handles and they
-~ are grouped together in the image to the right ; ' : '
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@ Qrder - The order of overlapping images can be changed using this feature, In the example of two
rectangles below, the green rectangle is selected and the Send Backward command was used to
move the image below the blue rectangle. Send Backward and Bring Forward will move elements
by one layer. Send to Back and Bring to Front move the elements to the back or top of a series of

 several overlapping graphics. -

% Nudge - Use the nudge actions to move an object slightly in one direction.

- Align or Distribute - Select a group of objects and choose one of the the commands from the Align
or Distribute menu to change the position of the objects in relation to one another.

“" Rotate or Flip - Rotate an object 90 degrees or lip the object over its x- or y-exis. -
@ Select objects - Deactivate all drawing functions.

- @ Freerotate - This button will place green handles on certain objects 50 they can be arbitrarily
rotated. Click and drag the handles to rotate the objects,

@ AutoShapes menu - Click the small down arrow to the right of the ”AuteShapes" textto select a
shape. [more...] '

@ Line and Arrow - Click and drag the mouse on the slide to add lines. Hold down the SHIFT key
to draw a straight line. Use the end points of the completed line to stretch and reposition the line.

" Rectangle and Oval - Click and drag the mouse on the slide to add rectangles and ovals, Hold
down the SHIFT key to add squares and circles, ' :

% Text box - Click to draw a text box on the slide,
@ Word art - Click to add Word Art. [More]
@ Picture - Click to add a clip art image to the slide.
@ Fill color - Choose a fill color for rectangles, ovals, and clip art.
@~ Line color - Select a border color for shapes and pictures,

% Fontcolor- Highlight text on the slide and click the small down arrow nex.t to the Font color icon
to select a color,

@ Line style - Highlight a line or arrow that has been drawn and click this button to select a thickness
or style for the line, ' ' o __

- @ Dash style - Highlight a line or arrow and select a dash style. _
@ Arrow style - Cha_nge the arrow head style for an existing arrow or change a line to an arrow,

s Shadow - Select a text box to add shadow to text or choose any other objerct on the slide to add
a drop shadow. :
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& 3D - Add a three-dimensional effect to text and other objects.
9.3.1 AddingClipArt ' |
To add aclip aﬂ-image to a slide, follow these steps:
e SelectInsertiPicture|Clip Art from the menu bar or click the Picture bution on the Drawing toolbar..

Pt Thipta)

e Tofindanimage, clxck in the white box fo]lowmg Search for clips and enter keywords descnbmg_
. thei 1mage you want to find.

_ OR
®. Click one of the category icons.
® Click once on the itage to want to add to the slide and a selection bar will appear.

‘e Click once on the image you want to add to the slide and the following popup menu will appear:

@ Insert Clipto add the image to the slide,

Preview Clip to view the image full-size before addmg it to the slide, Drag the bottom, nght corner of
the preview window to resize the image and click the "x" close button to end the preview. '

e AddClipto Favontes will add the selected i image to your favontes dmectory that can be chosen
from the Insert ClipArt dialog box. .

e Find Similar Clips will retrieve images snmnlar to the one you have chosen. -

e Click the Close button in the top, nght corner of the Insert Chp window to stop addmg cl:p artto
" the slide.
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9.3.2 AddingAnImage from a File
To add a photo or graphic from a file:
® Select Insert|Picture|From File from the menu bar.

e Click the down arrow button on the right side of the Look in: window to find the image on your
computer.

® Highlight the file name from the list and click the Insert button.

9.3.3  Editing A Graphic

Activate the image you wish to edit by clicking on it once with the mouse. Several handles will
appear around the graphic. Click and drag these handles to resize the image. The handles on the corners
will resize proportionally while the handles on the straight lines will stretch the image. More picture effects
- can be changed using the Picture toolbar. = ' - _

934 Auto Shapes

The AutoShapes toolbar allows you'to draw a number of geometrical shapes, arrows, flow chart
_elements, stars, and other graphics on a slide. Activate the AutoShapes toolbar by selecting
- Insert{Picture|AutoShapes or View|Toolbars|AutoShapes from the menu bar. Click the buttons on the

toolbar to view the options for drawing each shape, '

Sorevion Dok Grestes Mo
At Bty

e Lines - After clicking the Lines button on the AutoShapes toolbar, draw a straight line, artow, or
double-ended arrow from the fitst row of options by clicking the respective button. Click in the
slide where you would like the line to begin and click again where it should end. To draw a curved
line or freeform shape, select curved lines from the menu (first and second buttons of second row),
click in the slide where the line should appear, and click the mouse every time a curve should begin.
To scribble, click the last button in the second row, click the mouse in the slide and hold down the
left button while you draw the design. Let go offthe mouse button to stop drawing,

e Connectors - Draw these lines to connect flow chart elements.

® DBasic Shapes - Click the Basic Shapes Button on the AutoShapes toolbar to select from many
two- and three-dimensional shapes, icons, braces, and brackets. Use the drag-and-drop method
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-to draw the shape in the slide. When the shape has been made, it can be resized.

Open box handles and other adjustments specific to each shapecan \be modified using the ye]low
diamond handles

f{:?

Block Arrows - Select Block Arrows to choose from many types of two- and three-dimensional
arrows. Drag-and-drop the arrow in the slide and use the open box and yellow diamond handles
to adjust the arrowheads. Each AutoShape can also be rotated by first clicking the Free Rotate
button on the drawing toolbar . Click and drag the green handles around the image to rotate it. The
tree image below was created from an arrow rotated 90 degrees.

* Flow Chart - Choose from the flow chart menu to add flow chart elements to the slide and use ths

line ment to draw connections between the elements
Stars and Banners - Click the button to select stars, bursts banners, and scrolls

Call Outs- Select from the speech and thought bubbles, and hne call outs. Enter the call out textin
the text box that is made.

More AutoShapes - Click the More button to choose from a list of clip art categories.

Each of the submenus on the AutoShapes toolbar can become a separate toolbar. Just click and

drag the gray bar across the topof the submenus off of the toolbar and it will become a separate ﬂoatmg
toolbar ' '

9.3.5

WordArt
Add headlines in striking colors and shapes to your presentation using Word Art,

- Select Insert|Picture] WordArt from the menu bar or chck the Word Art button on the Drawing

toolbar,

Choose a Word Art style from the listihg'and click OK.
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¢ Enter the text in the Edit WordArt Text box and choose the font, size, and style for the text. Click

94
9.4.1

‘@ Select an action for the button by choosing a Hyperlmk to dcstmatlcn.

If you want a sound to be played when the button is chcked check the Play sound box and ohoosc a

OK.

Use the white box handles around the word artto resize it on the slide.

Drag the yellow diamond handle to change the shape of the text. To revert back to no shape,

double-click the diamond,

Slide Effects

Action Buttons o L -

Use the action button toolbar to adci ﬁmctioﬁjng buttonc to. slides in a presentation, . |

Select Slide Show|Action Buttons from the menu bar. Click the bar across the top of the button '

menu and drag it off the menu so it becomes a floating toolbar.

Click one of the button faces and draw the button on the slide using the mouse. The action settings .

menu will then appear.

Set the actions under either the Mouse Click or Mouse Over tabs. Actions speclﬁed for Mousc.
Click will execute when the button is clicked on the slide while actions for Mouse Over wﬂl oceur '
when the mouse pointer hovers over the button.

sound from the drop-downmenu. -
e (Click OK when finished.
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94.2

The button on the slide can bé resized using the whrte box handles and the depth of the button can
be changed by dragging the yellow diamond.

-Slide Animation

Several animations for slide objects are available through the drop-down menus on the menu bar.

First, select the text box or graphic that will be animated. Select Slide Show|Preset Animation and choose
from one of the options. To select a different animation or turn the animation off, select the appropriate
choice from the same menu. For more options, follow the procedure below: - -

Select Slide Show|Custom Animation from the menu bar. |
Select the object on the slide that will be animated from the Check to animate slide objects list.

Under the Effects tab, select the animation type (or select "No Effect” to turn an animation off) and
direction from the drop-down menus and select a sound if you wish. '

Select an After animation effect if the text should change colors after the animation executes.

Color palette - Select one of the color swatches or click More Colors for a larger selection, The

text will change to the selected color when the mouse is clicked during the slide show.

Don't Dim - This option eras'les all After Animation effects.
Hide After Animation - Text will be immediately erased afier the animation is completed.
Hide on Next Mouse click - Th_e'text will be erased when the mouse is clicked.

Choose the style of displaying the text under the Introduce text section. The drop-down menu

provxdcs options for displaying the characters for each bulleted item. Select "All at once” for the
“text fo appear immediately, "by Word" for the text to appear one word at a time, or "by Letter" for :

atypewriter effect that displays one letter at a time.
Click the Order & Timing tab to alter the order that the objects appear on the slide. Highlight the

. object inthe Animation order box and click the Move arrows to move the object's position within

the animation sequence. Under Start animation, choose "On mouse click" to activate the animation
by clicking the mouse or "Automatically” for the animation to execute after a set number of seconds.

[168]




® . Click the Preview button at any time to preview the animation on the slide and click OK when
finished. - |

9.4.3 Animation Preview

Select Slide ShowlAnimation Preview from the menu bar to view the Animation Preview window,
Click anywhere within this window with the mouse to preview the animations that have been set. To hide
the window, click the x ¢lose button in the top, right corner.

9.4.4 Slide Transitions
Add transition effects when changing slides by following these steps:

Select Slide Show|STide Transition from the menu b

@ From the effect section, choose a transition from the drop-down menu and notice the preview after
the transition is selected. Select a speed for the transition as well. _

Under Advance, check "On mouse click” for the slide transition to occur by clicking the mouse or

using keystrokes or check "Automatically after" and a number of second$ if the transition should
occur automafically. : S

® Selecta Sound if neéqssaly and check the Loop until pext sound it it should keep repeating untit the
next sound is played ' _ .

. Click}\pply to Allif the transition effects should be added to every slide or Apply if'the effects
should be added only to the current slide.
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9.4,5 Slide Show Options

Select Tools|Options and click the \_ﬁew_ tab to choose from several more slide show options.

L]

. Popup menu on right mouse click - Check this box if you want to be able to access the shortcut
.~ - menu duringa presentation.

- @ ‘Show popup menu button - Check thisbox to activate the menu button that appears inthe bottom, '
- left comerof the screen during a presentanon. _

- & End with_block slide - Insert a blank, black stide to the end of the presentation.
9.5 - Master Slides |
9.5.1 Slide Master

| | Change the style of all slides in the presentation by changing the properties on the Slide Master.
Each Design Template has its own Slide Master that can be altered. If you create slides from scratch, a
consistent style can be added to the presentation by formatting the Slide Master,

e Select View|Master|Slide Master from the menu bar.

Click to edlt Ma&tf:r title style
i Chck to edrt Adaster texL styios
~ Second level -
> Possth levsi .
i Faith lmeel

ﬂhiaﬂﬁ“&maw

s g, .a,

I ( § 2
| IO mm, ST — mm LU mm; I:

o Format the master slide just as you would formata Iegular slide by formattmg text, formatting hsts,
addmg background patterns and effects and settmg footers.
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® Click the Close button on the Master toolbar to quit editing the master slide and return to the
presentation.

9.5.2 Headers and Footers

Add the date and time, slide numbers, and other footer text to the master slide from the Header and
Footer window, '

Select View|Header and Footet... from the menu bar,

Giinr and Saaber

¢ Check the Date and time box to add this feature to the slide. Seiecl Update automatically to
always display the current date and time or click Fixed and enter a date that will not change in the
text field provided.

® Check the Slide number box to add this featu;:e to the slides.
® Click theF ooter box and add other text to the footer area of the slide.
® Check the Don't show on title slide box to in'cle these features on the title slide of the presentation,
® Click the Notes and Handouts tab to make the same changes to notes and handouts pages.
. Click-AppIy to All to add the changes to every slide or Apply to add oﬁly to the current slide.
9.5.3 Slide Numbers

To add the slide numbers in a fixed position on the slide, use the Header and Footer window
detailed above. The slide number can otherwise be added anywhere on the slide by placing the cursor
where the slide number should appear and selecting Insert/Slide Number from the menu bar, The text of the
slide number can the formatting just as regular text style is changed. .

9.5.4 Dateand Time

_ A date and/or time can also be added using the Header and Footer window or anywhere else on
the slide. Place the cursor where the date and time should appear on the slide and select Insert[Date and
Time from the menu bar. Select a format from the Available formats box and click Update automatically if
this feature should always be updated to reflect the current date and time. Click OK to finish.
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9.6

9.6.1

9.6.2

%.6.3

SAVING AND PRINTING
Save as Web Page

Presentations can be saverd by selecting File{Save from the menu bar. However, if you want to post
Power Point presentatioras on the Internet, you may want to save them as web pages so students
and other visitors to your web site can view the presentation even if they do not have Power Point
installed on their compraters. Select FilejSave As Web Page from the menu bar. Choose your web
page directory on the network from the Look in: drop-down menu and name the file in the File
name: box, Click Save to save the presentation in web format.

Page Setup

Select File|Page Setuip from the menu bar to access options for printing the presentation slides.
Select the format the printed slides will be used for from the Slides sized for drop-down menu or
enter a specific prin t size using the Width and Height boxes. Select the page orientation for the
slides and for otherprint material from the presentation in the Orientation section,

Print

Select File[Print from the menu bar to print the presentation.

£

k)
o
g
B
%
£

e Printrange - Select All to print all the slides in the presentation, Current slide to print only the

current slide, or enter slide numbers in the Slides field to print only certain slides,

o Copies- Enter the number of coples of each shde spec1ﬁed in Print range and check the Collate

box if necessary.

>vint What

. Siides prints a full-page slide on each.page.

e Handouts prints as many slides as you designate on each page.
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e Notes Page prints one slide with that slide's notes on each page
® Outline view prints the oufﬁne of the presentation
® Click OK to print.

9.7 Keyboard Shortcuts

Keyboard shortcuts can save time and the effort of switching from the keyboard to the mouse to
execute siimple commands. Print this list of Power Point keyboard shortcuts and keep it by your computer
for a quick reference. :

Note: A plus sign indicates that the keys need to be pressed at the same time.

lAction IKeystroke | faction [Keystroke |
_Bdcument attion i FOrmatting .
Open a presentation Select all CTRL+A
New presentation CTRL+N Copy CTRL+-C
- {Save As Fi2 Cut CTRL+X
Save CTRL+5 Paste CTRL+V
Print CTRL+P Undo CTRL+Z
JHelp fF1_ - Redo CTRL+Y
- [Bold CTRL+B
2 O Precenta iction A [Italics CTRL+1
Begin slide show F5 . Underline CTRL+U
' ENTER or Left justified CTRL+L
Next slide. ﬁf"“’" oW | [Center justified CTRU+E
Biz:KSPACE Right justified CTRL+R
|Previous slide or Promote list item EALT+SHIFT+ Left
Up arrow key arrow
Activate pen tool CTRL+P Demote list item ALT+SHIFT+Right
arrow or TAB
jErase pen strokes E
Deactivate pen tool CTRL+A gy T " -
Show/HFde black screen B Find CTRLH—;
Show/Hide wh.ite sCreen |W Replace CTRLER
[E::&‘:é Hide pointer & A Insert hyperlink JCTRL+K
{End slide show ESC New slide [CTRL+14
: \ Speil checker lF7
"~ |Macros JaLT+Fs8

. ;

" Runtheslide showand pressthe F1 key

slide show. -

9.7.1 Design Tips

to viév_v all keyboard shorteuts applicable when running a

® Use contrasting colors for the text and the background so the text will be easy to read,

® Use font size large enough to be seen from the

held. A font size of 24-point or larger is recommended.

® Use short phrases and sentences to Convey your message.

o Use simple slide transitions, Too man

subject of the presentation.

-®  Avoid clutfering the slides with too much text or
have to say and not be distracted by a busy screen.
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9.7.2

9.8

Keep text simple and easy to read by not using many different text effects such as bold, italics,
underlining, larger font size for emphasis within a sentence, or a different font all on the same slide.

Presentation Basics
Begin the slide show by clicking the Slide Show buttonon the bottom of the screen.

Move to the next slide by pressing the SPACE BAR, ENTER, PAGE DOWN, or right arrow
keys or by clicking the left mouse button.

Go back to the previous slide by pressing BACKSPACE, PAGE UP, ot the left arrow key.
To end the slideshow before it is complete press ESC on the keyboard.

A opentool is available for drawing on the screen with the mouse. Press CTRL+P orclick the
right mouse button af any time and a popup window will appear. Choose Pen and the pointer will
change to a pen that allows you to draw frechand on the screen using the mouse. Press the Ekey
to erase all pen strokes. Press CTRLA+A to disable the pen feature and revert the pen back io a
pointer arrow, '

If you would like to use the pen to draw ona blank screen during a presentation, pressthe B or W
keys, or select Screen/Black Screen from the popup menu and the screen will turn black. Press B
or W again or choose Next from the popup menu to return o the presentation when you are
fimshed drawing. '

" To hide the pointer and button from the screen press the A key.

Be sure to preview the slide show using a projector if one will be used during the presentation. -
Words or graphics that are close to the edge of the screen may be cut off by the projector.

] Spell Check Correct the spelling in he presentation by selecting ToolsSpelling from the menu bar
or by pressing the F7 key on the keyboard. - o '

The colors of predesigned slide templates can be changed and a 60101' schéme can be added to
blank presentations. ' : _

The Drawing Toolbar pfovides many commands for creating and editing gtaphics. The toolbar is
located at the bottom of the Power Point screen or it can be activated by selecting
View{Toolbars|Drawing from the menu bar.

elements, stars, and other graphics on a slide.

" The AutoShapes toolbar allows you to draw anumber of geometrical shapes, arrows, flow chart

Date and/or time can also be added using the Header and Footer window or anywhere else on the
slide. Place the cursor where the date and time should appear on the slide-and select Insert[Date
and Time from the menu bar. '

~ A opentool is available for drawing on the screen with the mouse. Press CTRLAP or click the

right mouse button at any time and a popup window will appear. Choose Pen and the pointer will
change to a pen that allows you to draw freehand on the screen using the mouse. Press the E key

" to erase all pen strokes. Press CTRL+A to disable the pen feature and revert the pen back to 2

pointer arrow.
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9.9

LA

Unit end Questions

What is master slide?

Whatis color scheme?

What do youmean by auto shape?

How you will check spelling in your presentation?

What is auto shape tools?

- What is slide sorting view why is use usefull?
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Unit : 10 Microsoft Office Qutlook

Structure of the Unit

10.0
10.1

10.2
10.3

10.4

10.5

4

Objectives
Introduction
10.1.1 Getting Help
Exploring the Microsoft Outlook
Different Features & Views in Outlook
10.3.1 The Outlook Window
10.3.2 Drop-Down Menus
10.3.3 Navigation Pane
10.3.4 Folder Pane
10.3.5 Reading Pane
10.3.6 Toolbars
10.3.7 Outlook Today
Calendars in Outlook
10.4.1 Calendar Views
10.4.2 Understanding Calendar ftems
10.4.2.1 Appointment
10.4.2.2 Meeting
10.4.2.3 Event o
10.4.3 Scheduling Calendér Items ' !
10.4.3.1 Schedule an Appointment
10.4.3.2 Schedule a Recurring A ppointment
10.43.3 Schedule a Meeting |
10.4.3.4 Schedule an Event

' 10.4.4 Editing Calendar ftems

10.4.5 Deleting Calendar Items
10.4.6 Adding Holidays
Contacts in Outlook

10.5.1 Conta(;,ts Views

10.5.2 Creation of a Contact

10.5.2.1 Create a Contanct with Information
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10.5.2.2 Create a Contanct by Opening e-mail address
10.5.2.3 Create a Contanct from the Same company
1.0.5.2.4 Create a Distribution List |
10.5.3 Deleting a Contact
10.5.4 Howto Add a Picture to a Contact
106 Using Tasks '
10.6.1 Task Views
10.6.2 Creating Tasks
10.7  Using Notes
10.7.1 Creating a Note
10.7.2 Deleting aNote
10.8  Summary
10.9  Glossary
1 0; 10 Further Readings
10.11  Answersto Self Learning Exercises
10.12  Unit End Questions

10.0 Objectives
| | After reading this unit you will be able to understand :
e - Configuring Microsoft Outlook
| ¢ Diflerent views & features in Outlook
o The uses of Calendars in Outlook
¢ Scheduling an Appointment, Meeting & Event
o Creation and deletion of Contacts
e The working of Tasks in Qutlook
¢ Creation and Deletion of Notes
10.1 Introduction

Inthis unit, we will discuss a number of the basic procedures used in creating, editing, sending and
receiving Outlook mail messages. In addition to it, we will also introduce other features essential to managing
Outlook mail messages. _

Microsoft Office Outlook is adesktop information management program that helps you manage e-
mail, appointments, contacts and tasks, as well as track-activities, open and view documents and share
information, | ' :

Microsoft Qutlook has many more features than are mentioned in this chapter. The best way to
learn and discover these features is to experiment and search the online Help file. When you hold the
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mouse pointer over ah icon, a brief description of the icon appears. The same will occur on Outlook Web
Access, if you are using a relatively recent version of MSIE or Netscape. '

The first thing you will notice here that if you have worked with previous versions of Qutlook; is the
new, more colorful look. It incorporates several features designed to make Outlook easier to use such as
the Navigation Pane. This feature replaces the Outlook Bar from earlier versions of Outlook and provides
centralized navigation, For a full list of changes from Outlook 2000 to Outlook 2003, press <F1>and
type “What is new in Outlook 2003” in the search box, :

10.1.1 Getting Help
Ifyou face some problems using Microsoft Outlook 2003, you can get help from several online
sources such as:;
e OfficeAssistant
¢ HelpContents and Index
o Microsoft Web Site -
- Office Assistant

When you need to ask a question, you can ask the Office Assistant. You can also set the Office
Assistant to automatically provide tips and help while you work. The Office Assistant works with all the
Office Programs, and can be customised to meet your work style. o

When you load Outiook first time, you imay see the Office Assistant (A paper clip or assistant you -
choose) may appear. _

You can click-on the various choices to view the material, or if you do not want to view the
material now, you can click the RIGHT Mouse button on the Assistant and then click on Hide and the

Assistant will be disappeared. - |
"What wordd you ke to ds?
o Mot symbsels n Micraselt
o Crastanew Kens Fom
diffavant types of tams
W Movenimssages
- Btandeed viows

Oy MEssages
W Sea moe,,

Ifyou want to use the Office Assistant for help at anytime, you can click-on Help in the Menu Bar
and then click-on Showthe Office Assistant, which is displayed asina figure below:

Micrasoft Office Dutlook Help F1
Bl showthe gfice fssisiant

[178]




Help Contents and Index

The Office Assistant searches tﬁe Help Contents and Index of Microsoft Office Qutiook. If you
would like to look for mformatlon without using the Office Assistant, you musttum offthe Office Assistant
using following steps :

1. Make sure the Office Assistant is appearing on the screen. If it is not there, click on Help, and then
click on Show the Office Assistant.

2. Click the Office Assistant. Then a help dialog box appears:
3. Click the Options button. Then the Office Assistant options appeat.

4. Unmark the option to Use the Office Assistant and then click on OK button. Then the Ofﬁce
" Assistant will be disappeared. .

Now when you want to look for a general topic or browse through Help’s table of contents, you
can use Help Contents and Index. To access Help Contents and Index click the Help pull down menu and
click Microsoft Outlook Help.

Microsofi Web Site

Microsoft maintains a section of their web site for Outlook users. The web pages contain tips,
tools, patches, and articles. You can obtain help to access the Microsoft Outlook web site ;

hitp://support.microsoft.com
Note: Left mouse button

In this unit, whenever we indicate that you need to click a mouse button, it means to click the left
mouse button - unless we indicate that you should click the right mouse button. So, always move the
cursor over the ‘place’ we indicate and ‘click left’ unless we tell you otherw1se

102 EXPLORING Microsoft OUTLOOK
Launching Microsoft Outlook:
1. Click on the Start button.
Click on Programs.
Click on I\/ﬁcrésoft Office.
Click on Microsoft Office Outlook, OR

sl S

You can also double-click on the Micbsoﬂ Office Outlook icon on the Windows desktop.

103  Different Featares & Views in Outlook:
© 10.3.1 The Outlook Windew "

- Microsoft Outlook consists of several different user interfaces that you interact with to perform

‘various tasks. You can work with the program’s default settings or you can customize them to better suit

your own needs. The Outlook environment is the screens and layout use to work. You can work with the
Outlook default environment or customise it to suit your needs.
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All sections of Outlook contain a standard toolbar, located beneath the title bar. This toolbar
contains most of your basic functions, and can be customized to contain any button combinations you
setup. When you start Outlook, a screen similar to the following will be appeared, which isshown ina

figure below:

10.3.2 Drop-down Menus

Outlook offers drop-down menus that help you perfonn tasks. Outlook keeps track of which
drop-down menu items you use and how often youuse them. The most commonly used drop-dowih menu
itemns are listed in the initial view of that menu, If youdo notuse a command for an extended time, it will be

removed from that particular menu (but can be accessed via small arrows at the bottom of the drop-down
menu). ' '

10.3.2.1 Drop-Down Menu Arrows

Arrows are used to indicate that there are more options than currently displayed. To view items
missing from a drop-down menu, click the arrow or simply hold the cursor over the arrow for a few

seconds and the menu will automatically expand to show all of the commands available:

i

| New Mo Message  Ctken
| New Mail Message Usng &

| New Mall Mossage  CrieN
| MewMall Message lising  »

Follow Up . _ » - Follow Up oy
2unk E-meld - * Jank ﬁ-‘mall T
" Rebly CtrR

Reply b Ctri+Shift+R
 HE
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10.3.3 Navigation Pane

The new Navigation Pane in Microsoft Outlook allows you easy access to your Mail, Calendar,

- Contacts, Tasks, Notes, Folder List and Shortcuts with large buttons that you click to open each folder.

Favorite Folders and Search Folders are displayed at the top of the Navigation Pane. You can customise

your shortcuts by adding groups and shortcuts to folders. Groups (for example Outlook shortcuts) hold

folders, while folders (for example, Inbox) hold items like an email message. Not all of the large buttons are

shown by default. You can show more or less buttons in the button tray by using the menu afier clicking
Condigure buttons, which is shown in a figure below. '

e
G Unread Malil
For Follow Up [3]

&3t Matbox - Hate Sun
153 Dalebed feems
A Drafté
h:‘a Inbox [43]
b Jnk Emal

Cuthox

3 Senk ltems
i3 [ Search Foldots
124 For Follow Up [3]
4 Large Mal
3 Unvoad mal

Some of the useful features of the Navigation Pane are described here :

Mailbox - ‘your name’ - Qutlook Today displaysa summary of tasks and appointments you have
pending for today, as well as the number of unread messages in your Inbox folder,

Calendar ~is where appointments and meetings are entered, You may configure an appointment
to display a dialog box (a reminder) when it is almost time for your appointment. By default the Calendar
is only accessible to you, However, it can be set up to allow other users to view or edit your calendar. You
will learn more about the Calendars in this chapter, : |

* Contacts - allow youto record general information about a person. The Contacts foldér is stored
- on the Exchange Server where it can be accessed from Outlook Web Access. Here you will learn about
the use of Contacts in detail, _ ' o : . -

Tasks —is where you store your “To Do” list. As each task item is completed, the item is grayed
out and crossed out but still appears on the list.
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Notes —allow you to leave notes to yourself, ala a Post-It-Note. Most users prefer to use the
Task list to send themselves notes as well as take advantage of the “reminder” feature. In ﬂl]Slll]lt onyou
will learn these concepts in detail.

To Add or Remove a Button

If you want to add a button to the Shortcut buttons in the Navigation Pane, you just follow these
steps: ' ' '
1. Click the Configure button >> A shortcut menu appears. Which is shown in a figure below:

Shc-w More Buktons
Shew Fewer Butt-:ms_:

MNayigation Pane Oﬁtions...

Add o Remave Buttors

2. Click Show More Buttons to display the other buttons or click Show Fewer Buttons to remove
the button. You can also click the Add or Remove Buttons option to remove oradd a speclﬁc
button in a list. '

Add or Remove a Group from the Shortcut buttons
To remove a group from Shortcut buttoné,’you justuse the following steps:
1. Click the Shorteut button in the Navigation Pane. Ahst of Shortcuts will be appeared
| 2. Click Add New Group. '
A New Group window appears:-highli ght the text to rename it.
3. Toremovea group, right-click the group and choose Remove Group.

4. Aprompt appears asking you if you wantto remove the group, click Yes. Then the group wﬂl .
disappear from the Navigation Pane, :

" Folderson the Navigation Pane are shorteuts to folders that already exist in Outlook. For example, |
to add a new folder for messages to your Navigation Pane, you first need to create the folder in Outlook
or My Computer. Then you should add a shortcut to that folder on your Outlook Bar.

Adding a Mail Folder to Favorite Folders

When you add a folder to Favorite Folders in the Mail pane, within the Nawgauon Pane, the folder
stays in its originai location but also adds the folder in the Favorite Folders this provides qmck and easy
access to the folder. Only mail folders can be added to Favorite Folders.
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- To add a mail folder to Favorite Folders
1. From the Mail Pane, click and drag whichever folder into the Favorite Folders.
2. The folder appears in Favorite Folders, move it to another location within Favorite folders b)}
~ dragging.
Add a Shortcut to 5 Folder
‘Toadd a shorteut to a folder, you should use the following steps:

1. Click the shorteut button of the Navigation Pane. Click the group that will coptain the new folder.
The shortcuts display. '

2. Right-click the group, a shortcut menu appears. Click Add New Shorteut. The Add to Navigation
window appears, :

3. Selectafolder to add as a shorteut in your group by clickingit, Click Ok, The Shortcut appears in
the Outlook Shorteuts view. -

'\Add a Web Page Shortcut to the Navigation Pane
- To add a web page shortcut to the Navigation Pane, you have to. perform the following steps:

1. Ifthe web page is not already a shortcut in your Favorites Folder, go to the web page in Internet
~ Explore and choose Add to Favorites from the Favourites menu,

2. OpenMy Computer, double click Drive C:, and then open\Documents and Settings\user\Favourites,
where user is your logon account name.

3. Inthe Navigation Pane, open the shortcut group where you want to add the new  shortcut.

4. Drag the shortcut’s icon from the Favorites folder or the desktop to the Navigation Pane. Drop
it on the name of the shortcut group where you want it placed. '

5. Ifyou want to rename the shorteut, right-click it and choose Rename Shorteut from the Pop-up
meny. You can click the new shortcut to open a web page in the Qutiook Window,

Remove 2 Shortcut to a Folder
| If'you want to remove a shortcut to a folder, you should use the following steps:

1. Right-click the folder you want to remove. A shortcut menu appears.

2. Click Delete Shortcu. | |

3. Click Yes. Then the shortcut to the folder will be disappeared from the Navigation Pane,
10.3.4 Folder Pane o

Generally the Folder Pane displays the contents of the opened folder. When the Inbox folderis opened,
then it displays mail from that day at the top, followed by the previous days, weeks, month, and then
anything else under the description older. The Inbox displays a multi-line layout showing your messages in
the format with four fields (From, Subject, Date, and Icon} and are normally displayed ina vertical column,

This is the default folder when Outlook is opened. It is the folder where all incoming mail is deposited,
unless otherwise redirected by mail filters, This section of the screen is also referred to as the Preview
Pane. When Outlook screen appears, you will be in the Inbox where the mail you receive is located. The
Inbox screen almost looks something like the image shown below : '
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10.3.5 Reading Pane

The Reading Pane replaces the Preview Pane in past versions of MS Outlook and will allow you
to read the entire contents of an email without opening the email. With any view you can display the
Reading Pane, To display the Reading Pane, go to the View menu and select Reading Pane and choose
Right, Bottom or Off. '

10.3.6 Toolbars

The standard Outlook toolbar of Microsoft Outlook allows quick access to many Outlook features.
The folder you are viewing determines which buttons are on the toolbar. If you are viewing the Inbox, you
- will see the email buttons, but if you are in the Calendar, you will see the appointment buttons. The following
list describes the buttons which are always present on the toolbar: '

i ﬂew[v New lten: Tt i; used to create a new item, such as an email message or appointment.
5{ Print : Ttis used to Print the current item.

E‘}ji Move to Folder : It is used io displ_ay a drop-down list of places to move the selected items.
X jDelete : Thié Buttﬁn is used to send the selected itern to the deleted Items folder.

%y Frd| Find: Tt is used to search for an Outlook item by keyword.

%5 Organize | ‘Organize: This button is used to allow you to choose different options for
displaying items. _ o |
o @] Microsoft Outiook Help: It is used to display the Office Assistant or Help Toolbar buttons do
not automatically change with use; instead, they must be manually configures if customization is desired.
10.3.7 Qutlook Today |

The Oﬁtld_o_k_ Today pagé shows a preview of your appointments, a list of your tasks, and how many
new email messages you have for the current day. You can also quickly find a contact by using the Find
Contact box. _

You can customise how Outlook Today looks and functions using these steps:
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1. Click Shortcuts on the Go memu, Inthe Navigation Pane, click Outlook Today. @ fThe QOutlook
Today page appears. L
2. Click the Customize Outiook ‘Today ... button Custonize

‘Outlonk Today

The Customize Outlook Today page appears.

3. Select the options you would like to use in Outlook Today and then click Save Changes to save

your changes or Cancel to exit without saving The Outlook Today page reappears.
10.4 Calendar in Outlook

The calebdar is also an important feature of MS Outllook, The Calendar in Microsoft Qutiook helps
you manage your time through appointments, meetings, and events. Outlook can even remind you of
upcoming items. To access your calendar, click Calendar on the Navigation Pane shortcut, The Calendar
appears in the Navigation Pane, is shown in a figure below:

uary 2011

&5 Jan

Bundn

How to Share Calerndars

- o I ~

10.4.1 Calendar Views

As with the Inbox, you can view the Calendar in many ways. Each view, except Day/Week/
Month, shows attachments, subject, start and end times, recurrence information, location, and categories.
Youcan expand the view of the Date Navigator by placing the cursor over the line separating the Date
Navigator and Expanded Calendar or between the Date Navigator and the My Calendars bar. You will get
a double-sided arrow and you can now click and drag to expand the Date Navigator View. To change
your view, go to the Tools menu and click Organize. A nevw screen section appears. Click>Using Views.
In the Change your view box, select one of the following views : _ ' o

Day/Week/Month- Appointments, events and meetings for one or more days or weeks or for
amonth. Also includes a list of tasks, This view looks like a paper calendar or planner.

Day/Week/Month with Auto Preview— with same as the Day/Week/Month view, except the
first lines of the text appear in items, '
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Active Appointments— A list of all appointments and meetmgs beginning today and going into the
future and dctalls about them.

Events— A list of all events and details about them. _
" Annual Events—- A list of events that happen once a year and details about them.
Recurring Appeintments— A list of recurring appointments and details about them,
By Category— Alist of all Calendar items grouped by category and details about them.
To change the Day/Week/Month calendar display, click one of the buitons described below:

{ 55;] Displays one day of the calendar and the Navigation Bar with Date Navigator.

\[] otk week | Displays one work week (Mon-Fri) and the Navigation Bar with Date Navigator,

E] sweek | Displays one week of the calendar and and the Navigation Bar with Date Navigator.
10.4.2 Understanding Calendar Items

You can schedule three types of activities into your calendar: appointments, meetings, and events.

© 10.4.2.1 Appointment

An appointment s an activity that you block time for in your calendar that does not involve inviting
other people. Appomuncnts can have reminders attached to them. You can schedule recurring appcmtments.

10.4.2.2 Meeting

A meeting is an appointment to which you invite other people. When you create a meeting, you
identify the people to invite and pick a meeting time. Responses to your meeting request appear in your
Inbox. You can also add people to an existing meeting, reschedule a meeting, orschedule a recurring
meeting. To create an online meeting, such as a Net -Meeting, check this is an Online Meeting check box
on the Appointment tab of your meeting request _

10.4.2.3 Event

Anevent is an activity that lasts 24 hours or Ionger. Examples include a trade show, the olympics,
a vacation, or a seminar, An annual event, such as a birthday or anniversary, ocgurs yearly on a specific
date, while an event occurs once and can last for one day or several days. Events and annual events do not
occupy blocksof time in calendar; instead, they appear in banners. An all-day appointment showstimeas
busy, while an event or annual event shows time as free when viewed by others.

10.4.3 Scheduling Calendar Items

There are several ways to schedule a calendar item. If you want to create your calendar { ltem, you l :
should follow the instructions below: .

10.4.3.1 Create (or Schedule) an Appointment _ _
To create or schedule an appointment use the following steps:
I. Click the New Appointment button. |
2. Inthe Subject box, type a description.
3. Inthe Location box, type the location,
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4. Type start and end times. When you select start and end times, youcan take advantage of
Autodate fimetionality and type text such as ‘next Tuesday’ or ‘noon’ instead of typing a date or
5. Select other options you want,

6. Click Save and Close. Then the appointment appears on the calendar, (See figure10.1 1)

AppORtES | Bchatiaog
i

AT
Lucatreie

- Rhart dimery
Errdl Gz )

7. Note: In Calendar, you can also create anappointment by selebt’ing ablock of time, right-clicking,
and then clicking New Appointment on the shorteyt menu, '

10.4.3.2 Create (or Schedule) a Recurring Appointment
You should use the steps mentioned below to create a recurring appdintment:
1. Make sure you aré in the calendar, '
2. From the Actions menu, click New RecﬁrringAppoinﬁnent.
- OR
Double-click an empty space on the Calendar screen.
3. Typestartand ent_fl timgs.' |

Click the recurrence pattern (Daily, Weekly, Monthly, or Yearly) at which the appointment
recurs, and then select options for the recurrence pattern.

he

Cli_gk OK. Anew window appears, _
In the\Subject box, type a description. . o
In the Location box, type the location, |

® N o w

Select other options you want, and type information in the open space.
9. Click Save and Close.
Che appo mtment appears onthe calendar.
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10.4.3.3 Create (or Schedule) a Meeting

When you schedule ameeting, Outlook sends the people on your hst an email message askmg if

they can come. Use the following steps:

1.
2.

o2 N s

10.

Make sure you are in the Calendar.
Click Actions and then click Plan a Meeting,

To invite attendees and resources, click Add Others. Select a name from the list. If you need to
invite people not listed, click New . . . to add them. For each name typed, click Required,
Optional, or Resources. Click Ok.

Choose the start and end times for the meeting.

Click Make Meeting. |

In the Subject box, type a description.

If you do not schedule aroom, type the location in the Location box.
Select other options yéu want. '

If the meeting is recurring, click the Actions menuand then click Recurrence. Select the recurrence
pattern and range of recurrence options you want.Click Ok.

Click Send.

The appointment appears on the calendar and Outlook sends an email invitation to each person.

10.4.3.4 Create (or Schedule) an Event

To schedule an event :

Eal A

You should use the steps mentioned below to schedule an event:

Make sure you are in the calendar.

Onthe Actions menu, click New All Day Event. |

In the Subject box, type a description.

Tn the Location box, type the location.
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5. Select other options you want.
6. Click Saveand Close. |
The event appears on your calendar.
10;4.4 Editing Calendar Itelﬁs

If you want to change the item, after the creation of a calendar item. There is an easy way to changean
appointment; you just do double-click the appointment in the calendar. Then the item opens for you to
make changes. :

Outlook allows you to drag items around the calendar For example, to move an appointment to a new
day, click the appointment in your caleridar, hold down the mouse button to drag it to a new day, and
release the mouse button. The appointment moves to the new day. Experiment dragging items in the
calendar when you need to make changes.

10.4.5 Deleting Calendar Items

When you no longer want fo keep a calendar item, you should highlight the item the:. click the Deleté -
button. This moves the riem to your Deleted Items folder. At this point, you could go to your deleted Items
folder and recover the item. _

If you would like to permanently remove the item, you must highlight the item in the déleted Ifems
folder, and click the Delete button. Or you can remove everything in the deleted Items folcler by rlght-
clicking the folder and clicking Empty ‘Deleted Items’ folder.

10.4.6 Adding Holidays

You can automatically add the hohclays fora partlcular country to thie calendar. These hohdays:ére |
sef up as recurring evenis in your calendar,

To add holidays to your Calendar, you should use the follow'ing steps:
1. Onthe Tools menuy, click Optlons and then click the Calendar Options button.
2. ClickAdd Holidays. '

3. Check the check box next to the country with the holidays you want to-add to your Calendar,,and
click Ok. Then the holidays will be appeared on your calenclar -

self Learning Exercise

Fill in the bianks :
[(:) I is the default folder when Outlook is opened.
() TN located to the right of the Inbox, it is opened by defaﬁlt when Cutlook opens.
{C) e, vrrerees is where messages from your Inbox go when you delete them.
(<) IOUOROTIo window shows a preview of your appointﬁ]ents, a iist of your tasks and how many

new e-mail messages you have for the current day.
@) coeeennne. contains thé e-mail messages you started to compose but have not yet sent,
L State ‘True’/ ‘False’ ; ' |
(a) Microsoft Office Outlook is a desktop information manager.

(b) Anappointment is an activity that youblock time for in your calendar that doesnot mvolve uviting
other people

r
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(¢) The new navigation pane allows you easy access to your mail, calendar, contacts, tasks.
(d) The new item tool bar creates anew item, such as an e-mail message or appointmenf.
(¢) Calendar is not a powerful tool for keeping track of your appointments,

10.5 Contacts in Outlook _

Acontactisa person or organization you con‘esp'oncl with. You can store information about contacts
such as job titles, phone numbers, addresses, email addresses, and notes. Each contact is like a business
card that you keep in a file. To access the contagt list, click Contacts on the Navigation Pane,

The Contacts folder is used to create a personal address book, There are many ways to add names to
your Contacts folder. We will describe three of the more popular procedures in this chapter.

The contact list works with other areas so that you can easily access it any time you need information
about your contacts, - - o '

For example, you can look up names and addresses in your contact list or merge contacts with  form
letter in Woid. :

10.5.1 Contacts Views _'

When you chaﬁ'ge your contacts view, from the menu bar Click>Tools and then cho_osé OrganiZe
from the drop-down list, Anew screen snapshot appears. Then click>Using Views. Inthe Change your
view box, select one of the f_o]lowing views : - B

Address Cards—On individual cards with one mailing address and business and home phone Humbers.

Detailed Address Cards —On individual cards with business and home addressés, phone numbers, |
and additional details. ' : A

Phone List—In a list with company name, business phone number, business fax nu:ﬁber, and home
phone number. ' : : : : : "

_ By Category —In alist grouped by categories and sorted by the names the contacts are filled under
- within each category. ' . -

By Company —In a list groilped by comiaany with job title, company name, department, business
phonenumber, and business fax number, _ ’ '

- By Locatioln —~Inalist grouped by country with company name, state, coﬁnﬁ'ir and phone numbers,
By Follow-up Flagm Inalist grouped by flag. Also shows the due date for follow-up action fér the
10.5.2 Creation of a C@tact_ @i v
.‘When 3-10u createa contact; you type all new information or start with a ébpy of information from -
an existing contact from the same company. ' ' . :
10.5.2.1 Create a C(Imt_agf WIthNew Inforhlaﬁon -
To create acon‘tact-wjiﬁ{hew it_ifdﬁnation, follow these steps:
1. Click Contacts on the Navigﬁfﬁn Pane.
2. Click the New Contact button. - |

[190]




Then a blank contact form will bw appeared, that is shown in figure below :

Mm&m]wmﬁsimml

n the Full Name box, type a name for the contact,

. Type the information you want to mclude for the contact To select an emall address, use the

Address button _ N -
Click Save and Close. STy

" Then the outlook saves the new contact,

10.5, 2 2 Create a Contact by openmg and rlght-chckmg an e-mail address -

Fal S

To create a contact from the same company as another contact, you should follow these steps :
Open the e-mail by double~clicking it.

Right click the name of the sender in the e-mail. A shorteut list will be appeared

Choose the OptIOI‘l Addto Outlook Contacts. A Contact listing appears for that person

.Type the information you want to include for the contact.

Click Save and Close, Then the Outlook saves the new contact.

-10.5.2.3 Create a 'Contact__froﬁ the Same Company as another Contact

AP R N

To create a contact fromihe same company as another contact ;

Select an existing contact from the same company as the contact you want to create.
From the Actions menu, click New Contact from Same Company.

In the Full Name box, type a name for the contact.

Type the information you want to'indhide_for the contact.

Click Save and Close. Then the O_ut_lbok sévcs_ the new contact.
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10.5.2.4 Create a Distribution List
To create a list for a group of people you should perfomi these foliowing steps:

1. While viewing your contacts folder, from the File menu, click New, and then click Dlsmbutton
List. Then the Untitled-Distribution let window will be displayed. '

2. Inthe Name text box, type the name for the list of people. i
3. Click the Select Members button. Then the select Members window displays,
4. Select aperson you would like to include in y~ur list. Then click the members Button.
The person adds to the box on the right ofthe window. |
5. Repeat step-4 until everyone you need on the list.
6. Click OK. Thenthe Seleét Members Window will be displayed.
7. Click Save and Close. Then the distribution list will be appeared in your Contacts
10.5.3 Deleting a List or Contact . -
Toremove alist or contact, do the following things ;
1. In your Contacts Folder, highllight the contact you wishto délete by clicking it once. :
2. Clickthe Delete button. Then thei item is removed from your Contacts Folder.
- 10.5.4 How to add a plcture to a Contact

The picturescan aslo be inserted or added directly into a contact in MS Outlook, which means
that users can associate a face with the name and other mformatlon inthe contact. Which is refferedin a
figure below: ' ' -

§  General e .
e Trnghant Massyce

1 Detats | a
~~—{ E1]; New Letter to Contact .« ...

[GEIT N

Job title: ' iGroup Program Marags

Nmﬂgs_saqg’io._(:ont—’ac_t_ o
MNat Méetingi.Réqutssiﬁ:to_Contétt*. .
v, Appointmect Wittt Coritat_:t :
_Nsw Task Por Contacl:

Company: {Adventure Warks

File as:
i .Phone rurmbers -

New laurnal Entry For Conta-:t

CgﬁCnntact R Y :
Call Using Net&leetnng o T . '
Follow L. .. CI:rI+Sh|ﬂ:+G E
Display Map ﬁf Ad-:lress .
Explore Web Page. - ClrltShifery
Add Fictups

Forward as vCard - : )

| Forwerd . cer

[192]




The picture can be inserted to a contact using these steps:
1. InContacts, create or open a contact,
2. Onthe Actions menu, click Add Picture.

10.6 Using Tasks

We know that the Qutlook Tasks helps you mertage your various duties and projects. You can use
it to record your tasks, set priorities, and due dates. To access your task list, click Tasks in the Navigation
Pane. Task properties dialog box is displayed in a figure below :

10.6.1 Tasks Views
If you have several tasks in MS Outlook, then you want to see all of them in a special format.
To change your view, click Organize. A new screen section will be displayed. |
Now, click Using Views.
~ So, there are many views in the change your view box, select one of the follomng views:
Simple List—In a list with only a few details so you can see ata glance the tasks that are complete

Detailed List — In a list that shows many details about each task including priority and percentage
complete. :

Active Tasks —In a list that shows only incomplete tasks (including ones that are overdue). |
Next Seven Days — In a list that shows only the tasks that are due in the next seven days.
Overdue Tasks — In a list that shows only the tasks that are overdue:

By Category —In a list, grouped by category and sorted by due date within each category.

Assignment —In a list that shows only the tasks that have been asmgned to others, sorted by task owner
and due date.

By Person Responsible —In a list, grouped by task owner and sorted by due date for each task owner.

Completed Tasks - Inalist that shows only the tasks which have been marked complete.
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Task Timeline — Represented by icons arranged in chronological order by start date on a timeline. Tasks
without start dates are arranged by due date.

10.6.2 Creating Tasks

To create a simple task, type task information into the space labelled Click here to add a new Task
and press Enter key. You can also drag an appointment or message onto Tasks in the Navigation Pane to
create atask. Or, you can perform the following steps :

1. Click Tasks on the Outlook Bar.
Click the New Task button . Then an empty task will be displayed.
Type atask name in the Subject box.

- Select the options you want.

LA woN

[f the new task is recurring, click the Recu_ri*ence l_)uttc_m . _

Then a new window will be displayed. Select the options you want and click on Ok button.
6. Click Save and Close. Now the Outlook adds the new task to the task list,

10.7 Using Notes

Inthis section, you will learn about the Notes. Mierosoft Outlook can create electronic versions of
sticky notes. All notes are conveniently kept in your Notes folder. '

10.7.1 Creating a Note ¥
To create a note, use the following steps :
L. Click Notesin the Navigation Pane. Then the Notes screen will be appeared in the Reading pane.

y : .
2. Click the New Note button: Thén a b ank note will be appeared with your curser waiting for
information. S '

3. Typethe information for the note. This information is saved automatically.
4. Click the Close button. Now, the Outlook will save the note in the notes folder.

Youmay want to keep a note open on your desktop. Double-click the note you want. Even when youn
close or minimize Outlook, the note will stay open until you close it.

10.72. Deleting a Note
To delete anote, use the following steps: ) _ _

1. Notes in the Navigation Pane. Then the Notes -écreen will be displayed in the Reading pane.
2. Click the note you_.want fo delete. The note is highlighted.
3. Pressthe Delete key. Now, the note will be removed from the Notes folder.

Self Learning Exercise

I Fillin the blanks :
M e, folder is a default folder that is Iocated inthe favorite folders section.

| (i) The improved Personal Folders File (*.pst)storesupto ........ of data by default, _

(i) ............ helps you manage your various duties and projects.
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(V) cererren is designed to help with date-file management activities such asarchiving and copying
between rmailboxes. .

V) e, ..... allows youto create a group of addresses to which you frequently send email.
I State “True/*False’ : _

(vi) The New Mail Desktop does not alert fades in subtly with the name, subject, and a short text
preview, _ S : S _ .

-(vii)Taské help you manage your various duties and projects.
(vili)Attachments are not files that are sent ﬁiﬁane-mail meésagg _ -
(x) Microsoft Qutlook has many oﬁﬁons for you to orgaﬁizc your e-mail messages.
(x) Ameeting is similar to an appointment.
10.8  Summary |

In this unit we have discussed a number of the basic procedures used in creating, editing, sending
and recetving Outlook mail messages. In addition to it, we have also introduced other features essential to
managing Outlook mail messages. As you know that Microsoft Outlook is application software that allows
users to keep track of their email, their appointments, their tasks, and notes. It is basically an electronic
form of a daily planner. '

The new look of Outlook helps users organize information to increase productivity and get the
information they need. Outlook also helps users block the information they do not require and protect
against the misuse and unwanted distribution ofkey company information.

Contact feature of Qutlook is a powerfi tool for managing and using information about people. It
goes way beyond the basic address book to store just about any kind of information about a person you
canimagine. What’s more, it makes it easy to find and use that information in various ways. Many people

- find contacts to be one of Outlook’s most tiseful tools, B B

Outlook’s Calendarisalsoa poWerﬁll d flexible tool for keeping track of your appointments and |

other time commitments. Much more than a sifple daté book, the Outlook Calendar can do things suchas -

remind you of an upcoming appointment, o

Outlook provides some pbwerﬁll tools for .};eeping track of your tasks. Although a task does not

have aspecific period of time associated with it (unlike an appointment), it can have a due date. By listing

your tasks and optionally reminding you of when they are due, Qutlook can greatly reduce the chance that

you’ll forget to do something important, Outlook even lets you assign tasks to other people and track their
- progress, a truly valuable tool for a manager or team leader. '

10.9  Glossary
Menu Bar : New, Send, Reply, Reply to All, Eprward, Find, Delete, etc.

Outlook Shortcut Bar: S<zvitches to different windows in Cutlook pmgram, such as Inbox, Calendar,
Contacts, Tasks, Notes, Deleted Items. :

Folder List Pane : Similar to Outlook Shortcut Bar but includes Personglanﬁﬁliblic Folders.

-

Preview Pane : (Optional) Display_s contents of selected email messagé.- o

Unread Mail : Unread e-mail messages, regardless of their folder location, are shown in the Unread Mail

search folder. B |

Outlook Mail: Itis 2 tool in Microsoft Outlook that allows you to réad and send email
ros

-




For Follow Up: his folder provides a virtual to-do list of all messages that have a Quick Flag applied.

Large Mail: This folder assists with mailbox cleanup by showing the largest email messages from the -

entire Inbox.

AutoUpdate: Microsoft is commltled to prowdmg periodic updates of the Junk E-mail Filter so that i it
continues to be effective.

Junk E-mail Filter: The Junk E-mail Filter feature is on by default, and the protection level is set to Low,

which is designed to catch the most obvious junk e-mail messages. Any message that Junk E-mail Filter
catches is moved to a special Junk E-mail folder, where users canretrieve or review it at a later time.

10 10
| ]

10.11

“Outlook 2003 can also be set to delete ]unk e-mail messages permanently.

Further Readmgq _ _ _

Microsoft Office 2003 for W"mdows S. Sangman

Microsoft Office 2003 Suite - A Comprehensive Approach, McGraw Hill
Microsofi Office 2003 Bible by Edward Willet

Mastering Microsoft OfﬁceQOOBProfeesmnal Edmon by me Courter
Mastering Microsoft Office 2003 for everyone - San_]_ay Saxena : TMH

Answers to Self Learning Exercises -

- Fillin the blanks :

"~ (a) Inbox
{b) The Reading pane

(¢) DeletedItems -

" (d) The Outlook Today
(e) The Drafts folder

L

True/False :

(a) True
(b) True
(c) True
(d) True
(e) False

Fill in the blanks :

() TheForFollow Up
{g) 20GB
() Tasks |
@ Thefolderlist
() The Personal Distnibufion List
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1.

True/False :

() False
(2) Tiue
(h) False
@ Te
(i) False
10.12 Unit End Questions

1.

2.
3.
4,
5.

What is an Email Client?
What are the different views in Outlook? Explain in brief
What is a contact? How would youcreate a contact in Outlook?

What are the steps required to-create an appointment?

Whrite short note on:

(a) Inbdx

(b) Address Book

() Navigation pane

. (d) Calendar
(e) Tasks
Shortcut Keys

. Mail CTRL+1
. Calendar CTRL+2
. Contacts CTRL+3
. Tasks CTRL+4
+  Notes  CTRL+5
. _ F_ol_dér List CTRL+6
+  Shorteuts CTRLs7
. Folder : CTRL+Y
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Unit 11 : E-Mail

Structure of the Unit
1.0 Objectives
11..1 Introduction _
11.2  Word Processor as an E-mail Editor
11.3  Using E-mail in Outlook
| 11 3.1 Setting-Upan E- MallAccoqht
11.4 ;&um Slgnature
11.5  Sending E-mail
11.5.1 Additional e-mail Option$
116  Spell Checking |
11.7° MailFilters
11.8  Message Options
11.8.1 SendmgAttachments
11.8.2 Receiving Message
11.8.3 Replying Message '
11.84 Forwarding Message
11.9  Flag E-mail for Follow-up
11.10 Personal Address Books
- 11.1.1 Distribution Lists ‘
11.12 Creating Personal Folders
11.12.1 Moving Mail to-a Personal Folder
11.12.2 Managing Sent E-mail ’
11.13  Deleting Unwanted Messages
11.14 " Printinga Message =
11.15 Outof Office Assistant
11.16 Summary
11.17 Glossary
11.18 FurtherReadings
1 1.. 19 Answers to Self Learning Exercises
11.20 -

Unit End Questions
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11.0  Objectives | _
® After reading this unit you will be able to understand the following concepts:
¢ Word Processor as an E-mail Editor
¢ Setting-Up an E-Mail Account
¢ Personal Address Book
¢ AutoSignature and-the Spellchecker
e Creating Personal Folders
» Sending Messages
o Receiving Messages
* Replying to a Message
e Closingtoa Message =
» Saving aDraft Message

- o Deleting Messages
¢ Printing Messages

111 Introduction

In this unit, we will discuss one of the important features of Outlook is sending and receiving e-mail,
You can easily read e-mail in many views. You can also send, forward, and reply to e-mail, the use of
address book, and print your e-mail.

To access your email, you can either use the Inbox in the Navigation pane or you can use the My
Shorteuts bar, The Inbox folder on both bars accesses the same information, but the My Shorteuts bar has
access to other items, such as Sent Ttems.

This unit gives you how to work with the items, folders and data files to keep your Outlook

information organized, accessible, and backed up. It tells you that Qutlook has an overwhelming number of
- e-mail options. Fortunately, most options can be left with their default settings and changed only when you
have a specific reason to do so. As you become more familiar with Outlook, you gain a better understanding
of how to set options to maximize your convenience and productivity.

Outlook’s e-mail features ate sophisticated and comprehensive. Undemeath all that pdwer, however,

are the fundamental tasks of composing, sending, and reading messages. This unit explains the basics of

composing and sending e-mail messages.

_ When Microsoft Outlook receives an e-mail message, it places in the Inbox folder by default,
messages are sorted by the time and date they were received. You can see that the sender, the subject, the
time and date received, and the message size are displayed. ' :

Sometimes, when you send a message, you would like to be reminded to follow up on the message-
for example, to make sure that you have received a reply. You can flag a message for follow up and,
optionally have Outlook remind you. ' :

1.2 'Word Processor as an E-mail Editor

You can use Microsoft Word (also known as Word processor), if you have it installed on your
compuier, as your ¢-mail editor, if you need. To activate Microsoft Word, make sure that you are in the
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Inbox, Sent Items ot Deleted Items screen. Then click on the Tools in the Menu Bar, click on Op.tions in
the drop down menu that appeats. Whic}his shown inafigure below @ :

Q%J_t 0!’ {Zﬁ F&E mmﬂ:

R g AL b g

ﬁ"usf.um:zs ,

Opttons Menu Screen

When the Options menu screen appears, click-on the Mail Format tab, which is displayed ina
figure below :

St o Tormaait B dopewng o arad oo e mw m:mw
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B fcrpeniy (e Mg SE04 n ress ek §
{ m:mwg&m ' ...... WT | wb@ftﬂﬁw st@cm, .‘ ’
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] N e . E
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Mail Format Tab

If you alré.using word procéssor as an editor (including all word processing features), in the Options

- menu screen that appears, click-in the boxes to the left of use Microsoft Word to edit e-mail messages and -

use Mlcrosoft Word to read Rich Text e-mail messages.

Then chck onthe Apply button and then click on the OK button. The next time when youwill create
a new e-mail, or reply or forward an email you will see a little message appedr that indicates that word
processor is being loaded as your editor. At the top of the screen you will see 4dditional; new toolbars for
using word processor. When you are typing your e-mall message you w1ll*’have all of the power that is
inherent in Mlcrosoﬁ Word 2003,

11.3 Usmg E-mall in Outlook

Before you can send and receive e-mall messages using M1crosoﬁ Outlook, you must set up at
least one e-mail account, providing Outlook with the information, it needs to connect rzc%?m-mﬁm -
e-mail account.

 Therefore, you can oompose, send and receive messages from there. Microsoft Qutlook provides
alot of tools for creating and organizing your messages, as well as options for customizing how it works
with your messages. This unit will help you to learn the basics for all of those actions in Microsoft Qutlook.
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11.3.1 Setting-Up an E-Mail Account

When you are using the Mic}osqﬁ_ Qutlook te-send and receive e-mail, you must set up an e-mail
account. You can have more than one account, so, you should follow the same steps for each one, There
are two ways to do this job : :

First, your account must be set-up on the server or at your ISP. This is not done in Outiook. Ifyour
account is at your workplace, it will likely have been set-up by an IT person and he/she will have provided
you with the required information such as your e-mail address and password. If you are setting up a home
or small business account, you should do this yourself, The details depend on your ISP, so I can not
provide instructions, but as part of the process you will either specify or be given your e-mail address and
password.

Second, you must set-up your account in Microsoft Outlook. This pro_éess provides Qutlook with
the information, such as your e-mail address and password, which it needs to conmect to your e-mail server
and send and receive messages. :

The minimum information you need is your e-mail address and your password. You may also need

to know the addresses for your organization’s or ISP’s e-mail server. The URL looks like web page -

address and will be something like mail hosting.com. Some mail accounts require two addresses, one for
incoming mail and another for outgoing mail.

You should perform the following steps to setting-up an e-mail account -
Step—1 - '

When you open Microsoft Outiook, a screen similar to the one shown below is appeared (The
screen seftings may differ depending on your seftings). ' '

-Lalendgar o e naT o

2
H

The Outlook Window
Step-2

Go to the *Tools’ menu and click on “E-mail Accounts...”
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Dotwmgrarh [ Pasatape. | nokbecinse T o e L B8 o

Tools & E-mail Accotnts Option
Step-3

When the E-mail Accounts window appears, Select Add anew e-mall account then click

Next button.

This wrizord will allow you ta cheonge the e-mali
dceomes and direct ardes thot-Qubleok nscy,

E-tymit

D 2 rirer o0 Setont
T e or charga plethg e Acounts

Birgrtory

& adg anior dhctery on Liithesg ook
o o SRR B chesthneins of ATV AL twagks

E-mall Accounts Wmclow
STEP-4

On the choose a Server Type screen select POP3 and then click Next button.

E-trtanll ACLiasiibe

fervar Tyno
o0l e ey -tha Knek oF v yols St aman atotnt vl vigr pith

T umfnsﬁtsuchaowkm )

Cerifiect koo Exchangi savoer torad st a&ﬁm&kﬁ&&lﬁm,m thare
ibierrs. .

Ccmnct kg WWSW&HWW o mad,

o A .
_ %mc{mari IIW'&MM wﬁswbm Berinad A avTichrakee pasdoct

t‘ HETF
Catmieet to-at HTTP & mad teavar sutlras Hmwmm w.ad 3nd
arize re-pilny boldeis.
= munal Sn.rvn_r?:enut o
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Figﬁre 11.6: Server Typé screen
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Step-5

The Internet e-mail settings window requires you to enter all your e-mail account information (you -

have all this information available in the welcome email sent to youduring order processing) |

Your -Name.: The name you wﬁnt to appear on all e-mzﬁls you send out. ..

E-mail Address: The e-mail address you wish to configure. (i.e. test@yourdomain.com)

User Name : Your complete ¢-mail id. (i.e. test@yourdomain.com) ' '

(Note: - You must enter your comp!et_‘e email id here afong wz’th_ your web site or domain name}
Password : Enter your email account password here. |

Incoming Mail Server (POP3) : Your web site domaih name or IP address. (i.e.. yourdomain.com) -
Outgoing Mail Server (SMTP) : Your web site domain name or IP address, (i.e. yourdomain.com)

Once you have filled out the details, please click on More Settings......

BE-mad Acedunks:  TET

Intecreet £-malf Seteings (eoba) X
o theede sabtieegs 3k remerast b0 8 yie @+isal aopisst it v,

d ma\k@mm L
il somer B Lordomaingon L

Step—6

In this window, click on the General Tab and type the name into first blank field which you would
like to refer to this account. This name is displayed in the ‘from e-mail id’ field when you send an e-mail.

a -+ Frourdomeincom

- Otherlisie nformai

O e .

Internet E-mail Settings
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Step—7

Now, click on the Outgoing Server tab and ensure that the check box ‘My Outgoing Server
(SMTP) requires authentication’ is selected. You also need to select the option “Use same settings as my
incoming mail server’.

| Inket ml E- maﬁ \ettin

mld Ouigoing Server } Conaection | Mvanv:BdI

W MQWW(SWP) Foipan siheniiations
Fmsmséwwﬁasmmfﬁmmﬂm_ L

Ce Logonto hoomngmaimver hefores«nﬁ'gmﬂ

0utgomg Server tab dialog box
Then, click on the Connection tab.

Step-8 -
On the Connection tab, select the type of your Internet connection. Then Click on the OK button.

of cannection ko use for s-mad,

. R Gonpiect g g (otal e matiasr i LANY _
- l“cmgamodanwmomisoﬁm R
: Pcmnmwngmmw R S

e tmeuusunqmmm‘gora&dpamﬂw

Connection Tab

Step-9
Click on Next button to proceed.
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Step—10

You should end up at this window, Congratulations!. You have successfully configured your e-
mail account under Microsoft Outlook. Finally click Finish button to proceed.

Congratifationst

Tt tycrasefily entermd b the rfonshon requaibe
g i AT,

T e thws wided, olick Faen

Finish option _

Now, Microsoft Qutlook 2003 has been configured to access and download e-mail onto your
computer, you should now make sure you are connected to the internet and then click the send/receive
button or press the F9 key to check your e-mail. Then the following window screen is displayed ;

T T
LLILL LT
LR PR T
TR N, 4 ]
Fesi Hinmye Al A, 4

i warl TR NAAT, 40
Taat Hohiysumt_, 41
N G _ vy

, IRE1eAon-DNmce CUIRGR Taet Mtakage . r'\ -
N % o lematg s com
lix - et S

T Lo w Pl vty e Wikt e T 7 MRS LENA et Lea s Loous e i
] bR o TGO B Rer ROET mess,

E—mail configured

window
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114 Auto-Signature

Thisis an unportant teature of Microsoft Outlook which allows you to pIace a desngned signature
at the end of your e-mail messages. You will need to be in one of the main areas of Oytlook to create a
signature (Inbox, Sent items & Deleted Items etc.).

Generally , We can say a signature file contains text that is automatically added to the end of

outgoing e-mail messages. Microsoft Outlook allows you to add asignature block to all your outgoing mail

Messages O 10 nEw messages only
To create asignature file you should perfonn the following given steps:

1. Select Tools>>Options from the Outlook menw. When the drop down menu appears, click on
Optlons .

£F Customize,..
gl:lﬁDﬂS...:._" ] . . -

Tools Options screen

The Options menu screen is appeared, which is shown in a figure below:

i:hnose & foernat for oatooing mall and chmge ad\ranced sett!rsgs. )

Compose i this messaga formaty }Ru:h Text h

I " [Fluse Mcrasoft Offica Wiord 2007 1o edit a-mal nessages .
| S “ Use Microsaft Office Word 2003 ta raad Rich Text e-mail messages
[ Internet Fomat.., - ] [ Internationsi Options, ., J

Sﬁtw‘ler‘( ard me e i et s s = 4 e e o+ et

i Use statisnery to change your default fant and style, change eolors,
' o and add bada:munds to your messages,

i o ' use this stationery by defait:

S’sgﬁa!u BE

| g{; SeEectshgramres for ac:amt-

Sﬁgnam far new messages:

Sgnztre for replies snd forwards:

T e e T TS o 4 18 T g S Ao s eereeem

I T

‘The Options menu screen
2. Click the Mail Format tab.
"3, ~ Now, Click the Signatures button and then click New.
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Create Signatiure Menu screen -

‘4. -In the Create New Sl gnature box, type a name for your signature file, then click on the Next
. button. . e _ :

» Enter aria & for w.wnewssgnawm TR
- ‘Gregﬁutlaf

_2‘ Chome }mw m p:reat
N {v) sranwwahimk i

g oz ""“ Cm-:ef]

" Create New Slgnature Screen

5. Inthe E dlt Signature box, type your name and any addmonal text ie. your department and
~ extension numberas you would 11ke itto dlsplay n outgomg e-mail messages

6. When you have done, click lesh button and then click OK.
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. ,;i"& Thi text ol b inctudied 1 outgeing med messanes:

: ;Ha\'e a great dayt

" Greg Bt
i |

[ Fn.nt... HPaugraDth Clear ] I :;dvanced Eﬁt }

; R Attadythis budeess card (uCand) to s diature: o .

L T S,

'. { ew vCard. fom Contact,,

The Edit Signature

When you create a new message, reply to one, or forward one, you will see that your signature
is automatically added at the end of the message. :

If you want to edit your signature or create a new one follow the process above, and choose the
logical buttons to Edit, Remove, or Create a New signature, When you are satisfied with your signature,
then Click OK button. ' -

Note: Selecting Clear will erase all the text in the Signature text box.
11.5 Sending E-mail

: When you are in the Inbox, then click New button on the Outlook toolbar, or select File>>
New>>Mail Message from the Outlook menu. A blank message form will display. Complete the message
form as follows: _ :

1. Click the To button to display the global address list and/or your personal address book to select
recipients from. Once you have selected a recipient from the Name box, click the To button to
move the name to the Message Recipients box. Continue to select recipients in this manner. You
may also select the names of individuals you want to carbon copy (cc) or blind carbon copy (bec)
at this screen. When you are done, click OK button. :

2. Typeabrief descriptioh of your e-mail message in the Subject line, then click in the large inessage
body box and type your message. Click send when you are done.

Click the ptions buiton to dispke
additional options available 19 you when
gending email,

This k& ny.“irat zrir i msemyd

 Additional Options
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11.5.1 Additional e-mail Options:

If you want to receive a notification when your email is delivered and/or read by the recipient, do

this prior to sending the email:

Click the Options butfon on the message screen, and then select the desired option, then click OK
button. B

You can also alert the recipient as to the importance/ sensitivity of your email by selecting the
appropriate setting from the drop down lists, Then your mail will be flagged accordingly.

d You eon uze the Imgartance and bensitivity boxes
bo ukerd e recipient os 19 the inpor lurice widfor
senst=rirty of your emal,

i Cheekng thesa two aptions will result in
e your being notifisd when your mail is o
delivered to and read by the reciptent(a)

Figure11.20: Additional Message Options
116  Spell Checking | '3 |
The spell checking can be petformed in two ways: Manually &Automatically. '
To manually spell check a message, press F7 key or select Tools>Check Spelling.

To automatically spell check all outgoing messages, from the Inbox Toolbar (see the figure below),
select Tools>>Options. Select the Spelling tab and select>>Always check spelling before sending.

Inbox Toolbar

11.7  Mail Filters

Microsoft Outlook has built-in junk e-mail (aka spam) and adult junk e-mail filters. You should
review suspected junk e-mail before deleting it in case you receive a legitimate e-mail with the keyword(s)
the spam filter is looking for. : ' '

To change your junk e-mail settings select the Tools>>Optiens from the Inbox Toolbar. Under
the Preferences tab select Junk E-Mail from the E-mail section. Finally, choose your level of protection
and then Click Apply. : _ '

11.8  Message Options

Ifyou want to receive a notification, when your e-mail is delivered and or read by the recipient(s),
~do this prior to sending the e-mail. Click the Options button on the message screen and then select the
desired options and click OK button. . . o _ .
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Flessage settings

o

iy

Tmportate:
Sensitivity:
' 'M'ng ahd Tratking ophnns -
[Clrequest a defivery raceipt for this, hessa

Delvery options -~
@ T |Have rspﬂl&s senk t:

[Z] Save serk rasssas tor

{"|Expires after:
Attachment Format!
Encading: -

. [cotenwtee | 1

Message Options

You can alert the reclplent as to the Importance of your message by selectmg the appropriate

 setting from the drop-down lists. Your e-mail will be flagged accordingly.
11.8.1 Sending Attachnents

_ Ifyou want to send a file with your e-mail, click the Insert File buttoﬁ.on the'mes.sage screen. The
Insert File button resembles a paper clip. Browse to the file you want to attach. Once you have located
the file you want to send, select it and click Insert. The file name will display in the Attach field of the e-

o _ . _
Please find attachad tralmng ducurnent

Regards,
ENFIRERE

_ _ | . Attachment Optioné
11.8.2 Receiving Message .‘ - .

.

As youknow that the incoming ¢é-mails or messages are stored in the .Inbéx In Microsoft Outlook, -

youdo not need to refresh your mailbox to see if you have new mail — it will appear automatically. Messages
or e-mails that you have not yet read are displayed in boid font. Also the e-mails or messages that you have
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not yet read can be accessed through the Unread Mail folder. To read 4 message, double-click on the
message. . - S _ . .

11.8.3 Replying Message

If you wish to reply an open e-mail message, click the Reply button on the toolbar. The original
sender will automatically be put in the To : line of the response, and you can add whatever lext you want
to the response before you send it. :

There is also a Reply To All button that allows youto reply to all recipients of the original e-mail,
including those which have carbon copied and blind carbon copied. :

11.8.4 Forwarding Message

Ifyou want to forward a message or an e-meail to another individual, then you should use the click
on the Forward bution. The e-mail will be displayed in a new window and youmust type or select the -

mail address of the desired recipient, type a message of your own if appropriate, and then click the Send
buiton, -

119 Flage-mail for Follow-up

You can place a flag on e-mail asa way to remind yourself that additional action needs to be taken.
To flag an e-mail for follow-up, right click the e-mail message in your Inbox and select Folldwup, then
select the colour flag you would Iike to use. You can also click Add Reminder to enter additional follow-
up options. Which is displayed in afigure below: CL '

_E_Igg:ggiﬁg rmarks an-item_"tu reminﬁ;_yeu that it needs to be Fnl[d’v_ved up 'Aft'er \
it hias beenfollowed up, vou can markit complgte

e
owty: e~ g

= B _ | o '[:|=.Cumpleted _
(g ] & ) Cam

S _ : Flag for Follow lip
11.10 PersonalAdd_ress Books

If you want to store frequenly used e-mail addresses in a Personal Address Book. The easiest
way to do this is using Contacts; The following steps should be used. They are as follows :

1. From the Menu, select File>>New>>Contact. Then the Contact dialog box will be appeared :
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[ser B

Type the name of the contact and the e-mail address (or click the Address Book icon next to
the e-mail address field to select aname from the global address list.)

3. Any other information you enter is optional. When you have done, then click Save and Close.

1n.u

To select a Contact in a new e-mail message, click the To button in the message, then select
Contacts from the Show Names in.. ..field of the dialog box. '

Note: If the Contact list does not display as an address book :
Click the Contacts icon at the bottom of the Navigation pane.

When the Contacts screen appears, right click Contacts under My Contacts and select
Properties.

Select the Outlook Address Book tab and make sure that show. This Folder as an e-mail Address
Book is checked.,

Distribution Lists B
Distribution lists simplify the process of sending e-mail to groups. For example, il you frequently e-

mail everyone in your department, you can create a distribution list for your department,

1.
20

With the Inbox displayed, select File>>New=>>Distribution List.

Then the Distribution List dialog box will display. Now, you should type a name for the Distribution
list in the Name field.

Click Select Members to select members from the Global Address List or your Personal Address
Book.
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4.

6.

Categories.,.. ,

Distribution fist Window
Once the address list displays, click on the name of ar - mdividual you wish to add to the distribution

list, then click the Members button. To select multiple names, hold down the Ctrl key while
selecting names. '

Ifthe individual is not on the global address list, you can click Add New in the Distribution List
dialog box. Clicking Add New displaysa dialog box in which you type the display name and e-mail
address of the individual you are adding to the distribution list,

Click Save and Close when you are done.

We know that the distribution lists are stored in the Contacts folder. To use a distribution list when

sending e-mail, click To button on the ¢-mail message screen, then select Contacts from the ‘Show Names
from the’ ficld in the Select Names dialog box.

11.12

Click on the name of your distribution list, then click To button, and then click OK button.
Creating Personal Folders

In the Inbox menu, select Tools>>E-mail Accounts, View or change existing e-mail accounts,

Click Next,

E-mail Accounts Window
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Now, click on New Outlook Data File button.

- New Outlook Data File

Select either Office Outlook Personal Folders Ftle(pst) or Outlook 97 2002 Personal Folders
File (pst) then click OK button. o _ _ o

In this next dialog box, you will select the location for your petsonal folders, Personal folders
should be stored in H:\Exchange or H: \Outlook $O that you.can access them from any computer that you
logon to,

Now you should follow these i mstructlons to complete this dialog box :

Click the triangle next to¢ Outlook’ inthe Save box. From the drop down list that dlsplays select’

the H drlve&

Thisknigy
I3 Fy Compndw
i Y T
E=A becat Bk 0
_i Rramcpsatind and Sevmac

i _ The H drive is the drive that is
X Mesd lobeled with your name. 1% is your
mmm B storage space on the file server.

28 ot -
- ot YrTmR L

e& wmmmmww

Dlalog Box

Once you have already selected the H:\drive, double chck the Exchange {or Outlook) folder to
bring up the followmg dialog box.
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PQHWFBHNI) e .

S Create or open Outlook data file
In the Flle Name box you should type aname for your personal folders, then click on OK button.

Create or Open Outlook clata file

Cllck OK button at the next dialog box will be d1splayed

i AR

Create Personal Folder
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You are returned to the E-mail Accounts Screen. Click 1he Finish button., Your Personal Folders
will now display in your Folcler List.

T

I —
& i Inbow 463 H
'{g e i

Personal Folders displayed in Folder

View,

Personal folder in folder view

Once you have created Personal Folders, youmay create subfolders to categorize your mail. To
create a subfolder, right click on ‘Personal Folders’ and from the shortcut menu, select ‘New Folder’.

In the Create New Folder dialog box, name the folder. Make sure the folder contains box indicates
Mail and Post Items, and that Personal Folders is selected in the ‘Select Where to Place the Folder’
box. Then ¢lick on OK button.

Create New Folder dlalog box
11.12.1Moying Mail to a Personal Folder

1. Tomove mail to a personal folder, select the message(s) you want to move. You may Shift+Click
to select a group of consecutive messages, or CtrHClick to select multiple messages that are not
. consecutive. :

2. With the message(s) selected, right click and select Move to Folder from the shortcut menu,

3. Select the appropriate personal folder from the list of folders that displays in the Move Items dialog
box.
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Note: You can also select the messages and drag them to the appropriate personal folder
11.12.2Managing Sent E-mail

Sometimes if you want to read or forward a message you have already sent. To access your Sent
ltems, click the My Shorteuts bar in the Navigation Pane.

Sent Items

The Sent Items folder contains ail of the items, e-mail, appointments, meeting requests, etc., you
have sent to other people. To view items you have sent, click the Sent Items Folder. The items listto the
rightin the Folder Pane. :

Outbox

The Outbox folder contains all of the items that are pending, but you could not see sent yet. This
feature only works when you are using Outlook in an Offline Mode. On campus, Outlook is configured
so that all messages are sent immediately. Therefore, no messages will be listed in the Outbox.

Drafts |

The Drafis folder contains the messages you started to commpose but have not sent yet. To complete
an unfinished message, click the Drafts Folder. Then open, complete and send the message.
11.13  Deleting Unwanted Messages

Ifyoudon’t want to keep the message, you can elick on the ‘X button, in the button bar, tosend
the message to a ‘Delete folder’.

Note: Thisis NOT the ‘X? button in the upper right corner of the screen. If you do click on the upper
right corner X, it will simply close the message and return you to the Inbox etc. When you delete a
message in the Inbox, it is sent to the Deleted Items folder to be ‘really deleted’ or recovered later.

Deleting Message

11.14 Printing a Message

Ifyouneed a printed copy of the message or e-mmail you can Click on the Printer button in the
button bar. ' -

Printing Message
OR
You can also click on File in the Meru Bar and then click on Print option,
11.15 Out of Office Assistant

- If you plan to be out of the Office fora day or longer, you can use the Out of Office Assistantto
automatically generate replies to any email you receive, while you are gone. In the Inbox Menu, select
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Tools>>Qut of Office Assistant. Complete the dialog box and click OK button when you have done.
Microsoft Outlook will automatically send the response you indicate for as long as ‘1 am currently Qut of
the Office’ is selected when you return to the Office, follow the above steps and click ‘L am currenily In
the Office’ to deactivate the Out of Office Assistant.

Click to activate the Out of Office Agsistant

Qut of Assistant

Self Learning Exercise
Q1.  Fillin the blanks
o (a) 'lhcoming email messages are StOTed i the. .. ..vvviveeerereess |
(b) eerrl i, . cODtAINS text that is automatically added to the end of outgoing email messages.

©) ...........allow you to move mail from the email server to your computer, theneby reducing the
chances of exceeding your mallbox s storage capacity.

(d) Byclickingonthe ....... e allows you to forward the e-mail to another individual.
T A{8) -errreeenieneennnennn . simplify the process of sending e-mail to groups.
Q2. State “True’/False’:

{a) Email can not be grouped in a variety of ways, such as date, conversation, senderete, (b) Ifi
you plan to be out of the office for a day or longer, you can use the Out of Office Assistant to
automatically generate replies to any e-mail you receive while you are gone. -

(¢} The messages that you have not yet read can not be accessed through the unread mail folder,
(d) Attaching a file does not send a file with your email to the 1écipien_ts.
(¢) The Sent Items folder contains all of the items, email, appointments, meeting requests.
Q3. Whatisanaddressbook? |
| Q4. What gmupiﬁg arrangements are available?

Q5. Howcanlcut down on spam and junk mail I receive?
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11.16 Summary

. This unitexplained the fundamentals of setting up your e-mail account and sending and receiving e-

mail messages. It also covered sending attachments, dealing with attachments that you receive, and using
the Inbox, Outlook data consists of items such as e-mail messages, appointments, and contacts, These
items are organized into folders that are, in most cases, specialized to hold a single type of item. Folders in
turn are stored in a Personal Folders file that also contains your account information and other Qutlook
settings,

1117 Glossary
Toolbar: alloWs quick access to many of the features available in Microsoft Outlook.
Mailbox icons : visually describe the status of your mail.
Information Viewer : your e-mail messages are displayed to the right inside it.
- Spell checking : The spell checkiné is done by pressing <F7> key manually.
Signature : allows you to automatically add text to the emails you send.
Persona) Address Books : are used to store e-majl addresses,
Distribution Lists : is the process of sending e-mail to groups.
Personal folders : allow you to move mail from the e-mail server to your computer.
Sent Items folder : containg all of the ftems, email, appointine_nts, meeting requests.
Outbox folder : contains all of the items that are pending, but you could not see sent yet,
Drafts folder : contains the messages you started to compose but have not sent yet,
I1.18 Further Readings | -
¢ Microsoft Office 2003 for Windows; S. Sangman
e Microsoft Office 2003 Suite -A Comprehensive Approach, McGraw Hill
e Microsoft Office 2003 Bible by Edward Willet |
- ¢ Mastering Microsoft Office2003 Professional Edition by Gini Courter
» Mastering Microsoft Office 2003 for everyone - Sanjay Saxena : TMH
11.19 Answers to Self Learning Exercise
1. Fillin the blanks :
@lbox
(b) Asignature file
(c) Personal folders -
(d) .Forwa:rd button
(¢) The distribution lists
2. '.State “True’/‘False’ : -
(a) False |
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(c) False
(d) False
(¢) True

3. Outlook has multiple address books. The contacts list stores your own list of addresses and -
7 distribution lists that will be maintained on the server. The Global Address list contains all users and
distribution lists on your Exchange server.

4. Email _rnessages can be sorted by various categories—Date, Conversation, From, To, Size, Subject
and several others, ' _

5. Outlook has a junk mail filter than must be turned on, When you first install Outlook, you are
prompted to activate the junk mail filter, but you can setup junk mail by following the instructions
below: o

From the Tools menu click on Options and click on Preferences tab ifit is not already selected.
From the preferences tab Click on the Junk Mail button.

You must now just select to use Low, High, or filter all but ones you note. Starting with Lowis a
~ good idea, just to see how well initially filtering goes.

11.20 Unit End Questions _
1. Explain the role of word processor as an e-mail editor in brief?
- Write the common steps to setup an e-mail account?
What is the purpose of personal address book in Outlook?

What is an auto-signature? How would you create a signature file?

LA

Expand the following terms —
(a) SMTP

(b) POP3

() ISP

(d) TCP/IP -

(¢) BCcand Cc
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Unit 12 : Data Base Package

Structure of the Unit

12.0
12.1
12.2

12.3
12.4
12.5
12,6
12.7

" Objective

Introduction

Understanding Databases

12.2.1 Access concepts and Terms
Creating Database

Creating Tables

Primary Key

Reference Key adding

Editing and Viewing data

12.7.1 Editing records

12.7.2 Deleting records

12.7.3 Adding and deleting columns

' 12.7.4 Resizing rows and columns

12.8

12.9

12,10
1211

12,0

12.7.5 Freezing columns

12.7.6 Hiding columns

12.7.7 Finding data in a table

12.7.8 Replace |

12.7.9 Check spelling and Atltocorj'ecf_
12.7.10 Print a Datasheet

Sorting and Filtering -

Summary N

Unit end questions

References

Objective

After studying this unit, you will learr -

Introduction of Databases

" How to create Database

How to create tables

Primary key
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e Reference key |
o FEditing and viewing data
o Sorting and filtering data

2.1 Iniroduction

A database consists of an organized collection of data for one or more multiple uses. One way of
classifying databases involves the type of content, for example: bibliographic, full-text, numeric, image.
Other classification methods start from examining database models or database architectures. Other models
such as the hierarchical model and the network model use a more explicit representation of relationships.

We'll take a look in this module at how this database management system can help you to collect,
find and use mountains of data You can create a database in either Access or Excel. Microsoft Office
Access, previously known as Mierosoft Access, is a pseudo relational database management system
from Microsoft that combines the relational Microsoft Jet Database Engine with a graphical user intetface
and software-development tools.

We illustrate the construction process with MS-Access is that it is a widely available tool. Anybody
who has Microsoft Office with MS-Word, also has Access and the programming language Visual Basic
behind Access. . . : .

Access is referred to as a relational database system for two reasons:

1. Datais organized into tables which are also called relations. This is because each tablehasa -
subject (i.e. tbIPersonnel for employees) and every field in a given table is supposed to be directly
related to the subject of the table. If you look at the design of the Personnel table, you will see that -
each of the fields is a piece of information that pertains to a given employee. You also won’t see
more than one address for an employee or more than one job title. o '

5. Tables can be linked or related to each other. In the sample database, this is demonstrated by the :
link between tblPersonnel and tblAbsences . Since there'can and likely will be more than one
absence for each employee, the absence information is placed in a separate table and the two
tables are linked by a number assigned to the employee. This eliminates the duplicate entry of
information such as the employee name and department. This, in turn, reduces the size of the ﬁ
database and the possibility of data entry error and corraption. . g

- $JobTitte

L Deparkrrnsnt
={MireDate
StartDate
girthDake

12,2  Understanding Databases
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Databases consist of software-based “containers” that are structured to collect and store information
S0 users can retrieve, add, update or remove such information in an automatic fashion, Database programs
are designed for users so that they can add or delete any information needed. The structure of a database
is tabular, consisting of rows and columns of information.

MS-Access is also a good illustration of many principles that exist on other platforms too, for
instance arelational database, a Graphical User Interface (GUI), event handling, and an object-oriented
programming language. MS-Access contains all of these parts — cooperating reasonably smoothly.

Access is an interactive, relational database management system. A database is an organized
collection of data stored in categories that are accessible ina logical or practical manner. Relational databases
enable data to be stored in multiple tables linked together via data indexes. This makes working with the
data faster and easier. Once entered into the database, the data may be manipulated or viewed in various

_ ways such as by sorting or by specially set-up quertes and reports.

12.2,1 Access Concepts and Terms

_ Microsoft has its own take on certain standard DBMS terms, and has added a few new terms to
. the database world. The basic features of Microsoﬁ Access are as follows:

a) Database : A database is simply a collection of useful data, A phone book is an example of
database. Access databases include such “objects” as tables, queries, forms, and more. In relational
databases such as Access, data is stored in tables made up of one or more fields (Access calls a
column a field). The data stored in each column must be of a single data type such as Character,
Number or Date. A collection of values from each column of a table is called a record or arowin
the table.

| Different tables can have the same column in common, This feature is used to explicitly specifya
relationship between two tables, Values appearing in column A in one table are shared with another
table _

b) Tables : Tables are the main units of data storage in a database. A table is a collection of data
about a specific topic; it is made up of one of more fields,

¢) Field : A field is a column in a table and defines a data type for a set of values in a table. For
example, a mailing list table might include fields for first name, last name, address, city, state, zip
code, and telephone number,

d) Record: Arecord inarow ina table and is a set of values defined by fields. In a mailing list table,
each record would contain the data for one person as specified by the intersecting fields,

e¢) DataType : Data types are the properties of each field. A field only has one data type, such as
Character, Number or Date.

f) Primary Key : A primary key is a value that can be used to identify a unique record in a table. _
g} Design view : It provides the tools for creating fields in a table,
h) Datasheet view : It allows you to update, edit, and delete in formation from a table,

12.3 Creating Database

In Microsoft Access a database consists of one single file. The file contains all the tables of the
database, the relationships (the crow’s feet), queries (computed tables), forms (user windows), and many
other things. As a systems developer you will design tables and user windows. As a user youwill enter data
into the tables (usually through user windows)and get data out of the tables, for instance through the same
windows or throtigh printed reports, In Access it is very easy to switch between the developer role and the
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user role. As a developer you will typically design some tables, then switch to the user role to enter data
into them, then switch back to the developer role to change the design, design more tables, eic. Access can
to alarge extent restructure the data that already is in the database so that it matches the new table design.

Create the database

1. Locate the Access program. Depending on the way the system is set up, you may find it under
Programs-> Microsoft Access or Programs -> Microsoft Office -> Microsoft Access.

2. InAccess 97 and 2000: Open Access and ask for a “]:;lank” database.

In Access 2003: Open Access and click the New icon (under the File menu). Then click Blank
~ database in the help area to the far right.

3. Access now asks where to store the new database. Select the folder you want and give the
database the name hotel (or hotel.mdb).

The above screen now shows the database window, We have selected the Tables tab, but there
are no tables or other things in the database as yet. However, you see three icons that can create tables for
you. When you have created a table, it will appear in the table window and you can then Open it and enter
data inito it, or you can Design it, i.e. change the definition of it. (In Access 97 the database window looks
like a traditional tab form. There are no create-icons, but function buttons for the same purpose).

124  Creating Tables

In Access, fables are collections of similar data. For instance, if you ran avideotape rental store,
youmight have an Access table that collects information about each tape you own(title, running length,
date purchased and so on). Youmight also have a different table that collects customer’s names and phone
numbers, membership numbers, addresses and so on. There might be yet another table where you keep
information about which customer has reserved which tape for which night, and so on . With Access, all of
these tables would be organized differently, and contain mostly different information ; but they’d allbe in
the same database file.

1. By clicking the Table tab on the left hand side, you will find Access provides three ways to create
atable for whi(_:h there are icons in the Database window.

e Create Table in Design view will allow you to ereate the fields of the table. It allows you to
define the fields in the table before adding any data to the clatasheet This is the most common way
of creatmg atable and is explained in detail below.
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® Create table by using wizard will step you through the creation of a table.

® Create tabie by entering data will give youa blank datasheet with unlabelled columns that looks
much like an Excel worksheet.

2. - Double clicking on Create table in Design view displays the Table Design screen where you define
fields for your table. The screen is divided into two parts: a top pane for entering the field name,
data type, and an option description of the field and a bottom pane for specifying field properties.

Aot Time
L sy
AEC ML

"

3. .~ Everytable consists of fields. For each field, specify the name of the field, the type of data, and any
description needed to determine what data the fietd contains. Pressing the Tab key moves the cursor
from one column to the next in the Table Design screen. You can select the data type from the drop-
down list in the Data Type column , - ‘ :

4, As afinal step, the table must be saved. Pull down the File Menu to choose Save, A dialogue box will
pop up where the name of the new table should be specified. Access gives a default name such as
“Table1” or“Table2.” Simply type over this default name with the name of the table. Forthis example,
name the table “Book_Info”, then click OK. '.

i

] {Bosle_Info .

5. Atthis point, the new table has been created .an-d"saved. Switch back to the Access main screen by
pulling down the File menu and choosing Close. This will close the Design View for the table and
display the Access main screen. Notice that the new Book_Info table appears below the Table
tab. ' :

deivpw. § U " s
Craata eatile in Diaaigr whowy
Creats table by Lsing wizard “ ;
mraata table by antaring dats ; ) . ]

InAoo&ss,- there are number of fields in table which are used to define the characteristics of particular
information .
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a)

b)

Field Names : Field names can be up to 64 characters long, and include spaces and numbers,
Simply click in the first empty field name box and type a unique , meaningful field name.

Data Types and Properties : Access otfers eight data types for its fields, and each type offers a
variety of options called properties, It is important to understand what the different types and
properties do; and when to make which choices. For example, although postal zip codes are
numbers, you will probably not want to put them in a numeric field. Same goes for telephone
numbers, social security numbers etc. Youcan choose a field’s data type by clicking on the little
arrow in the current field’s Data Type column, This display a list, from which you choose an

appropriate type. :
Once you’ve chosen a fields data type, its property list is displayed in the béttom halfof the dialog |

box. Difierent data types offer difterent properties. Properties let you specify things like the maximum
length of entries, how the entries will be formatted, whether an entry is requlred ornot, and so on,

)

Text Fields : Text is the default data type. you use the text data type when you need to store
words, obviously, But it is also a good type to use for ﬁelds lhat will contain part numbers Soc1al
Security numbers, or zip codes. G _

Text fields can be indexed, so that Access can find pie‘ces of it quite quickly. Unforttmately, atext
field can not contain more than 255 characters ; for longer text entries, you must use the memo

datatype. .
There are ten possible Text field properties, Which are: -
Field size '

Foi-mat

~ Input Mask

Caption

Default value
Validation rule |
Validation Text
Required

Allow Zero length
Indexed

Unicode compression

Field Size : The Field Size of a Text field can be anything between 1 .and 255 characters. Smaller o
sizes save disk space, but you shouldn’t make the setting too small unless disk space is s at a
premium. _

Format : The format property forces entries to appear accordmg to the characteristics you specnfy '
For instance, to force all text to upper case, regardless of how it is entered, you can place a
>(greater than sign) in the space next to Format. Conversely, a<(less than 51gn) forces all textto
lower case. : -

iii) Input Mask : Input Mask provide things like parenthesis around area codes in telephone mimbers;

time and date formats, etc. The Input Mask Wizard can help you to pick and experiment with
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iv)

vi)-

predefined masks. The wizard will launch when you click on the small button at the right edge of
the Input Mask property box.

Caption : The Caption property lets you specify replacement text for the name of the field as it
appears on screen. Captions thus have the same effect as labels. For instance, if you have a field’
named “Postal Code” you might want the onscreen caption or label to read “ZIP Code.” Type the
desired label in the space for the caption property.

Default value: This property lets you specify a value that will be automatically entered int the
field whenever you create a new record. For instance, if you want the word “Member” to appear
in the field you would type Member in the space for default value, Although the default entry will
then appear automatically whenever a user is entering new records, the user can edit, replace, or
delete it. ' '

Validation rule : This property lets you specify error checks. For instance, if an entry must be at
least 12 characters long, you can create an expression here to check for this. '

* vii) .Validation Text: You can place desired error message here, like “Oops! Part numbers are atways
' 12charactersinlength.” When an entry violates rule, the error message text will appear on screen.

Vi) Required : You can use this Yes/No field to tell Access if an entry is required in the field you are

2)

3

ix)

designing. You can change the setting here by clicking on the space next to required and then
picking Yes or No from the drop-down list.

Allow Zero length : We know that there is a difference between “nothing” and “I don’t know”.

. Sometimes, when entering data, users leave a field empty because there is no data for that particular

~  field in that particular record, Other times users leave a field empty because they don’t know the -

correct data to enter. For example, when entering datain an employee database, you might leave
aparticular field empty for one employee- say a field for Assigned Parking Space- either because

 she does not'have_ an assigned space or because you don’t know her parking space number. So
-+ thedifference between “None™ and “Idon’t know” is frequently distinguished as follows:

- a) For“None”, the user enters a zero length, or null, éharacter by typing two double quote marks

x)

.- with no spaces between them(“”).

- -+ by For“Idon’tknow,” the user simply skips the field.

Tndexed : You can use this Yes/No field to tell Access if a field is to be indexed for speedy

lookups. You can change the setting here by clicking on the space next to Indexed and then picking

~ Yes or No from the drop-down list. You can also choose to permit or prohibit duplicate records.

xi)

- maximum character counts and the fact that it does not offer an Input mask property, the Memo -

Unicode compression : This is a concern because Unicode employs two bytes per character,
which for western character sets includes the normal ASCII value as the low order byte and zero
for the high-order byte. This would make text fields twice as large as in older versions of Jet. Access,
for no useful reason for many users. _ '

Memo Fields : A field of the Merrito data type can hold up to 64,000 characters. Howev.er, it

can’t be indexed , so use it only for data that will exceed 255 characters per endry. Other than

fields property options are identical to those of the Text field.

Number Fields : The number data type should be used:

‘When you are collecting data to be used for computatiohs.

When you want to require someone to enter only numbers.

When you want to format entries with things like decimal places and currency symbols,
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Number field properties affect both the precision of numbers and their appearance.
The following fields belong to the Number field format:

Field size: The table that follows summarizes the available Field size choices and their specifications,
Some field sizes use more disk space than others, with a resulting increase in precision:

FIFI D ST7F DFSCRIPTIAN
| Donble (The defardt) gtores nurbes wath 13 d_sg_t% of memsmn
Single States naznbezs with 7 digits of pecision,
Byke Use | byte to stors whole munbers from 0 te 253,
Indezer Uses 2 byles to stowe whole nurders(no fracfion
Long Integer - Uses Aloyes to store whole amabers(no fraction)

Format ; The format property lets you choose the on-screen and printed appearance of numbers.
This does not change the internal precision of the numbers, thus it does not affect things fike -
storage and computations. There is a drop-down list that lets you see and pick the desired formats,
which include commas, currency symbols, scientific notation etc.

| iii) Decimal Places: This property tells Access how to display numbers, For example, with the

v

~ Format set to fixed, if you enter 1,123 in a field and the Decimal Place option is set to 1, Access

will only display 1.1. This does not affect the precision of data or computations the way choosing
aField Size does. Leave the default Auto setting, type a number from 0 to 15, or pick a number
from the available drop-down list.

w) Input Mask: This is a great setting for controlling data entry. Whenever a user moves to a field

with an input mask, Access places a template inside the field to guide the user in entering the data.

'For ashort date like the format used in thlPersonnel, the user would see something like this:

_B10Q004  BALO04 - AR
an DQDDAL_ |

Access also uses the input mask to create a password field where all characters entered are
displayed as “*” as they’re typed. As with the Format setting, you can select from pre-defined

‘masks based on the data type ot you can create your own. Form fields will inherit masks from the

table fields they are based on. S
NOTE; The other number properties(Caption, Default Value, Validation Text, Validation Rule,

. Required and Indexed) are identical to those previously described under “Text Fields.”

Dzitefl‘ ime Fields : The Date/Time data type lets you enter dates and times in a variety of formats.
Available Date/Time properties include many you will recognize from earlier field types :

1) Format
2) Input Mask
3) Caption
4) Default value
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'6)
7

. 8)

12.5

5) Validation rule
6) Validation Text
7) Required

8) Indexed

Currency: Use the currency data type when you want to store information about money. The
options listed are based on the international settings found in your Windows Control Panel, Standard
American currency options include General Numbers, numbers with dollar signs, etc., but yow’ll
probably want to leave it at the default setting(which provides dollar signs, commas, and two
decimal places). If you want you can create your own custom settings.

' You can specify a decimal position in the Decimal places section of the field Properties lst. It

includes these fields;
1) Format

- 2) Decimal Places

3) Input Mask

4) Caption

5) Default value
6) Validation rule
7) Validation Text
8) Required

9) Indexed

“Tochoosea specific decimal setting, either type the desired number of decimal places to replace

the defanlt setting auto, or click on'the drop-down list to see the options available . the rest of the
Currency field properties (Caption, Default value, etc. ) work as you’d expect,

‘Counter Fields: To have Access automatically number each record as you add them , use the

Counter data type. Many users define the Primary key field as a counter field.

Counter field properties include Format, Caption, and Indexed. Normally you’ll leave them alone,
except perhaps for the Caption property.

Yes/No Field : Use the Yes/No data type when you want to give users a field with only two entry
choices, like Yes or No, On or Off, or True or False, or pethaps Male or Female, Paid or Unpaid-
in short, any either/or value you want, You can specify a defalt answer(like No).

In addition , you can specify a caption for the field if you don’t want to use the field name as a
caption . Validation rules are possible. '

OLE Object Field : Finally , you can define a field as an OLE Object field. This makes it possible

_toround up and use OLE objects like video clips, audio clips, graphs, etc

Primary Key

Access needs a unique way to identify each record in you tables. To do this either you or Access

must create what is called a primary key, Thete can only be one primary key in a table, but primary key
can use multiple fields. - : .
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A Primary key field is a field that is used uniquely to identify edch record. The field can be used by
Access to manipulate data more efficiently. You do not have to specify a key. If you wish to use one, -you
can choose an existing field or, if you answer yes to the prompt for Access to create a Primary key, If you
let Access automatically create the primary key for you, Access will add a Counter field that will assign a
unique number to each new record that you create. If you wish, you sometimes rename this field and use it
for additional purposes. Access will create an extra field containing an ID number for each case.

1. Each table in your database should have a “primary key.” A primary key is a field that uniquely
identifies each record in the database. In a database of book collection, there might be two books
with the same author so author is not a good primary key. However, every book has a unique “call
number”, so “call number” would be a good choice for a primary key. To set the primary key for
your table, highlight the key field and choose Primary Key from the Edit menu,

s IR R

2. When the primary key is set, you should find a little key icon next to the field name on the left side.
Note: To remove a primary key, simply repeat this procedure to toggle the primary key off.

Primary Key can be defined as:
e The Primary Key uniquely identifies a record within a t'éble.
¢ The Primary Key establishes a relationship between two tables.
o The Pr.imaJyKey is usually an auto-geﬁerated number.
¢ Example: “ContactType ID” is the primary key.in the Contact Types table.
12.6 Reference Key adding

A foreign key is a field (or several fields) that refer to something unique in another table - -usually the
primary key. Be careful here. The foreign key and the primary key must have the same type. However,
when the primary key is an AutoNumber, the foreign key must be a long integer.

Foreign Key can be defined as:
o The Foreign Key is a field from one table placed into another table,
e The Foreign Key facilitates a relationship between two tables.
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Example: “ContactType I is the foreign key in the Contacts table

e 10 | gt name

.. 1:Sam’s StockPot - C Sam WO“Q
2 Loonie Mart #107 K - _;BlllWllhams e
.3 Rosth Dry Goods Ihe. K Alice McRorie
4 Gadgets"R"Us ¢ Leslig Cranfield-Jones
5 The Chefs Assmtant N ) Andre Qulette
l,‘AumNumber] '

12.7 Editing and viewing data

You could open the table and add records in this fashion if you choose. At the database window
right click the table and select ‘open’

Add new records to the table in datasheet view by typing in the record beside the asterisk (*) that
marks the new record. You can also click the new record button at the bottom of the datasheet to skip to
the last empty record.

1251 Editing Records

To editrecords, simply place the cursor in the record that is to be edited and make the necessary
changes. Use the arrow keys to move through the record grid. The previous, next, first, and last record
buttons at.the boitom of the datasheet are helpful in maneuvering through the datasheet.

12.7.2 Deleting Records

Delete a record on a datasheet by placing the cursor in any field of the record row and select
EditDelete Record from the menu bar or cllck the Delete Record button on the datasheet toolbar.
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12.7.3 Adding and Deleting Columns

Although it is best to add new fields (displayed as columns in the datasheet) in desigh view because
more options are available, they can also be quickly added in datasheet view, Highlight the column that the
new column should appear to the left of by clicking its labe] at the top of the datasheet and select Insert|Column
from the menu bar. '

Entire columns can be deleted by placing the cursor in the cohumn and selectmg Edit[Delete Colimn
from the menu bar.

12.7.4 Resizing Rows and Columns

The height of rows on a datasheet can be changed by dragging the gray sizing line between row
labels up and down with the mouse. By changing the height on one row, the height of all rows in the
datasheet will be changed to the new value.

Column width can be changed in a similar way by dragging the sizing line between columns. Double
click on the line to have the column automatically fit to the longest value of the column. Unlike rows,
columns on a datasheet can be different widths. More exact values can be a351gned by selecting FormatRow
Height or Format|Column Width from the menu bar.

12.7.5 Freezing Columns

Similar to freezing panes in Excel, columns on an Access table can be frozen, This is helpful if the
- datasheet has many columns and relevant data would otherwise not appear on the screen at the same time.
Freeze a column by placing the cursor in any record in the column and select FormatjFreeze Columns from
the menu bar. Select the same option to unfieeze a single column or select Format|{Unfreeze all Columns,

(941) §55.1734
(941 £55

12.7.6 Hiding Columns

Columns can also be hidden from view on the datasheet although they will not be deleted from the
database. To hide a column, place the cursor in any record in the column or highlight multiple adjacent

columns by clicking and dragging the mouse along the column headers, and select Format{Hide Columns
from the menu bar.

To show columns that have been hidden, select Format|Unhide Columns from the menu bar. A
window displaying all of the fields in the table will be listed with check boxes beside each field name.
Check the boxes beside all fields that should be visible on the data table and click the Close button.
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12.7.7 Finding Data in a Table

12.7.8 Replace

Data in a datasheet can be quickly located by using the Find command.
Open the table in datasheet view.

Place the cursor in any record in the field that you want to search and select Edit|Find... from the
men bar. )

Enter the value criteria in the Find What: box.

From the Look In: drop-down ment, define the area of the search by selecting the entire table or
Just the field in the table you placed your cursorin during step 2.

Select the matching criteria from Match: to and click the More > button for additional search
parameters. : '

When all of the search criteria is set, click the Find Next button. Ifmore than one record meets the
criteria, keep clicking Find Next until you reach the correct record. '

‘\whaole Field

The replace function allows you to quickly replace a single occurrence of data with a new value or

to replace all occurrences in the entire table, :

Select EditfReplace... from the menu bar (or click the Replace tab if the Find window is already
open). '

Follow the steps described in the F ind procedure for searching for the data that should be replaced
and type the new value of the data in the Replace With: box.
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» Click the Find Next button to step through occurrences of the data in the table and click the
Replace button to make single replacements, Click Replace All to change all occurrences of the
data in one step.

Find and Replace -

12.7.9 Lheck Spelling and AutoCorrect

The spell checker can be used to flag spelling errors in text and menu fields in a datasheet. Select
Tools|Spelling from the menu bar to activate the spell checker and make corrections just as you would
using Word or Excel. The AutoCorrect feature can automatically correct common spelling errors such as
two INitial CApitals, capitalizing the first letter of the first word of a sentence, and anything you define.
Select Tools|AutoCorrect to set these features.

12.7.10 Print a Datasheet

Datasheets can be printed by clicking the Prmt button on the tootbar or select File|Print to set more
printing options.

12.8 Sorting and Filtering

Sorting and filtering allow you to view records in a table ina different way either by reordering all
of the records in the table or view only those records in a table that meet certain criteria that you specify.

Sorting

By default, Access displays the table data in the order in which it was entered, You can sort an entire
table by opening it and using the Sort option from the Records menu. You can choose an ascending or
descending sort. You can also use the Filter window to produce a sorted listing of filtered records by
clicking on the Sort Cell in the Filter window and choosing the required sort from the drop down menu,

Youmay want to view the records in atable in a different order than they appear such as sorting by
adate or in alphabetical order, for example. Follow these steps to execute a simple sort of records ina
table based on the values of one field:

1. Intable view, place the cursor in the column that j/ou want to sort by.

2. Select Recordé|Sort|Sort Ascending or Records|Sort|Sort Descending from the menu bar or click

the Sort Ascending or Sort Descending buttons on the toolbar.
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To sort by more than one column (such as sorting by date and then sorting records with the same

date alphabetically), highlight the columns by clicking and dragging the mouse over the field labels and
select one of the sort methods stated above,

Filtering

Using Find will only display one occurrence of a search value at atime, To find all records witha

field containing a certain value, use a filter.

1) Filter by Selection %z

This feature will filter records that contain identical data values in a given field such as filtering out’
all of the records that have the value “Smith” in a name field. To Filter by Selection, place the
cursor in the field that you want to filter the other records by and click the Filter by Selection -
button on the toolbar or select Records|Filter|Filter By Selection from the menu bar. In the example

below, the cursor is placed in the City field of the second record that displays the value “Ft.
show only the records where the city is Ft. Myers.

Filter by Form

Hthe table is large, it may be difficult to find the record, that contains the value you would like to
filter by so using Filter by Form may be advantageous instead. This method creates a blark version
of the table with drop-down menus for each field that each contain the values found in the records
of that field. Under the default Look for tab of the Filter by Form window, click in the field to enter

the filter criteria. To specify an alternate criteria if records may contain one of two specified values,

click the Or tab at the bottom of the window and select another criteria from the drop-down
menu. More Ot tabs will appear after one criteria is set to allow you to add more alternate criteria

forthe filter. After you have selected all of the criteria you want to filter, click the Apply Filter
 button 5 | -

onthe toolbar.

The fbllowing methods can be used to select records based on the record selected y that do not

1ave exactly the same value. Type these formats into the field where the drop-down meny appears instead
f selecting an absolute value.
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Lo " Filter by Form
Format ' Explanation
Like “*Street”|Selecz &l records th st end with " Street”
<="G" Selects all records that begin with the fetters A through G
>1/1f00 Setects al dates since 171700
<> 0 Selects aff racords not aqual to zera

3) Saving AFilter -

_ The filtered contents of a table can be saved as a query by selecting File|Save As Query from the
- menu bar. Enter a name for the query and click OK. The query is now saved within the database.

4
To viewall recbrds in a table again, click the depressed Apply Filter toggle button on the toolbar,
"To perform several filters and sort functions at the same time vise the advanced filter option:
e Openthe tabie from the database window.

s Choose Advanced Filter/Sort from the Filter option in the Records menu. This will open a Filter
window in which you can define the records you want to see.

o Click onthe required field listed in the upper part of the window and drag it down to the first Field
cell in the lower part of the Filter window. Or double click on it to copy it automatically.

e Specify search criteria by typing the required value in the first Criteria cell.

o To apply the filter, choose Apply Filter/Sort from the Filter menu. The reguired records will be
displayed in a datasheet view.

For example, if you wanted to see all the records of people from an address database living in
London and thete was a field in the table called Town, place the Town field in the Field cell then type
‘London’ in the criteria cell. The Filter window would like this:

Remember that you can specify any number of fields using this method.
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12.9

Summary

This process of organizing data in Access or any other type of database is called data normalization,

A normalized database follows a set of rules known as Normal Forms. While I’ve provided a practical
example of this process, Microsoft’s support site also offers a couple of very good articles which detail
the rules of normalization and provide more examples.

- 12.10
I.

2
3
4
5.
6
7
8
9

10
12.11

SR W

Unit End Questions

Define the use of Relational database. Also explain the role of MS ACCESS in Microsoft windows
2000. . _

- What are'the advantages of MS Access Database.
3. Howto create a Database in MS Access?

- What is the procedure to create a table in MS Access,

What is the difference between Primary and Foreign Key. Explain with suitable examplé.

. How does Sorting method work in Databases? Explain with an application,
- What does Fiitering mean? And how it can be implemented on databases?
. Define the functions of different data types for different Fields.

. Howtoedit data in existing Databases 2

+ What is the difference between MS Excel and MS Access in Microsoft Windows.

REFERENCES
http:/;’WWW.fgcuedufsupportfoﬁice2000!access/ﬁltersort.hhnl
http:l/www.kamueyd&sig]works.comftutorials_daxabases.htm _
htlp:f/cisnet.baruch.cuny.edu/holowczak/classesfﬂOOfaccess/accessall.-html
http:/fmsdn.microsoﬁ.oonﬂen—usfliibrary!aa662945(ofﬁce. 11).aspx
http:!/www.oneil.com.aWpc/acces&stillgNﬁcrosoﬁAccess4-F ormsReports pdf
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Unit 13 ; Query in Data Base Package

Structure of the Unit

13.0  Objective.:
13.1  Inwroduction
13.2  Understanding Query
13.2.1 Design view
13.2.2 Create a Query
13.2.3 Entering criteria
13.2.4 Sorting data in a Query
133 JoinQuery
134 Relationship
135 Query
© 13.5.1 Select Query
13.5.2 Action Queries
13.5.2.1 Update Query
13.5.2.2 Delete Query
13.5.2.3 Append Query
13.5.2.4 Make table Query
13.6  Crosstab Query
13.7  SQLviewofqueries
13.8  Summary
13.9  UnitEnd questions
13.10 References

13.0  Objective
Afier studying this unit, you will learn-

¢ Introduction of Query

How to create Query

Use of Join query

Relationship Query
Function of Action Query
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o Useof Crosstab query _ -
s Sql view of Query
13.1 Imtroduction

As tables grow in size they can have hundreds of thousands of records, which makes it impossible
for the user to pick out specific records from that table, Queries were designed to combat this problem.
With a query you can apply a filter to the table’s data, so that you only get the information that you want.

Access offers the ability to answer questions. The answer to these questions, and many more are
found in the database, and Access can find the answers quickly. When you pose a question to Access, the
question is called a query. A query is simply a question represented in a way that Access can understand.

You use queries to view, change, and analyze data in different ways. You can also use them as the
source of records for forms and reports. The most common type of query is a select query. A select query
retrieves data from one or more tables using criteria you specify, and then displays it in the order you want.

Note: Makingfchanges te a query record or deleting a record in a query will affect the same record in
the related table. ' '

13.2 Understanding Query

After Tables, Queries are perhaps the most important component in a database. Queries are used
to retrieve information from a database. Once again, a telephone directory can be used for an example of

aquery.

When you look up.2 phone number in a phone directory, you use query techniques. You might
begin by looking for names that begin with J. Then you might narrow it down to listings with the last name
Johnson. The criteria for your query is Last Name = Johnson. If there are still too many results, you may

add additional criteria to narrow down the results. E.g. Initials, Suburb, street address. Eventuatly, your
criteria will narrow down the results until you have the result you are after.

13.2.1 Design View

The design grid is used to setup a query in Design view.

Fust Mame

There are two sections in design view:
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o The top section’is where the table or query will be displayed from which you are basing your new
query. Inside each table or query window will be listed the field names.

o The bottom section is where the ﬁeld names are moved to set up the criteria or other options to
base the query on.

e Inthe bottom section, each row will consist of a row heading to describe its purpose. You will find
the following:

~N
~ Field for the field name. Calculations can also be made in this cell to display the result based on
an expression. (See the Calculated Fields section for examples.)

— Table for the table or query name.
— Sort for sorting the query by ascending or descending.

— Show to select whether the data in that field is displayed or not.
— Criteria to enter the criteria for the query.

By going into the View menu and clicking Totals, the Totals row heading will be added to the
design grid. Click the drop-down arrow to display the results of a calculation in a field, based on a
- predefined calculation such as, sum, average, count, minimum, maximum, standard deviation, or variance,
You choose total calculation for each field if you want to calculate.,

13.2.2 Create a Query

1. Toconstructa query, Click on the New button in the database window as shown below. Choose
Design View, click OK.

Simpla aery Wizard
- Crosstab Query Wizard

Firid Doplicstms Omey Wizard
1Find uUnmatched Guary Wizard

2 Cweai:e WY t&uar‘y‘ w.l ke
i a-:wnzar;l. ;

|

|
4
2
|
i

e cgm_:__ql__ ]

2. Inthe Show Table chalog box as shown below, you will be asked to choose a table/tables forthe

query. Select the tables you want to query and click Add.

3. Add fields from the tables to the new query by double- clicking the field name in the table boxes
or selecting the field from the Flelcl and Table drop-down menus on the query form. Specify
sort orders if necessary.
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4. Enter the criteria for the query in the Criteria field. The Expression Builder can also be u_sed' to
assist in writing the expressions in the Criteria field.

5. Afieryouhave sélected all of the fields and tables, click the Run button on the toolbar to
execute the query. Figure shows the query result, records that match the criteria you set.

Juthor ID i Title Aduthoi LastiFam

BMicrosoft heces Alewander

- 6. Choose Save from the File menu to save aquery for later execution.
7. Toseethe re_ﬁults of the query, i.e. run the query, click the Run button on the toolbar.
13.2.3 EnteringCriteria

To enter criteria, enter them on the Criteria row in the design gird below the field name to which '.
the criterion applies. :

e, Wiy WildeSkdS and Expres sion Opaatabe.
%igzi:;grf Explanation
7 Strest The question mark is a wildcard that takes the
- |place of a single letter,
43th * The asterisk is the wildcard that represents a
number of characters, :
<100 Valye lsss than 100
=1 Value greater than or equal to 1 ;
<> "FL” Not equal to (all states besides Florida) ?
Between 1 and [Nurnbers between 1 and 10
10 . .
Is Nuit Finds records with no value :
Is Not Null . Jor all records that have & value Q
Like "a*" All words baginning with *a”
>0 And <=10 |Ail nurnbers greater than 0 and lees than 10
“Bob" Dr "Jane” fvalues ars Bab or Jane
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1) Text: To use text data in criteria, simply type the text in the Criteria row below the corresponding
field name. For example, to indicate that the student’s Last Name is ‘Jones’, you would type Jones
in the Criteria row below the Last Name field.

2) Wildcards: Two special wildcards are available. The first of the two wildcards, the asterisk (*),
represents any collection of characters. For example in the Last Name field criteria, typing Sm*,
means any last name that starts with Sm followed sy any collection of characters. The other
wildcard symbol is the question mark (?) which represent any single character. For example, T?m,
could be Timor Tom.

3) Numeric Data: To enter a number in a criterion, type the number without any dollar si gnsor
commas,

4) Comparison Operators: If you want a result other than an exact match, you must enter the
appropriate comparison operator. The comparison operator are > (greater than), < (less than),
>=(greater than or equal to), <= (less than or equal to), and NOT (not equal to).

Using Compound Criteria

To query with more than one criteria you must use a compound criteria. Two types of compound
criteria exist. '

a) In an AND criterion, each individual criteria must be true in order for the compound criteria to be
true. For example you would use an AND criterion to find students that are Freshman AND who
 are Economics majors. To combine criteria with AND, place the critetia on the same line.

b) In an OR criterion, is true if either individual criteria is true. For example you would use an OR
criterion to find students that are Freshman OR who are Economics majors, To combine criteria
with OR, the criteria must go on separate lines in the Criteria area,

13.2.4 Sorting Data in a Query

To order records in the answer to a query in a particular way, you sort the records. The field or
fields on which the records are sorted is called the sort key. To sort the results of the query, you must
specify the sort order in the Sort line of the design grid below the field that is to be sorted. If you specify
more than one field to sort, the field sorted on the left will be sorted first and the one on the right will be
sorted next. ' '

13.3 JOIN QUERY

Joins dictate how two tables or queries relate to each other, Click on the join line with the right
mouse button to access the Join Properties.

1. Select Join Type to display the join properties dialog box, and then choose one of the following -
options to define how the tables will be joined and select OK. ' -
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a) Option 1, the default, creates an equi join(also called an inner join), in which the records that
contain equal values in two tables are added to the dynaset.

b) Option 2 creates a left outer join, in which all the records on the left side of the LEFT JOIN

-~ statement in a query are added to the dynaset, regardless of whether corresponding fields in the

table on the right contain matching values. The records that contain matching values from the right
table are combines in the dynaset with the records from the left table.

¢) Option3 creates a right outer join, in which all the records on the right side of the RIGHT JOIN
statement in a query are added to the dynaset, regardless of whether corresponding fields in the
table on the left contain matching values. The records that contain matching values from the left
table are combined in the dynaset with the records from the right table.

Inner Joins
~ Anlnner Join displays only the records from table one that have matching records in table two,
Outer Joins

Anouterjoin will displayall the fields from one table and any matching fields in the secoﬁd table, There
are two types of Outer Joins, Left and Right.

Cartesian Product Query

A Cartesian Product Query or Cross Product Query creates a list of every possible Sombination
of'two tables or queries that do not have a join. '

The cartesian product of two relations is a join that is not restricted by any criteria, resulting in
every tuple of the first relation being matched with every tuple of the second relation. The cartesian product
isimplemented in SQL as the CROSS JOIN join operator.

Note: If tables in a query aren’t joined to one another, either directly or indirectly, Microsoft
Access doesn’tknow which records are associated with which, so it displays every combination of records
(called a “cross-product” or “Cartesian product”) between the two tables.
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13.4 RELATIONSHIP

After you’ve set up different tables for each subject in your database, you need a way of telling
Microsoft Access how to bring that information back together again. The first step in this process is to
define relationships between your tables. Afier you’ve done that, you can create queries, forms, and
reports to display information from several tables at once.

The kind of relationship that Micr_osoﬂ:'i\_ccess depends on how the related fields are defined:

* A one-to-many relationship is created if only one of the related fields is a primary key or has a
unique index. A one-to-many relationship requires that a record in one table can have many matching
records in a second table, but a record in the second table must have only one matching record in
the first table. For example, suppose there is a products table and an order table, There will only
be one product id for each item in the product table, but there can many orders for that one
product in the ordertable.

* A one-to-one relationship is created if both of the related fields are primary keys or have unique

~ indexes. a one-to-one relationship requires that there be only one matching record in each table.

For example, the SSN of an employee in a fund raising table must match only one employee
record in the employee table. '

¢ A many-to-many relationship is really two one-to-many relationships with a third table whose
primary key consists of two fields - the foreign keys from the two other tables. a many-~to-many
relationship allows for a multitude of matching records in both tables involved, For example, there
can be many teachers in the teacher table who have many students in the student table and vice-
versa. In reality, this type of relationship actually involves three tables, the third of which s a joint
table that carries the primary key from both tables. For example, the teacherID and the studentlD

- could be the primary keys of each table.
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Relationship between tables

L.

8.
9.

Close any tables you have open. You can’t create or modify relationships between open tables.

2. Ifyou haven’talready done so, switch to the Database window.
3.
4. If your database doesn’t have any relationships defined, the Add Tables/Queries box will

Click Relationships on the toolba.

automatically be displayed. If you need to add the tables you want to relate and the Add Table
dialog box isn’t displayed, click Show Table on the toolbar. If the tables you want to relate are
already displayed, skip to step 6.

Double-click the names of the tables you want to relate, and then close the Add Tables/Queries
dialog box.

Drag the field that you want to relate from one table to the related field in the other table. In most
cases, you drag the primary key field (which is displayed in bold text) from one table to a sinzilar
field (often with the same name) called the foreign key in the other table. The related fields don’t
have to have the same names, but they must have the same data type (with two exceptions) and
contain the same kind of information. In addition, when the matching fields are Number fields, they
must have the same Field Size property setting. '

The Relationships dialog box is displayed. Check the field names displayed in the two columns to
ensure they are correct. You can change them if necessary.

Click the Create button to create the relationship.

When you close the Relationships window, Microsoft Access asks if you want to save the layout,

Whether you save the layout or not, the relationships you create are saved in the database.

Referential Integrity

:~.\\

Referential integtity is a system of rules that Access uses to ensure that relationships between

records in related tables are valid, and that you don’t accidentally delete or change related data. You can
set referential integrity when all of the following conditions are met:

The matching field from the primary table is a primary key or has a unique index. A unique index is
an index defined by sefting a field’s Indexed property to Yes (No Duplicates). A unique index will
not allow duplicate entries in the indexed field. Setting a field as the primary key automatically
designates the field as a unique index. :
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» Therelated fields have the same data type. There are two exceptions. Aa AutoNumber field can
be related to a Number field with a FieldSize property setting of Liong Integer, and an AutoNumber
tield with a IFieldSize property setting of Replication ID can be related to a Number field with a
FieldSize property setting of Replication 1D,

 Both tables belong to the same Microsoft Access database. If the tables are linked tables, they
must be tables in Microsoft Access format, and you must open the database in which they are
stored fo set referential integrity. Referential integrity can’t be enforced for linked tables from
databases in other formats,

When referential integrity is enforced, you must observe the following rules:

* Youcan’tentera value in the foreign key field of the related table that doesn’t exist in the primary
key of the primary table. However, you can enter a Null value in the foreign key, specifying that the
records are unrelatedl.

- Forexample, you can’t have an order that is assigned to a customer that doesn’t exist, but you
can have an order that is assigned to no one by entering a Null value in the CustomerID field.

' Youcan’tdelete arecord from a primary table if matching records exist in a related table.

- Forexample, you can’t delete an employee record from the Employees table if there are
orders assigned to the employee in the Orders table.

¢ Youcan’tchange a primary key value in the primary table, if that record has related records.

- Forexample, you can’t change an employee’s ID in the Employees table if there are orders

assigned to that employee in the Orders table. If you want to enforce these rules for arelationship,

select the Enforce Referential Integrity check box when you create the relationship. If referential
integrity is enforced and you break one of the rules with related tables, Access displays a
message and doesn’t allow the change.

You can override the restrictions against deleting or changing related records and still preserve
referential integrity by setting the Cascade Update Related Fields and Cascade Delete Related
Records check boxes.

» Whenthe Cascade Update Related Fields check box is set, changing a primary key value inthe
primary table automatically updates the matching value in all related records.

o When the Cascade Delete Related Records check box is set, deleting a record in the primary
table deletes any related records in the related table. :

13.5 QUERY

When you query 2 database on a computer, you use the same techniques. A query is a set of rules for
finding information in a database. Queries in a database use the Structured Query Language (SQL —often
pronounced “sequel”). In Access, however, it is not necessary to leamn Access to create queries, as queries
can be created using the much simplet Query by Example (QBE) window. The most common variety of
query is the Select query, where the query is used to select certain information from the database according
to criteria you specify.

13.5.1 Select Query

To ask a question about data in a database, we design a query that tells Microsoft Access what

data to rétrieve. The most commonly used queries are called Select Query. With Select queries, we can

view, analyze, or make changes to the data. We can view data from a single table or from multiple tables.

When a Select query is run, Microsoft Access collects the retrieved data in a Dynaset . A Dynaset is a
dynamic view of the data from one or more tables."

»
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Creating a standard select query involves the following steps:

1. Choose which table(s) the information will be coming from (information can also come from existing
queries).

2. Choose which fields will be included in the query output.
3. Specify the criteria for the type of query.
4. Runthe query/ view the results,

i
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13.5.2 Action Queries |
By défault, queries are SELECT queries which means they select data but they do not alter it.
ACTION queries are another type of query which do alter data in some way.

Note : It is strongly recommended that before performing an action query that you back up your
table. You can not undo an action query!

There are several types of action queries:
13.5.2.1 Make Table Query

A Make Table Query creates a new table copying data from an existing table based on criteria.
The newly created table can be saved to the currently opened database or exported to another database.
Note that the data in the new table does not inherit the field properties including the primary key from the
original table, which needs to be set manually.

To create an Make Table Query, first create a simple query with the criteria desired. Check the
query to verify it is pulling the desired records. Note that you can include any columns desired in the new
table but because we will be using this table in a later exercise, we will place all of the columns in the new
table.

From the menu choose Query, Make Table Query.
_ .

Adialog box will appear. Enter the name of the table to be created.
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To run the make table query: from the design view, choose the run button on the toolbar from a
closed query, open the query.

A message will appear indicating that the query will create a new table and the number of rows in
the table.
Microsofi Access™

b3

-

13.5.2.2 Append Query

We use an Append Action query to insert records from one or more source tables into a single target
table. An Append Query adds records to a table copying data from an existing table based on criteria. To
create an Append Query, first create a simple query with the criteria desired. Check the query to verify itis
pulling the desired records. Append queries are also useful when we want to append fields based on criteria
or even when some of the fields do not exist in the other table.

From the menu choose Query, Append Query.

The table being appended to should always be backed up prior to executing the append.
¢ The query is based upon the table where data is being appended (copied) from.

* Ifyougetanerror message when attempting to append, consider any complications caused by a

keyed table. For example, if you are appending into a table that has a primary key set but you are

.notappending any data into keyed field, Access will not aliow the append because keyed fields

+ cannotcontain blanks.Another problem sometimes arises when data is being appended into the

keyed field. If the data being added duplicates data that is already in the keyed field, then Access
will not allow the append.
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¢ When appending from one table to another, if the field names are an exact lhatch, Access will
place data from one table into its corresponding field in the other table, When the field names do
not match, the vser must tell Access the corresponding fields. '

* The field names do not have to be in the same order in both tables.
& Notall fields (columns) need to be copied into the table.
* Notall records need to be copied into the new table, You can append based upon a criteria,

* Appending has no affect on the table being ap;ueildjllg from but can dramaticélly affect the table
being appended to. '

I. - Adialog box will appear, Enter the name of the table to be appended.

g

To run the append table query: from the design view, choose the run button on the toolbar from »
closed query, open the query. '

LR S S

13.5.2.3 Delete Query

The Delete Action Query deletes a group of records from one or more tables, We can use g single
delete query to delete records from a single table, from multiple tables in a one-to-one relationship, or from
multiple tables ina one-to-many relationship with referentia] integrity set to allow cascading deletes, A
Delete Query removes records from a table based on criteria, To create a Delete Query, first create a simple
query with the criteria desired. Check the query to verify it is puliing the desired records.

From the meny choose Query, Delete Query,

(2491




To run the delete query: from the design view, choose the run button on the toolbar I"rom.a closed
query, open the query. :

A message will appear indicating that the query Wlll delete rows in the table and the number of
rows to be deleted. C

M:crusoﬂ Access

13.5.2.4 Update Query

Update queries can be used to make global changes to your records based upon a criteria, For
example, you would like to raise the credit limit of those people who live in the USA by 10%.

An Update Query allows information to be changed throughout a table based on criteria.

To create an Update Query, first create a snnple query with the mteria clesn‘ed Check the query
to verify it is pulling the desired records,

From the menu choose Query, Update Query.

TraatmentCode
tbMiskLineltems

The Update To line will appear in the design grid. Enter the update value.
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Note: When the query is switched to the datasheet view, only the field to be updated will appear.
To run the update query: from the design view, choose the run button on the toolbar from a closed
query, open the query. A message will appear indicating that the query will update the table.

%

13.6 CROSSTAB QUERY

A crosstab query takes data that isin a I

useful for performing data analysis by category. A crosstab query is notan action query and has no effect
on the table it is based on. To perform a crosstab query, at least 3 different columns are needed. Crosstab

Jueries are simple to create using the “Crosstab Query Wizard”. Crosstab queries can also be created
nanually but that procedure can be somewhat tedious,

In this example, we have a list of movies made between 1972 and 1994, The list contains the name

f the movie, its rating, release date, profit made, production company, and the type of movie it is, We
vould like to know the total profit for cach year broken down by movie rating.

A Crosstab Query is used to create g view of data in

a compact form. To create a Crosstab
Juery, create a new query using the Crosstab Query Wizard,

The wizard will start prompting for the information needed to ére_ate the query.

Find Duplicates Query Wizard
JFind Urmatched Query Wizard - : '

B P

Choose the table or query updn which the query is to be based.

Slarir.ais
LIV T
JrBloe ey s

FRi R AR R ALY

Choose the fields to be used for the row headings, then choose the fields for the column headings.
can Choose the field for the calculation, and the type of calculation,

T o
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13,7 SQL VIEW OF QUERIES

You need to become familiar with SQL (Structured Query Language) because you will need it if you
ever develop aMicrosoft Access application and have to issue queries through code. You also need SQL
to query other database systems, such as Oracle and MySql. Finally, once you know SQL, it is often

easier to write a query directly in SQL than to design it using Access’s QBE interface.

As Roger Jennings observes in his excellent book, Using Access 2002, one of the best ways to léam
SQL is to build QBE queries and then inspect and alter the query in SQL View. You are going to do just
that with the CurrentProductsAndSuppliers query that you developed and saved in the last chapter. In

detail, you are going to copy the SQL from the CurrentProductsAndSuppliers query, statt a ggw blank ;

query, paste the SQL into the new query, and save the new query under a new name. Then, you are gomg
to changg_the SQL behind the new query. . :

udu:!.ﬁndb u;ml Solect 0 deariry

l'-“rudu-:l:s Pnnd.nctlo, Prodlxts Prachuctivane, Fr K pliers, Compary hlanne,
ppliar. Fhone :
FROM imrs IMMER J2IMN Erodurts OM Supplers. SuppllerlD = Producks, Supp
im-nERE idPraducts . Slecontinuimclis o) nm ((Supphisns, SA.lpp"er'I:DHProdml:s] [su_npplerlta])),

1)  Starting the New Query

Step 1. Be sure the Queries tab is visible. Press the New button to start a new query, When the

New Query dialog box appears, be sure that Design View is selected and press OK.
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[)5ign L
{Smple Query wWizard

Crossteb Guery Wizard
Fird Duplicates Query Wizard
Find Unraatched Quary wWizard

dialog box appears.

3

Step 2. Because you want to start a new blank query, press Close as soon




2) Pasting SQL into the New Query

Step 1. Paste the SQL you have previously copied to the clipboard into the new query’s SQL view
window by selecting the text in the window if necessary, cllckmg on the Edit menu, and then clicking Paste.

The result will be that you have the SQL from the CurtentProducts AndSuppliers query pasted into
the SQL view window of your new query.

cuck s, Produoctits, Freduehn SFroductName, L Frochects. i G L “.'oupplusrs L mnp—anyl\lame,
L oier s . Fhore
SO Sumpkew INIAER O Prodocts ON Supolers. Sonolier ID — Froscocks Suopkioe O
Ers (F@Md.m CHoaarsk ks e a—da ) AR CLSuppl ey e . SupphisyID j=—Fresduces ] Sunpiler L TIxa

3) Simplifying the New Query SQL

The SQL view window is 2 complete, though simple, text editor. Youare going to simplify the SQL
you have just pasted in by editing it.

Step 1. The parentheses in the SQL are not needed, so delete them. -

Step 2. The INNER JOIN statement is not needed either, so remove it too. (Remove ever ythmg
after the FROM on the INNER JOIN line.) You do need to say what tables you are using though, so insert
PRODUCTS, SUPPLIERS after the FROM. The simplified SQL in the SQL view window of the new

query should look like

Peackacte r 10, SUpRlsrS, C o eyl e,

Producks, Suppiear:
HMERE Products. I:k-e.erklrmod-uu ARG Suppliars, Eummrm—med.ghnj SuppficrID]:
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4) Saving the Simplified New Query

Save the simplified new query for future use as SQLQuery. (The period is there for grammatical
reasons and is not part of the name.) Yes, the name SQLQuery is a dumb one, but there are only so many
variations on the more descriptive CurrentProductsAndSuppliers name, Displaying the SQL Query in
Design View. o

Oncea query has been built with SQL, it has a perfectly reasonable design view (QBE view). Let
us verify this by displaying the SQL query in design view.

| Step 1. Change to the Design View of the query. By now, you know how.

Note that the design view of the SQL query is nearly the same as the design view of the
CurrentProductsAndSuppliers query. Note the two tables displayed in the tables panel of the design view
window, Only the line denoting the Access many-one relationship is missing, Note how similar the tabular
QBE panel of the SQL query is to the QBE panel of the CurrentProducts AndSuppliers query. Only the
order of some of the columns s different, You can switch back and forth between designing a query in SQL
View and Design View at will. You should mix and match, and nse whateveris simplest at the time.

i R e A

Supplior I
Companyfa
Contactparns -
ont kTt

CompanyMame SLIDDHQI‘I\D.
ol Supplieys Suppliers : Produrcks S lers

L

SQL means Structured Query Language. Behind a query is.always an SQL-statement that specifies -
what to compute. Let us look at the SQL statement in qryStayList:

f \';._i ot

‘Condimants
iFroduce

__... Condiments

i Toky
Ganen
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In SQL, the SELECT part corresponds to the top-two lines of the query grid. Field names may
mclude btrange characters, and in this case Access surrounds the name with square brackets to avoid that
the name is interpreted as something else. (Often Access surrounds the names w1th square brackets forno
apparent reason. } Examples of names with strange characters: :

guesth written as [guest#]
Guest History written as [Guest History] ~ *

The FROM part corresponds to the tables and the relationships in the top part of the query
window. In our example, the FROM part says that tblGuest and tbiStay must be joined, and the join
criterion must be that guestID must be equal in the two tables. Actually, Access stores the query as an
SQL-statement, and when we want to see the query in design view, Access translates it into a grid and the -
data model. You can sometimes observe this when you have set up the grid in one way, When you close the

" query and open it again, the grid looks different, for instance with the columns in a different sequence. Your
‘version and Access’s version correspond to the same SQL statement. You can also type the SQL-staternent
directly in SQLview. Access may still be able to show it as a grid, but for some SQL-statements it is not
possible. For instance this is the case with a UNION statement, where two tables are to be concatenated
one after the other. Access can handle this, but not show it as a grid, Expert Access developers sometimes
. define aquery with a grid, sometimes with SQL, and often they switch between the two during development.

_ Capital letters: Access doesn’t care whether you type with capitals or small letters. For instance

you may type SELECT with stall letters, but when you close and open the query in SQL view, SELECT
will be with capitals. When you define field names and other names, Access remembers the capitallzatlon
in the name definition, but accepts names written with different caps as equivalent. It finds the result in six
steps (ato f): : '

a) Cartesian product: The SQL-engine takes the first _guest record and extends it with all the fields
from the first stay record. It corresponds to the top left celd of the matrix. Then it takes the second -
guest record and extends it with the first stay record. This corresponds to the second cell in the top
row. And so on for all the guest records. This corresponds to all the cells in the top-row of the
matrix.

b) Join: Next, the SQL-engine discards all cells where the join criterion is not met. For example ,In
our case, the criterion is that guestID must be equal in the two source tables, What is left are the

“cells marked with a cross on the figure. Notice that all stays are included because they have a cross
in their row. However some guests (for instance guest 2) are not included because no stay is
recorded for them in the database. '

¢) Where: We can also specify Where cnterla, for instance Where state=1 This would cause the
SQL-engine to discard all cells where state isn’t one. They are djscarded at thls point of the
process.

d) Group By We can specify Group-By criteria. They cause the SQL-engine to bundle the remalmng
“records according to the Group-By criteria and compress each bundle into one record.

e) Having: If we have a Group-By, we can also speclfy Having criteria. They tell the SQL-engine to
keep only bundles that meet the criterion. Other bundles are discarded at this point.

f) OrderBy: We cartask the SQL-engine to order the remaining records according to some criteria.
Some people say that the records are sorted rather than ordered.
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13.8 SUMMARY _

In this unit we demonstrated the major features of the Query-by-example(QBE) facility using the
Microsoft Access 2000 DBMS. When we create a query using QBE , in the background Microsoft
“Access constructs the equivalent SQL statement. SQL isa language used in the querying, updating and
management of relational databases. In this unit we presented a comprehensive overview of the SQL
standard. We can also use QBE to perform useful operations on tables such as inserting and deleting
records, modifying the values of fields, or creating new fields and tables.

13.9 UNIT END QUESTIONS
1) Discuss the concept of QBE in Microsoft Access 20007
2) Describe the main functions of Relationship for multiple tables?
3) Whatis the use of Query? How it can be implemented in Relational databases?
4) Describe the different types of ACTION queries with their example?
5) Discuss the function and importance of Integrity constraints in relationship?
6) How delete action query can be implemented on Microsoft Access Database?
- 7} Howtocreate query using{FAE in relational databases? .
- 8) What Advanced Action queries can be implemented on databases?
9) What is the use of Append Action query on relational databases?
10) How Crosstab query can be implemented on relational databases?

13.10REFERENCES |
1) http://download.oracle.com/docs/cd/B1 9306_01/server.102/b1 4200/statements_5004. htm
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AﬁQuick_Microsoft_Access_20{)0_Tutorial. pdf
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‘Unit 14: Forms and Reports

Structure of the Unit
14.0-  Objective
14.1  Creating Forms
14.2 Form'Wizards
14.3  Charts
14.3.1 Creating a Chart
14.3.2 Editinga Charf -
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140 OBJECTIVE
After studying this unit, you will learn -
¢ How to create Forms
o Description of Form wizard
e Howto work on charts
e How to create Reports

14.1

Use of different kinds of Reports,
CREATING FORMS

Microsoft Access Forms allow a user to view and edit the data stored in the underlying bas
tables, presenting the data in an organized and customized mannet. Forms can be displayed and printe;
the main use of forms is on screen , to improve the interface for data entry. You can add graphics to then
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and specifying shading, éolors, type style, and more. Youmight have a form that youuse for the on-screen
entry and editing of employee records. Forms can use information for multiple tables. It’s even possible to
combine information from different databases on the same form, '

Forms are constructed as a collection of individual desi gn elements catled controls or control
objects. There are many types of control , such as Text boxes to enter and edit data, labels to hold field
names, and command buttons to initiate some user action. Controls can be casily added and removed from
a form, In addition, Access provides a control wizard to help the user add controls to a form.

A form s divided into a number of sections, of which the three main ones are:
¢ Form Header: This determines what will be displayed at the top of each form, such as a title.
¢ Detail : This section uéually displays a number of fieldsin arecord.
¢ Form Footer : This determines what will be displayed at the bottom of each form, such as a total.

142 FORM WIZARD

There are Wizards and other tools to help you create forms . It’s a good way to get started.
Although the form wizard is actually very useful and should save you a bunch of time! Let’s create a simple
data input form for the new employee. You can run the Form Wizard at any time after creating a new table,
In this example the Wizards and I will show you how to crgate a couple of forms from a database as
follows: ' :

1. Open the Database of your choice the Form tab, if necessary .

2. Click on form wizard to bring it forward . Unless you’ve already created some forms for this
database, you will see an empty list. . :

Create Form in Design view

Cie cfﬁrmm u:_:ihg wizard}

3. Inany cése, click the New button in the Forms window. _'

4. You will be asked to select a table. Choose your table from the drop-down list,

SaleNumbar
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5. After selecting a table, click on the Wizard button.

6. You will be presented with a choice of five Form leards(Smgle column, Tabular, etc.), You can

click once on a Wizard’s name to display a brief description of its function at the bottom of the

~ dialog box. Double clicking on a name selects the Wizard and continues the process of creating a
form. for this exercise, double clicking on the Tabular Form Wizard.

7. You will be given the opportunity to choose which of your table’s fields will appear on the new

~ form. To choose fields, select them in the Available fields list and click on the > button between the

two lists, or doubie click on the fields. To remove ﬁelds from the form list, double chck onthem or
use the <button .

8. When you have moved all of the desired fields to the form list, Cllck on the Next button to
continue.

9. The Wiz will offer some predeﬁned style choices. They are chosen by clicking on the appropriate
radio button . Chosen styles are demonstrated in the upper left corner of the dialog box. Explore
them all, if you like. Then choose one and click on the Next button.

10. You will be presented with the wizard’s final dialog box, which gives you a chance to modify the
form or see it with your contacts data. This is also where you create a title for your form, Access
proposes a title which you can edlt

11. After youhave titled yours, be sure the choice “Open the form with data in 1t” ismarked and click
on the Finish button.

12. Inamoment you’ll see your new title from with your contacts data displayed in it.
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Entering Data Using Access Forms

Now that the form has been created, Bob _]LlSt needs to teach his employee how to enter in the
data. Lucky for Bob it’s as easy as one-two-three and won’t take him long to brmg his new employee up
o Speed

Open up frm EmployeeEn!Iy {easy!)

2 At the bottom of the form is a set of arrows to navigate through the records. To getto the end of
“the existing records and begin entering data you need to click the arrow with an asterisk(*).

3. Clicking that button will bring you to the first blank record, whlch would be the snxth in our case.
You would then enter all the data for that record and click the right arrow to advancd to the next
blank record. After all the new records have been entered, close the form and pat yourself on the

" back.

When you enter data into this form it will automatically add i 1t to our existing thl_Sales because we
specified that table when we created our form. With this form the new employee will be able to enter data
into Bob’s existing Access table without ever knowing a thing about tables

143 CHARTS

Each application in Microsoft Office{except Mail) allows you to create achart, Charts are embedded
objects, and are saved in the file in which they were created,

Finding the Chart Wizard
The chart wizard can be found inside the Reports area of Access. Navigate to the reports are.
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He % Creata report in Design view
A Create report by using wizard

e s

The chart wizard can be found by clicking the green New button and selecting Cha.rt Wizard.

ki

AutoRepart: Columniar
-JAutoReport: Tabutar

Choosing the Right Chart

1. Our data consists of product types and total sales, so a histogram would probably be the best
choice for this data. With Chart Wizard selected, choose the Query “qry_ProdSales” from the
drop down list. This is what our chart will be constructed from.

1. Click OK.
- 2. Addboth available fields to the chart and click Next,

3. Select the Bar Chart and press Finish.
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4. Yournew chart should look something like this:

qry_ProdSales -

@sumOfPrice

Lll-'dl'u erHH' 1 D':‘_.Il]rl ». H."
Create report by using wizard
i1 8 cht_ProdSales

B orpt_Sales

This chart doesn’t cleary show all the products, so we are going to have to widen it a bit.

- 14.3.1 Creatmg a Chart

In access , Use the Graph Wizard and Chart Wizard to create a Chart using data entered in a file.

In access , you can insert a chart while you are in Form or Report view. The chart you can create will
appear on each form in the database.

To create a chart -

1.
2.

Open the Access file that contains the data you want to plot,

In Access, click on the Design view button on the Form Design or Report Design tootbar, and then
click on the Toolbox button on the Form Design or Report Design toolbar to display the Toolbox.

Click on the ChartWizard or Chart button on the standard toolbar in Access’s Toolbox. Click in
the location in Access’s form or report, or in where you want to place the chart. The Graph Wizard
dialog box appears in Access.

Answer the question in the Graph Wizard or ChartWizard dialog box, and then select Next. Continue
until each of the questions is answered, and then select Finish. Or select the data in any cell in the
datasheet window, and then type the data youwant to plot. The chart window reflects any changes
you make
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There are several different items that are either used to create achart or that appear in the chart,

depending on the type of chart you create:

a)
b)
c)
9

€)
f)

2
h)

1432

The data series in the row, column, or field of data used to plot the chart.
The chart is the area inside the Chart window, including all the items the make up the graph.
The chart’s axes are the lines used to plot data on the chart.

The plotarea is the region of the chart in which the data is plotted, The axes and data markers used
to plot the data are located in the plot area. ' '

A data marker is the symbol in the chart that marks a data point or value.

Gridlines, which often make the chart easier to read, begin at tick-marks and continue throughthe -
charteither horizontally or vertically, '

The chart text describes the data or chart items,

The legend is an insert in the chart that identifies the colors, pattems, or symbols assigned to the
markers in the data series. '

Editing a Chart
Youcan changc virtually every element ofthe chai‘t, including the chart’s size and type, the chart

text, and the data that is used to plot the chart.

To make any changes to a chart in Access, you must be in Design view.

Use any of the following methods to edit a chart:

1)

)

3)'

- and type the new text to replace the selection.

4)

In Access, double click on the chart to display Microsoft Graph’s Datasheet and Chart windows.
Select the cell that contains the value you want to change, and then type the new value to be plotted
in the chart. The chart is automatically updated in the chart window.

To move a chart, click just inside the frame that surrounds the chart to select the chartﬁ Then drag

the chart to a different location,
=3 dth Ot
O Sved Qe
m Zxred Otr
= i1st Qer
100

Double click on the chart text you want to change to activate its text box, and then select the text

D4ath Qtr | i
O 3rd Otr 'f""
o 2nd &rtr HE
B Tat Ofr

s

® T ,
select one of’ the axes, right click on it and then select Insert Gridlines to display the Gridlines dialog
box. Select the check boxes of any gridlines you want to appear in the chart, and choose OK.
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5) Toinsertachart title or axis title in a chart, right click on an axis, and then select Insert titles to
display the titles dialog box. Select the check box of any chart item for which you want a title, and
then choose OK. Atext box appears in the chart with some text in it describing the chart item., Edit
the text as described above. '

gry ProdSales

0 i 100 1356 200

14.3.3 Changing the Chart type of an Existing Chart

You can easily change the chart’s type. Double click on the chart to activate it, and then right-click
Just outside the plot area of the chart to display its shorteut menu. Select Chart type in the shorteut menu to
display the chart type dialog box, choose a different type of chart, and then choose OK. The same data
that was used to compile the original chart is used to draw 2 new chart of the selected type.

-14.4  Pivot Tables

, Pivot tables represent a powerful way to convey the data in Access databases, and they empower
users to perform many tasks that used to require custom programming, :

Createa pivot table in Access to summarize data in a list or database, and display the summary so
it can be analyzed. A pivot table allows you to rotate the row and column headings in order to display
different views of the data, and can be updatéd when the data in the source changes. In addition to
Datasheet and Form views, Access 2002 or later supports PivotTable and PivotChart views for viewing
data in a datasheet or form. The PivotTable view uses an Office PivotTable Component and facilitates
interactive data analysis. The PivotChart view uses an Office Chart Component and helps you create
dynamic, interactive charts. : '

To create the Pivot Table, invoke the Pivot Table Wizard with the menu commands Data, Pivot -
Table and Pivot Chart Report. The Pivot Table Wizard leads you through three steps:

Step 1: Allows you to specify where your data is located and whether you want a chart as well as
a table. Most commonly you’ll get your data from an Excel list that’s part of the current worksheet.

Step 2: Identifies the list range. Ifyour have the insertion point anywhere in the list when you start
the Wizard, Excel defines the list range automatically.

Step 3: Creates the Pivot Table using its best guess as to layout.

-
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How to Use an Access Pivot Table

14.5

Click “F] Ie” and then “Open” and browse to the Microsoft Access database you want to analyze,
Click “View” and then select “PivotTable View” and this displays the “PivotTable Field List.”

Select a numerical field from the “PivotTable Field List,” then drag and drop this field in the “Drop
Totals or Detail Fie]ds Here” section of the pivot table view, For example, if you want to know
how many orders you have in a store database, the order quantity field is the numerical field you

‘select, since it represents the number of orders. A simple pivot table view is displayed showing the

summarized list of the order quantities.

Select the field representing the store’s product identifier from the “PivotTable Field List,” then
drag and drop it in the pivot table view section labeled “Drop Row Fields Here.” Now the pivot
table view is displayed listing the order quantities for each store product. The grouping of information
by store product identifier makes the pivot table summary more meaningful for analysis,

Right-click the numerical field column narne in the pivot table view and select “AutoCalc” and then

- select “Sum’” and now you have a meaningful pivot table that summarizes the order quanuty for

every store product in your database,
CREATING FORMS WITH DESIGN VIEW
Although information in a database can be entered and edited directly in a table, most people find

it simpler to use a form. We use forms all the time in everyday life as a way of recording information so
forms are familiar to us. The Form design tools in Access are very flexible and allow you to customise a
form with many features to make it easy to use. Forms can be created in a few different ways.

Use an Auto form to create a form based on a standard layout.-
Use the Form Wizard,
Use one of the above methods and then modify the form in Design View.

Create a form completely from scratch using the Design View tools.

Using Auto forms

Auto forms allow you to create a form quickly based on a standard layout. In the first exercises,

you actually used an auto form when you used a form for data entry. There are several auto form layouts
to choose from and we will try out three of them in the following exercises.
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Cl‘eating a Datasheet Auto Form i
1) Make sure your Student List database is open.
R BERS, e

Q . Rﬁ;:‘:nrﬁ.---‘ ._z'
2) Select the Forms section from the Database Window.
3) Click the New button at the top of the Database Window.

4) Whenthe New Form dialog appears, click on the list at the bottom as shown below. A list of all
your tables and queries appears since forms can be based on either.

5) Select your STUDENTS table from the list (it’s easy to telt which one’s a table because we named
tables in uppercase and queries in lowercase). | ' o

1 Shemign: Y .
Foew Wirard K
S Atk Solupre :
| AciFaren T

e i

B JAuoees P it het ;

e L - e ]
Mol Tadshe Wi

oAbty Al s by jngd oord,
A AR TS ERLIAMIS By SR |
Soraretee: shadents moris betwd.
istcers? Suting with 2o .
Siugder moricy

SUETTIAC? § DT NyeER .
et gudr'y : ;

6) Egomthe list of options at the top of the dialog, select AutoForm: Datasheet. .. . . :
7} Click OK to créate the form. '

- Theendresultisa form that looks and acts the same as'a table. It may not seem very useful to have

afornrthat’sthe same as atable butit can be very useful for subformsas youwill see later on. Sometimes

" itis handy to have a list inside a form: Since a tabie can’tbeplaced inside a form, another form that looks
like a table can be used instead. . :

8) Close the form.
9) Whenyou are prompted to save the form, _cli__qk Yes,




10) Enter STUDENTS: Datasheet as the form name and click OK.

Creating a Tabular Auto form
1) Click the New button at the top of the Database Window.

AoFeITn: et abie
sarralorrn: FivoiChart
- Gt Yazared

© o4 PivotTabis Wizard

.2) When the New Form dialog appears, select the options shown above (STUDENTS as the table
and AutoForm: Tabular as the type of form). '

3) Click OK to create the form.

. _L.w_i?JtW?“'? N T e e

4y Cleosethe form. - _ .
.5) When you are prompted to save the foﬁn, click Yes,
6) Enter STUDENTS Tabular as the form name and click OK.

A tabular form can be used in the same was as a table, but it can be formatted and customlzed alot
more than a table,

14.6 CREATINGREPORTS

- Reports are used in a database to present information in a neat and organised format that is ready
for printing. When a report is opened in Access, it is opened in Print preview for this reason. Creatinga
 report is very similar to creating a form and like a form, can be done using any of the following methods:

¢ UseanAuto report to create a form based on a standard fayout.
o Usethe Report Wizard.
o Use one of the above methods and then modify the report in Design View.

o Createateport cbmpletely from scratch using the Design View tools,
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14.6.1 lntrqducﬁonl'

Having all your data stoted in Access is great for maintaining a database, but it isn’t the best when
you want to share the data or view it away from a computer. The solution to this problem is to create an
Access report that will let you design aready-to-print document of your desired database information.

Fof example, Bob wants a report to show the sales for each prodlict, as well as the total sales for

his company, Luckily, because he has ajl his sales information in an Access database, he can create this
report in about a minute! '

Let’s explore how you would create this basic sales reportin Aceess. -

1. Navigate to the Reports section in Access -

Creats s, sign'vise §
@ - Craate report by using wizard

B reateraport i

2. Double-click “Create report by using wizard” .

3. Select the query we created in the Access Quer-y'lesson qty_ProdSales and add both fields to the
report,

iR

iyt drvﬁpr_pd_sales ’

I

6. Atthe sorting step, select Price from the drodeown'-box then click Sununa;ry O.'p'tibrlls'

e




7. Check the Sum box, so the report will include totals for the Price field and click OK

8. andclick Finish

9. Click Nextto advance to the layout options |

10. Choose a Stepped lay'out anda Porl:reit drieﬁfatioh, then click Next

11. Atthe Style screen choose Bold and click Next

Name the report rpt. Sales and click finish . -

Open up your report and check it out! . |

ot Sales

T Price

F ool uwct
|
%1 3530.00
L Ty Hor Wrrepchant” o KRt 1 cheetaill ik
LT : H1SO 0
[r=ed 1 :
. _ %12.00
STy T Trevaiect® = Flaned 3 cheadl e ey
STy HE AL e
Blipper - -

) £35.00
ﬁhmmm o 'W'rl (X T ] sllppw.r 1 esnnkmein ey ey
T B - ELLg
Ensaler | )

: a0 ,00
Tesoy oa

ELarurery Feer 'l"'mn:iuot'.
. EIarrh
<5 rane f et

Srwea bome G2 clmlnll n:-coﬂ:lnp
F1DImDn

. a7 0

Bob can now prmt out this handy report and review hls sales in an easy-to-read fashion, while away

from his computer. If you would like to make any changes to the report just right-click rpt_Sales and -

 choose the “Design View” option from the popup menu.

'14.6.2 Different kinds of Reports

There are different types of reports in Ms Acoess. These repotts are:

~ a) Creating a Tabular Auto Report

1) Make sure you are in the forms section of the Database Window.
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2) Click the New ‘g tisw button at the top of the Database Window.

3) Select AutoReport: Tabular and make sure the STUDENTS table is selected as the source.

4). Click OK to create the report. The report will appear in Print Preview ready for printing.

STUDENTS

s Number £avt S First Aumie < of Binth Adden Suburk Favic Bl Plowe Gendler
| pses Man PSRN SRENBMON A DB BNP U ADSIRATM U
2 Fuwr by B B8 Brroite draw TR A HE B RHMNET fevwn
I Anmwey - D @ B1A5.50 B aabn RY ey IE%8  HA AL ET ST ‘omep
% fotwy T LI A Comie B Dtoei W WA HEREEI e

§) Closethe report. When prompted, save the report as Student Report: Tabular.
b Creatmg a ColumnarAuto Report
1) Click the New £ ew button at the top of the Database Window.

2) Select AutoReport Tabular and make sure the STUDENTS table is selected as the source.
3) Click OKto create the report Thereport Wlll appear in Print Prevnew ready for printing,
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4) Close the répon. When prompted, save the report as Student Report: Columnar.
14.6.3 Groups

The data in a field that was used to sort records in a report can also be placed in a group, a collection
of related data. Each group can contain summary information about its data in a header or footer. The
summary information can be the result of a calculation, such as the total number of items in the group,

Often statistics are used in combination with grouping. For example you may want the average GPA

forall studentsin each major of study. Grouping means creating groups of records that share some common
characteristic. In this example, when grouped by major, one group would by Business Administration
students, one group would be Finance students, and another group would be Economic students. The
calculation of average GPA would be made for each group. To indicate groping in the query, select the
Group By as the entry in the Total row for the field to be used for grouping. Then perform the aggregate
function, such as average gn the field to computer, GPA, ‘

K

Eountly

Comparny MNams Fegion, Company Mame, Cradit Limit.
Credit Limit .

>

1) Open thereportin Design view.
2) Select view->Sorting and Grouping to display the Sorting and Grouping window. _
3) Position the Insertion point in the field to be grouped in the field/Expression column in the
Sorting and Grouping window, and then set any of the following properties for the group in the
Group properties pane:

@ Select Yes in the Group Header drop-down list to add text or graphics at the top of the
selected field’s group.

& Select Yes in the Group Header drop-down list to add text or graphics at the bottom of the
selected field’s group. -
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e Select the appropriate Text, Date/Time, or numeric option to specify how the data is to be
grouped in the Group on drop-down list. The options that appear depend on the type of data-

in the field. '

* Type the number in the Group Interval text box to specify the interval that is necessary for the
property selected in the Group on drop-down [ist, For example , when order Date is the
option selected in the Group on drop-down list, type 2 in the Group Interval property text

box toreport on the data in biweekly groups.

* Select No(the default) in the keep together drop-down list to print the group without restricting
the header, details and footer to appear on the same page. Whole Group to print the group’s
header, details, and footer on the same page or with first detail to print the Group’s header on

the page if the first detail will also fit on the page.
4) Ifnecessary, add controls to group’s header and footer,

5) Click on the Save button on the Report Design toolbar, or choose File -> Save to save.thé'

changes to the report.
14.6.4 Totals and Summary Reports

1) From the Database Window, click the option that says Create report by using wizard.

ot b o kgt st ey L

S e L

A0 R sEan B Wore bl bere ke g ey

2) Inthe Tables/Queries list, make sure that table: STUDENTS is
3) Click the button to select all of the fields for use in the form. AH of the fields will now be listed

ontherightside. :

4) Double-click on Student Number and Comment to move them back over to the left as shown

~ above.
5) Click Next when ready,

selected.

ST, Frak Mg, Dot 2730w,
s, i s, Poskai, Fale, :
F ¥ Ve
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6) The next step allows you to choose grouping levels for your report. Double click on Gender to
select that as the grouping field. This means that all of the female students will be grouped together
in the report and all the male students will be grouped together.

~ 7) Click Next to continue.

This step in the w12a1d allows youto choose how the records in the report will be sorted. There
are also options for adding totals and subtotals to your report.

8) Inthe first sort box, select Last Name as shown above. You can also select additional fields for _

sorting in case there are any records with the same last name.

9} Click the Summary Options button. -

Pt N DS
o .:J'i . rﬂn

I{.ﬂundﬁﬂnﬂ tlrt et
[LiL S R Tt

You can use these oﬁtioné to add tbtals for any number fields. The énly field available here is

Mark.

10) Click the box to put a tick under the Avg option as shown above. ThlS will add an average mark

figure to the report.
11) Click OK to return to the wizard.
12) Click Next to move to the next step.
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13) Click Align Left 2 for the report layout with Landscape selected as the orientation and click
Next.

Title

1 aPRe: AN TIeT Ak
Taurars] frnk Dol

14) Select a report style and click Next.
15) Enter Students by Gender for the report name and click Finish.

“Students by Gender
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To sort the records that will appear in a report:
1) Openthereportin Design view.
2) Select view -> Sorting and grouping to display the sorting and grouping window.
3) Select the name of the first field on which the data is to be sorted in the first cell in the field /
Expression colum. ' ’ .
4) " Select Ascending or descending in the first cell in the Sort Order column to specify the sort order
for the first field . : :
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5) Repeat steps 3 and 4 for each field on which the data in the report is to be sorted. Up to 10 fields

can be used to define the sott order.

6) Double-click on the Sorting and Groupmg window’s control menu box to close it and return to the
report in Design view.

7) Click on the save button on the Report Design toolbar or choose File -> Save to save the changes
to the report.

14.6.6 Reports using more than one table

We wish to create a report which contains data from both the “Orders” table and the “Order
Detail” table. There are two methods of placing data from different tables onto the same report:

o (reate a relationship between the tables.

If you create a relationship between tables, you can place fields from the related tables on the
same report, However, relating tables at the table level can have a major effect on the database, When
tables are related at the table level, certain conditions must exist-and certain constraints will be in effect.

o Create a query between the tables,

[fyou create and save a query which links the tables then a report can be created offthe saved
query. This solution has no functional impact on how your tables interact with one another and will pose no
data entry constraints. However, the tables being linked must have a common field.

Table relations basically control how tables that have a ﬁeld in common will behave with each
other. Torelate tables, specific conditions must exist:

Master/Subordinate;: When two or more tables are related, there must be at least one “Master”
table. When set up to its fullest extent, the master table dictates what can be typed into the other tables
which are known as subordinates. (See Referential Integrity below).

Primary Keyed Field: The tables are linked through their common fields. Further, the “Master”
table’s linking field must be a primary key field. The subordmate table’s linking fields do not have to be
keyed.

Same Data Type: The linking fields must be of the same data type or similar data types The
following field types are compatible:

o Textto Text

e Number to Number

‘o Autonumber to Number (Field size on the number field must be set to “Long Integer”)
Relatlng Tables

Our eventual goal is to create a report that aIlows usto place mformatlon fromboth the “Orders”
table and the “Order Detail” table in the same report : s

. “Orders” will be the master table o |

o Thetwotables will be related through their common field of Order ID.
1. Click onthe “Relotionships” icon: |
2. Click on the “Show Table” icon.
3. Select the table “Orders  and click on “Add”.
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4. Select the table “Order Details” and click on “Add” .
5. Click on*“Close” to close the Show Table window.

The tables are related by using the mouse to connect the fields which are common to both of'the
tables, However, the direction the mouse is dragged determines which table is the master and which is the
subordinate. Always drag from the master table to the subordinate table.

6. Click on Order1D inthe “Orders” table.
7. Dragitto Order ID in the “Order Details” table.

The window below appears. At this point we could click on “Create” and be able to create the
Main/Sub Reports, but we will explore some of the other options as well.

147  Summary

In this chapter we have defined how the user can interact with Microsoft Access and develops a
database and application using tables, Forms, Reports, Data access pages, macros and modules, Queries
canalso be stored and used as the source of records for forms, reports and data access pages. Forms can
be used for a variety of purposes such as to create a data entry form to enter data into a table. Reports
allow data in the database to be presented in an effective way in customized printed format. Microsoft
Access is the mostly widely used relational DBMS for the Microsoft Windows environment,

14.8  Unit end Questions
L. How Access can be used in amulti-user environment? Explain.
- - Describe the main data types in Access and when each type would be used ,

+ Describe two ways to create tables and relationships in Access.

2
3
‘4. Discussthe advantages and disadvantages of Reports.
5. Whatisthe function of Pivot tables?
6. Deﬁné the way to create chafts inMS Access.
7. What res‘tricti.ons are necessary to create Reports in MS Access?
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